Important Regulatory and Safety Notices to Service Personnel

Before using this product and any associated equipment, refer to the “Important Safety Instructions” listed below to avoid personnel injury and to prevent product damage.

Product may require specific equipment, and/or installation procedures to be carried out to satisfy certain regulatory compliance requirements. Notices have been included in this publication to call attention to these specific requirements.

Symbol Meanings

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="symbol.png" alt="Protective Earth" /></td>
<td>This symbol identifies a Protective Earth (PE) terminal, which is provided for connection of the supply system’s protective earth (green or green/yellow) conductor.</td>
</tr>
<tr>
<td><img src="symbol.png" alt="Warning" /></td>
<td>This symbol on the equipment refers you to important operating and maintenance (servicing) instructions within the Product Manual Documentation. Failure to heed this information may present a major risk of damage or injury to persons or equipment.</td>
</tr>
<tr>
<td><img src="symbol.png" alt="Warning" /></td>
<td>The symbol with the word “Warning” within the equipment manual indicates a potentially hazardous situation which, if not avoided, could result in death or serious injury.</td>
</tr>
<tr>
<td><img src="symbol.png" alt="Caution" /></td>
<td>The symbol with the word “Caution” within the equipment manual indicates a potentially hazardous situation which, if not avoided, may result in minor or moderate injury. It may also be used to alert against unsafe practices.</td>
</tr>
<tr>
<td><img src="symbol.png" alt="Notice" /></td>
<td>The symbol with the word “Notice” within the equipment manual indicates a situation which, if not avoided, may result in major or minor equipment damage or a situation which could place the equipment in a non-compliant operating state.</td>
</tr>
<tr>
<td><img src="symbol.png" alt="Warning Hazardous Voltages" /></td>
<td>This symbol is intended to alert the user to the presence of uninsulated &quot;dangerous voltage&quot; within the product enclosure that may be of sufficient magnitude to constitute a risk of shock to persons.</td>
</tr>
<tr>
<td><img src="symbol.png" alt="ESD Susceptibility" /></td>
<td>This symbol is used to alert the user that an electrical or electronic device or assembly is susceptible to damage from an ESD event.</td>
</tr>
</tbody>
</table>

Important Safety Instructions

1) Read these instructions.
2) Keep these instructions.
3) Heed all warnings.
4) Follow all instructions.
5) Do not use this apparatus near water.
6) Clean only with a dry cloth.
7) Do not block any ventilation openings. Install in accordance with manufacturer’s instructions.

8) Do not install near heat sources such as radiators, heat registers, stoves, or other apparatus (including amplifiers) that produce heat.

9) Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized plug has two blades with one wider than the other. A grounding type plug has two blades and a third grounding prong. The third prong is provided for your safety. If the provided plug does not fit into your outlet, consult an electrician for replacement of the obsolete outlet.

10) Protect the power cord from being walked on or pinched, particularly at plugs, convenience receptacles, and the point where they exit from the apparatus.

11) Only use attachments/accessories specified by the manufacturer.

12) Unplug this apparatus during lightning storms or when unused for long periods of time.

13) Refer all servicing to qualified service personnel. Servicing is required when the apparatus has been damaged in any way, such as when the power-supply cord or plug is damaged, liquid has been spilled or objects have fallen into the apparatus, the apparatus has been exposed to rain or moisture, does not operate normally, or has been dropped.

14) Do not expose this apparatus to dripping or splashing, and ensure that no objects filled with liquids, such as vases, are placed on the apparatus.

15) To completely disconnect this apparatus from the AC Mains, disconnect the power supply cord plug from the AC receptacle.

16) The mains plug of the power supply cord shall remain readily operable.

17) The QMD-X, MD-X, QMD, or MD (Live Production Engine) chassis is to be rack mounted only.

18) **Warning**: Indoor Use: **WARNING**: To reduce the risk of fire or electric shock, do not expose this apparatus to rain or moisture.

19) The safe operation of this product requires that a protective earth connection be provided. A grounding conductor in the equipment's supply cord provides this protective earth. To reduce the risk of electrical shock to the operator and service personnel, this ground conductor must be connected to an earthed ground.

20) **WARNING**: This apparatus, when equipped with multiple power supplies, can generate high leakage currents. To reduce the risk of electric shock, ensure that each individual supply cord is connected to its own separate branch circuit with an earth connection.

21) **Caution**: These service instructions are for use by qualified service personnel only. To reduce the risk of electric shock, do not perform any servicing other than that contained in the operating instructions unless you are qualified to do so (Engineering Manual only).

22) **Caution**: These apparatus contain Lithium batteries, which if replaced incorrectly, or with an incorrect type, may cause an explosion. Replace only with the same type. Dispose of used batteries according to the manufacturer’s instruction.

23) Service barriers within this product are intended to protect the operator and service personnel from hazardous voltages. For continued safety, replace all barriers after servicing.

24) Certain parts of this equipment still present a safety hazard with the power switch in the OFF position. To avoid electrical shock, disconnect all A/C power cords from the chassis' rear appliance connectors before servicing.

25) This product contains safety critical parts, which, if incorrectly replaced, may present a risk of fire or electrical shock. Components contained within the product’s power supplies and power supply area are not intended to be customer-serviced and should be returned to the factory for repair.
26) To reduce the risk of fire, replacement fuses must be the same type and rating.

27) The safe operation of this equipment requires that the user heed and adhere to all installation and servicing instruction contained within the equipment’s Engineering Manuals.

EMC Notices

United States of America

FCC Part 15
This equipment has been tested and found to comply with the limits for a class A Digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

| Notice | Changes or modifications to this equipment not expressly approved by Ross Video Limited could void the user’s authority to operate this equipment. |

Canada

This Class “A” digital apparatus complies with Canadian ICES-003.
Cet appareil numérique de la classe “A” est conforme a la norme NMB-003 du Canada.

Europe

This equipment is in compliance with the essential requirements and other relevant provisions of CE Directive 93/68/EEC.

International

This equipment has been tested to CISPR 22:1997 along with amendments A1:2000 and A2:2002, and found to comply with the limits for a Class A Digital device.

| Notice | This is a Class A product. In domestic environments, this product may cause radio interference, in which case the user may have to take adequate measures. |

General Handling Guidelines

- Careful handling, using proper ESD precautions, must be observed.
- Power down the system before PCB removal.
A Word About Static Discharge

Throughout the many procedures in this Manual, please observe all static discharge precautions.

⚠️ Notice

Avoid handling the switcher circuit boards in high static environments such as carpeted areas, and when synthetic fiber clothing is worn. Touch the frame to dissipate static charge before removing boards from the frame, and exercise proper grounding precautions when working on circuit boards.
Warranty and Repair Policy

Ross Video Limited (Ross) warrants its switchers and related options, to be free from defects under normal use and service for a period of ONE YEARS from the date of shipment. Fader handle assemblies are warranted for the life of the product. If an item becomes defective within the warranty period Ross will repair or replace the defective item, as determined solely by Ross.

Warranty repairs will be conducted at Ross, with all shipping FOB Ross dock. If repairs are conducted at the customer site, reasonable out-of-pocket charges will apply. At the discretion of Ross, and on a temporary loan basis, plug in circuit boards or other replacement parts may be supplied free of charge while defective items undergo repair. Return packing, shipping, and special handling costs are the responsibility of the customer.

Software upgrades for switchers may occur from time to time, and are determined by Ross Video. The upgrades are posted on the Ross Video website, and are free of charge for the life of the switcher.

This warranty is void if products are subjected to misuse, neglect, accident, improper installation or application, or unauthorized modification.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or consequential damages (including loss of profit). Implied warranties, including that of merchantability and fitness for a particular purpose, are expressly limited to the duration of this warranty.

This warranty is TRANSFERABLE to subsequent owners, subject to Ross’ notification of change of ownership.

An extended warranty is available. Contact your dealer or Ross Video for details.
Environmental Information

The equipment that you purchased required the extraction and use of natural resources for its production. It may contain hazardous substances that could impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need for the extraction of natural resources, Ross Video encourages you to use the appropriate take-back systems. These systems will reuse or recycle most of the materials from your end-of-life equipment in an environmentally friendly and health conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your local or regional waste administration.

You can also contact Ross Video for more information on the environmental performances of our products.
<table>
<thead>
<tr>
<th>Company Address</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Ross Video Limited</strong></td>
</tr>
<tr>
<td>8 John Street</td>
</tr>
<tr>
<td>Iroquois, Ontario, K0E 1K0</td>
</tr>
<tr>
<td>Canada</td>
</tr>
<tr>
<td>General Business Office:</td>
</tr>
<tr>
<td>Fax:</td>
</tr>
<tr>
<td>Technical Support:</td>
</tr>
<tr>
<td>After hours emergency:</td>
</tr>
<tr>
<td>E-mail (Technical Support):</td>
</tr>
<tr>
<td>E-mail (General Information):</td>
</tr>
<tr>
<td>Website:</td>
</tr>
</tbody>
</table>
Volume I

Introduction 1
Control Panel Introduction 2
Using the Menu System 3
Switcher Basics 4
Background Transitions 5
Pattern Control 6
Keying 7
Key Modifiers 8
Memory and Disk Functions 9
Custom Controls 10
Proc Amps and RGB Color Correctors 11
Glossary of Terms GL
Index IX
Peripheral Control and More

In This Chapter ................................................................. 12-1
GPI Control ................................................................. 12-2
  GPI Input Control — Area and Button ............................... 12-2
  GPI Output Control ....................................................... 12-2
Aux Bus Group ............................................................. 12-3
  Synergy 4 ............................................................... 12-3
  Synergy 3 ............................................................... 12-4
  Synergy 2 ............................................................... 12-4
  Synergy 1 ............................................................... 12-5
Using the Aux Bus ......................................................... 12-7
Remote Aux Panels ......................................................... 12-8
  Synergy 4 Q/MD-X ....................................................... 12-8
  Synergy 3 Q/MD-X ....................................................... 12-8
  Synergy 2 Q/MD/X ....................................................... 12-8
  Synergy 1 Q/MD ......................................................... 12-8
Using a Remote Aux Panel ............................................... 12-10
Preview Overlay Group .................................................. 12-13
  Synergy 3 and 4 ........................................................... 12-13
  Synergy 2 ............................................................... 12-13
  Synergy 1 ............................................................... 12-13
Preview Overlay Elements .............................................. 12-14
Preview Overlay Font Color ............................................. 12-24
Editor Interface ............................................................... 12-25
External Still Store Interface ............................................ 12-26
  Changing the Still ID ................................................... 12-26
Character Generator Interface .......................................... 12-27
  Leitch (Inscriber) Inca CG ............................................ 12-27
  Chyron Duet LEX ....................................................... 12-39
  Pinnacle FXDeko II .................................................... 12-49
  Vizrt Viz/Trio Character Generator ............................... 12-53
Remote Camera Control Interface .................................... 12-55
  Telemeterics Remote Camera Controller ....................... 12-55
  Sony Robotic Camera Controller ................................. 12-58
  Eagle Pan Tilt System ................................................ 12-62
  Panasonic Pan/Tilt Head ............................................. 12-65
  Vinten AutoCam 200 Controller .................................. 12-67
  Grass Valley CameraMan 3e 3-CCD Robotic Camera ........ 12-68
Copy and Swap Functions ................................................. 12-72
  Copy MLE ................................................................ 12-72
  Copy Key .................................................................. 12-74
  Key Swap .................................................................. 12-75
  Copy Matte .............................................................. 12-76
  Copy Wipe ............................................................... 12-77

Still-Store

In This Chapter ................................................................. 13-1
Preparing for Image Transfers ....................................... 13-2
Image Specifications ......................................................... 13-2
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Naming Conventions</td>
<td>13-3</td>
</tr>
<tr>
<td>Creating a Connection to Your Switcher</td>
<td>13-5</td>
</tr>
<tr>
<td>Alternate Connection Method</td>
<td>13-6</td>
</tr>
<tr>
<td>Transferring Still Images and Animations</td>
<td>13-7</td>
</tr>
<tr>
<td>Copying Still Images and Animations to your Switcher</td>
<td>13-7</td>
</tr>
<tr>
<td>Copying Images and Animations from your Switcher</td>
<td>13-8</td>
</tr>
<tr>
<td>Legacy Image and Animation Files</td>
<td>13-8</td>
</tr>
<tr>
<td>Still-Store</td>
<td>13-9</td>
</tr>
<tr>
<td>Selecting a Still for a Still-Store Channel</td>
<td>13-9</td>
</tr>
<tr>
<td>Renaming a Still or Directory</td>
<td>13-11</td>
</tr>
<tr>
<td>Renumbering a Still</td>
<td>13-13</td>
</tr>
<tr>
<td>Creating a Directory</td>
<td>13-14</td>
</tr>
<tr>
<td>Deleting All Stills in a Directory</td>
<td>13-16</td>
</tr>
<tr>
<td>Deleting an Individual Still or Directory</td>
<td>13-17</td>
</tr>
<tr>
<td>Moving a Still from Directory to Directory</td>
<td>13-18</td>
</tr>
<tr>
<td>On-Air Properties</td>
<td>13-19</td>
</tr>
<tr>
<td>Default Stills</td>
<td>13-22</td>
</tr>
<tr>
<td>Capturing Stills</td>
<td>13-24</td>
</tr>
<tr>
<td><strong>Clip Control</strong></td>
<td>14</td>
</tr>
<tr>
<td>In This Chapter</td>
<td>14-1</td>
</tr>
<tr>
<td>VTR Clip Control</td>
<td>14-2</td>
</tr>
<tr>
<td>Clip Control Overview</td>
<td>14-2</td>
</tr>
<tr>
<td>Programming VTR Custom Control Buttons</td>
<td>14-3</td>
</tr>
<tr>
<td>Programming Clips</td>
<td>14-3</td>
</tr>
<tr>
<td>Running VTR Clips</td>
<td>14-11</td>
</tr>
<tr>
<td>Application Notes</td>
<td>14-17</td>
</tr>
<tr>
<td>Using Clips and Subclips on the Leitch ASC</td>
<td>14-17</td>
</tr>
<tr>
<td><strong>Squeeze &amp; Tease MD Basic Operation</strong></td>
<td>15</td>
</tr>
<tr>
<td>In This Chapter</td>
<td>15-1</td>
</tr>
<tr>
<td>Operational Overview</td>
<td>15-2</td>
</tr>
<tr>
<td>Working in 3D Space</td>
<td>15-3</td>
</tr>
<tr>
<td>Image Location in 3D Space</td>
<td>15-3</td>
</tr>
<tr>
<td>Position Coordinates</td>
<td>15-3</td>
</tr>
<tr>
<td>Screen and Image Location</td>
<td>15-4</td>
</tr>
<tr>
<td>Perspective</td>
<td>15-5</td>
</tr>
<tr>
<td>Image Rotation</td>
<td>15-7</td>
</tr>
<tr>
<td>Image Centering</td>
<td>15-9</td>
</tr>
<tr>
<td>Channel Control Options</td>
<td>15-9</td>
</tr>
<tr>
<td>Conclusion</td>
<td>15-10</td>
</tr>
<tr>
<td>Using the Positioner / Joystick</td>
<td>15-11</td>
</tr>
<tr>
<td>Menu Structure</td>
<td>15-12</td>
</tr>
<tr>
<td>Through the FLY KEY</td>
<td>15-12</td>
</tr>
<tr>
<td>Through the Main Menu</td>
<td>15-13</td>
</tr>
<tr>
<td>Menu Tree</td>
<td>15-15</td>
</tr>
<tr>
<td>3D Guidelines</td>
<td>15-16</td>
</tr>
<tr>
<td>Fly Key Rules</td>
<td>15-16</td>
</tr>
<tr>
<td>Flying Keys</td>
<td>15-17</td>
</tr>
<tr>
<td>The S&amp;T MD Position/Crop Menu</td>
<td>15-17</td>
</tr>
<tr>
<td>Assigning Multiple Channels to a Flying Key</td>
<td>15-18</td>
</tr>
<tr>
<td>Channel Listing</td>
<td>15-18</td>
</tr>
</tbody>
</table>
Position/Crop Functions

In This Chapter .............................................................................................................. 16-1
Position/Crop Menu ...................................................................................................... 16-2
Image Position ................................................................................................................ 16-3
  X-Axis Position ........................................................................................................... 16-4
  Y-Axis Position ........................................................................................................... 16-4
  Z-Axis Position ........................................................................................................... 16-4
Image Pivot Location ...................................................................................................... 16-6
  Pivot Presets .............................................................................................................. 16-6
  Pivot Position ............................................................................................................. 16-7
Image Rotation ............................................................................................................... 16-8
  X-Axis Rotation ........................................................................................................ 16-8
  Y-Axis Rotation ....................................................................................................... 16-9
  Z-Axis Rotation ....................................................................................................... 16-9
Image Aspect Ratio ....................................................................................................... 16-10
Image Cropping .......................................................................................................... 16-11
  Crop Horizontal ...................................................................................................... 16-11
  Crop Vertical ........................................................................................................... 16-12
Image Transparency ...................................................................................................... 16-13
Image Freeze .............................................................................................................. 16-14
Individual Centering ................................................................................................... 16-15

Advanced Positioning

In This Chapter ............................................................................................................... 17-1
Advanced Positioning Menu ........................................................................................ 17-2
Spin ............................................................................................................................... 17-3
Viewpoint ..................................................................................................................... 17-4
Locate ......................................................................................................................... 17-5
Individual Centering ................................................................................................... 17-6

Borders

In This Chapter ............................................................................................................... 18-1
Picture Frame Borders Menu ...................................................................................... 18-2
Border Size .................................................................................................................. 18-3
  Border Size ................................................................................................................ 18-3
Border Appearance ...................................................................................................... 18-4
  Border Softness ...................................................................................................... 18-4
  Border Symmetry ................................................................................................... 18-5
  Border Transparency ............................................................................................. 18-5
Border Style ................................................................................................................ 18-7
Border Color ............................................................................................................... 18-8
  RGB .......................................................................................................................... 18-8
  HSL .......................................................................................................................... 18-9
Working with Multiple Channels ............................................................................... 18-10
Individual Centering ................................................................................................. 18-11
Preprocessor Effects

In This Chapter ................................................................. 19-1
Working with Preprocessor Effects ................................................................. 19-2
  Defocus .................................................................................. 19-3
  Mosaic ....................................................................................... 19-4
  Posterize .................................................................................... 19-4
  Colorize ................................................................................. 19-5
  Strobe ...................................................................................... 19-6

Sequences and Squeeze & Tease Wipes

In This Chapter ................................................................. 20-1
Introduction to Sequences and Squeeze & Tease Wipes ........................................ 20-2
  Sequences ............................................................................. 20-2
  Squeeze & Tease Wipes ............................................................ 20-2
Working with Sequences ................................................................. 20-3
  Creating a Sequence ............................................................... 20-7
  Modifying Keyframes ............................................................ 20-13
  Modifying Spline Motion ......................................................... 20-16
  Adding a Hold to a Sequence ................................................ 20-18
  Running a Sequence with a Hold ............................................ 20-20
  Renaming a Sequence ............................................................. 20-20
  Loading a Sequence ............................................................... 20-21
  Running a Sequence ............................................................... 20-22
  Deleting a Sequence ............................................................... 20-24
  Recalling Sequences Using the Pattern Control Buttons ......................... 20-25
  Assigning a Sequence to a Different Pattern Selection Button ............... 20-26
  Sequence Memory Notes .......................................................... 20-27
  Previewing a Sequence ............................................................. 20-27
  Custom Controls and Sequences ................................................ 20-28
Working with Squeeze & Tease MD Wipes ......................................................... 20-29
  Creating a Squeeze & Tease Wipe ............................................. 20-30
  Loading a Squeeze & Tease Wipe ............................................. 20-33
  Running a Squeeze & Tease Wipe ............................................. 20-33
  Custom Controls and Squeeze & Tease Wipes ........................................ 20-34
Storing Sequences and Squeeze & Tease Wipes ................................................... 20-35
  Storing 3D Sequences ............................................................. 20-35
  Storing Memories ................................................................. 20-36
  Storing Individual Memory Registers ........................................ 20-38
  Storing an Individual S&T 3D Sequence ..................................... 20-39
Recalling Sequences and Squeeze & Tease Wipes ................................................. 20-41
  Recalling an Entire Set of Sequences ..................................... 20-41
  Recalling an Individual S&T 3D Sequence .................................. 20-42

Lighting

In This Chapter ................................................................. 21-1
Lighting Effects Overview ................................................................. 21-2
Applying Lighting Effects ................................................................. 21-4
  Applying Lighting Presets ....................................................... 21-4
  Applying Individual Lighting Parameters ................................ 21-5
Working with Multiple Channels ............................................................. 21-7
  Individual Centering ............................................................... 21-9
# WARP Effects

In This Chapter ................................................................. 22-1
Selecting and Working with WARP Effects ......................................................... 22-2
  WARP Resources .............................................................................. 22-2
WARP Effects .................................................................................. 22-4
  Film ........................................................................................................ 22-4
  Globe ..................................................................................................... 22-6
  Heart ...................................................................................................... 22-9
  Lens Flare ................................................................................................. 22-11
  Magnify .................................................................................................... 22-13
  Melt .......................................................................................................... 22-15
  Obscure .................................................................................................. 22-16
  Page Roll ................................................................................................. 22-18
  Pixie Dust ................................................................................................. 22-19
  Ripple ....................................................................................................... 22-21
  Sand ......................................................................................................... 22-23
  Split ........................................................................................................... 22-24
  Star .......................................................................................................... 22-25
  Stretch .................................................................................................... 22-28

# Appendix A. Menu Trees

In This Appendix ............................................................................... 23-1
BNC Configuration Menu Tree ................................................................. 23-2
Installation Setup Menu Tree ................................................................. 23-3
Communications Menu Tree ................................................................. 23-4
Custom Control Menu Tree ..................................................................... 23-5
Custom Control Banks Menu Tree ......................................................... 23-6
Disk Menu Tree ..................................................................................... 23-7
Recall Factory Menu Tree ...................................................................... 23-8

# Appendix B. Squeeze & Tease MD Wipes and Sequences

In This Appendix ............................................................................... 24-1
Squeeze & Tease MD Wipes and Sequences .............................................. 24-2

# Glossary of Terms

GL

# Index

IX
Peripheral Control and More

In This Chapter

This chapter provides instructions for interacting peripheral equipment from the Synergy Q/MD/X switcher.

The following topics are discussed in this chapter:

- GPI Control
- Aux Bus Group
- Remote Aux Panels
- Preview Overlay Group
- Editor Interface
- External Still Store Interface
- Character Generator Interface
- Remote Camera Control Interface
- Copy and Swap Functions
GPI Control

The GPI function of the Synergy Q/MD/X switcher provides 10 input ports and 10 output ports, each of which can be programmed for specific functions.

- The **GPI Input** function allows you to associate a GPI input pulse with an *area*, *button*, *Custom Control*, and *memory recall* on the switcher that you would like to trigger, when that specific pulse is received from an external device (e.g., trigger MLE 3 Auto Trans, or trigger Custom Control Bank 1 Button 2, memory recall, or Aux Bus override).

- The **GPI Output** function allows you to set up triggers that can be used to activate functions on remote devices (e.g., Play Forward on a VTR, Advance to Next Still on a Still Store, or tallies).

GPI Input Control — Area and Button

Use the following procedure to set up your GPI input functions for an area and button:

1. Toggle the **GPI** button in the **Remote** section of the **Global Memory System Group** to **On** (lit) to allow external GPI control.
   - **On** — When the GPI button is lit the switcher enables remote GPI control, but local operation can still be performed.
   - **Off** — When the GPI button is not lit the switcher disables remote GPI control.

This completes the procedure for setting up your GPI input functions for an area and button. Repeat this procedure for any additional GPI functions you want to install.

GPI Output Control

Each of the 10 GPI Outputs are *named* using the **GPI Output Setup Menu**. This function is performed by your facility engineer during switcher installation. Refer to the section “**Standard GPI Setup**” in the chapter, “**Additional Installation Steps**” of the *Synergy Q/MD or Q/MD-X Engineering Manual* for instructions on naming each GPI output.

GPI Outputs are triggered by programming a custom control button. Refer to the section “**Trigger GPI**” in the chapter, “**Custom Controls**” of the *Synergy Q/MD or Q/MD-X Engineering Manual* for complete instructions.

---

**Note**

Before attempting to set up or trigger a GPI input, ensure that GPI lines are properly **connected** from the desired external devices to the Synergy Q/MD/X switcher and that they are properly configured from the **GPI Setup Menu**. The configuration parameters can include GPI number, trigger location on the switcher, transition type and polarity.

Refer to the section “**Standard GPI Setup**” in the chapter, “**Additional Installation Steps**” of the *Synergy Q/MD or Q/MD-X Engineering Manual* for further instructions.

Consult with your facility engineer as required for a **GPI Input Worksheet** that lists the switcher locations and GPI assignments.
Aux Bus Group

The Synergy Q/MD/X switcher provides up to 48 Aux Buses, depending on the number of outputs you have, each of which can route video to external devices such as monitors, still stores or VTRs.

Aux Buses are arranged into groups of eight Aux Buses for each of the six Aux Bus Banks. This means that each bank has Aux Bus 1 through 8. Therefore, the first Aux Bus is Bnk1Aux1 and the last is Bnk6Aux8.

Synergy 4

The figure below displays the Aux Bus Group on the Synergy 3.5 and 4 Q/MD-X switcher control panels.
Synergy 3

The figure below displays the **Aux Bus Group** on the Synergy 2.5 and 3 Q/MD/X switcher control panels.

Synergy 3 Panel Aux Bus Group

1) Aux Bus Crosspoint Row  
2) Shift Button  
3) Special Aux Bus Crosspoints  
4) On Air LED  
5) Non-Sync LED  
6) Aux Bus Assign Group

Synergy 2

The figure below displays the **Aux Bus Group** on the Synergy 1.5 and 2 Q/MD/X switcher control panels.

Synergy 2 Panel Aux Bus Group

1) Aux Bus Crosspoint Row  
2) Shift Button  
3) Special Aux Bus Crosspoints  
4) On Air LED  
5) Non-Sync LED  
6) Aux Bus Assign Group
Synergy 1

The figure below displays the Aux Bus Group on the Synergy 1 Q/MD switcher control panel.

1. **Aux Bus Crosspoint Row**

The sources on the Aux Bus Crosspoint Row are identical (in both name and quantity) to those on the Program/Preset and MLE buses of each switcher. All sources are present except for re-entry crosspoints. Because each switcher can have up to 48 Aux Buses, this row is shared between all Aux Buses. When you select a specific bus in the Aux Bus Assign Group and then choose a source on the Aux Bus Crosspoint Row, the selected source is routed to a specific external destination (such as a still store or VTR).

If you attempt to select a crosspoint that is mapped to OFF, NONE or a Color Background, the following error message will be displayed.

2. **Shift Button**

The function of the SHIFT button is identical to those at the end of each Program/Preset and MLE bus. The button is used to access video and key sources that have been mapped to crosspoints beyond the number of available buttons. Due to the flexibility of the input mapping procedure (during switcher installation), all desired crosspoints can be made available — either on the shifted or un-shifted bus rows.

Use the following procedure to access a shifted source on an Aux Bus:

a) Press and hold the SHIFT button.

b) Press the desired crosspoint.

c) Release both buttons.

The SHIFT button plus the selected source both stay lit.
3. Special Aux Bus Crosspoints

Each Aux Bus includes a section that is reserved for additional crosspoints (many of which are not found on the MLE buses).

- **MLE PV (Synergy 1)** — Allows you to route the MLE Preview output to the assigned Aux Bus destination.
- **MLE 1 (Synergy 2, 3, and 4)** — Allows you to route the output of MLE 1 to the assigned Aux Bus destination.
- **MLE 2 (Synergy 3 and 4)** — Allows you to route the output of MLE 2 to the assigned Aux Bus destination.
- **MLE 3 (Synergy 4)** — Allows you to route the output of MLE 3 to the assigned Aux Bus destination.
- **CLEAN FEED** (All switchers) — Allows you to route the Clean Feed output to the assigned Aux Bus destination.
- **PGM** (All switchers) — Allows you to route the Program output to the assigned Aux Bus destination.

4. On Air LED

The **ON AIR** LED indicates, when lit, that the video selected on the assigned Aux Bus is contributing to the main program output. In addition, the source selected on that bus will be tallied. Refer to Chapter 14 of the *Synergy Q/MD or Q/MD-X Engineering Manual* for instructions on setting up Aux Bus tallies.

5. Non-Sync LED

The **N/S** LED indicates, when lit, that the source selected on that specific Aux Bus is non-synchronous. The **N/S** LED serves as a warning only, indicating that the input timing should be fixed at the source. When a non-sync LED is lit, the source is still usable, but it will be shifted vertically.

6. Aux Bus Assign Group

The **Aux Bus Assign Group** allows you to select the Aux Bus output that you want the Aux Bus Crosspoint Row to be assigned to. This group is different depending on the control panel you have:

- **Synergy 1** — The **Aux Bus Assign Group** consists of two buttons, **Aux 1** and **Aux 2** that are pre-assigned to **Aux Bus 1** and 2 on **Aux Bus Bank 1**.
- **Synergy 2, 3, 4** — The **Aux Bus Assign Group** consists of two groups of buttons. The first row of buttons (**BANK 1** through **BANK 4**) selects the Aux Bus banks, and the other two rows of buttons (**Assign 1** through **Assign 8**) select the actual Aux Buses.

---

**Operating Tip**

With a shifted source selected on an Aux Bus, to take an unshifted source, or another shifted source, follow the same procedure you would for selecting a crosspoint on any of the MLEs.

---

**Note**

The **Aux Bus Assign Group** only allows selection of Banks 1 - 4. Access to banks 5 and 6 is via the **Aux Bus Output Menu**.
Using the Aux Bus

Before you attempt to use the Aux Bus, ensure that each Aux Bus is properly connected to the desired external devices. Consult with your facility engineer, who can provide you with an Auxiliary Output Worksheet that lists the Aux Bus outputs and their destinations.

Use the following procedure to assign a video signal to an Aux Bus:

1. Press any button in the Aux Bus Assign Group to display the Aux Bus Output Menu.

   ![ Aux Bus Output Menu ]

2. Select an Aux Bus by one of the following methods:
   - Use the Aux Bus knob to select an Aux Bus.
   - Use the Bank and Assign buttons in the Aux Bus Assign Group (Synergy 2, 3, and 4 control panels only) to select an Aux Bus. You can only access banks 1 – 4 using this method.
   - Press Bank 1 – Bank 6 softkeys and then use the Assign buttons in the Aux Bus Assign Group to select an Aux Bus.

3. Using the Aux Bus Crosspoint Row or the Special Aux Bus Crosspoints, press the button for the desired source. Use the SHIFT button if required.

   On the example menu above, notice that DVE Send has been selected as the output for Aux Bus 8 on Bank 1.

   **Operating Tip**

   The Outputs Menu 2-2 allows you to quickly view all 48 BNC outputs and what is assigned to each. This can be used to quickly determine which BNC a particular Aux Bus is assigned to.

This completes the procedure for assigning a video signal to an Aux Bus.
Remote Aux Panels

Remote Aux Panels are one-piece panels that provide remote control (or monitoring) capability of one (or more) of the Aux Buses on the switcher. These panels are typically mounted close to the destination devices that they route their sources to. Video does not flow through these panels, rather the actual Aux Bus outputs originate from the frame and are wired to the destination.

**Note**

The current version of the Remote Aux Panels can only support Aux Buses Bank1, Aux1 through Bank2, Aux4. The Synergy 1 Q/MD Remote Aux Panels can only support Aux Buses Bank1, Aux1 through Bank2, Aux2.

**Synergy 4 Q/MD-X**

The figure below illustrates the Remote Aux Panel for the Synergy 3.5 and 4 Q/MD-X control panel.

![Synergy 4 Q/MD-X Remote Aux Panel](image)

**Synergy 3 Q/MD-X**

The figure below illustrates the Remote Aux Panel for the Synergy 2.5 Q/MD, 2.5 Q/MD-X and 3 Q/MD-X control panel.

![Synergy 3 Q/MD-X Remote Aux Panel](image)

**Synergy 2 Q/MD/X**

The figure below illustrates the Remote Aux Panel for the Synergy 1.5 Q/MD, 2 Q/MD and 2 Q/MD-X control panel.

![Synergy 2 Q/MD/X Remote Aux Panel](image)

**Synergy 1 Q/MD**

The figure below illustrates the Remote Aux Panel for the Synergy 1 Q/MD control panel.

![Synergy 1 Q/MD Remote Aux Panel](image)
In addition to crosspoints, all panels include dedicated “special” crosspoint buttons for Preview, Program, all the available MLEs on your switcher, and Clean Feed. The remote Aux panels for all of the Synergy Q/MD/X switchers are similar and differ only in the number of crosspoint buttons, MLE buttons and Assign buttons.

The figure below shows the remote Aux panel for a Synergy 3.5 or 4 Q/MD-X switcher.

**Synergy 4 Q/MD-X Remote Aux Panel Bus Group**

All panel types include an on-air LED that indicates (when lit) that the Aux Bus controls a signal that forms a part of the program output.

During switcher installation the remote Aux panels can be programmed to operate in either Regular or Follow modes.

- A single Aux Panel can be configured for any one of the first 12 (10 for the S1 Q/MD) Aux Bus outputs. Each output can be placed in one of two modes, as follows:

  - **OFF** — Select this option to turn the specific Aux Bus Off, effectively disabling access to the bus from the control panel. When the button in the Aux Bus Assign Group is pressed, it lights momentarily, but it will not “take.” The bus can, however, be controlled by a Remote Aux panel.

  - **Regular** — Select this option to place the specific Aux Bus in normal operating mode. The bus can be selected and sources can be changed from the control panel. This mode also allows both local and remote panels to control the Aux Bus.

  - **Follow** — Select this option to place the specific Aux Bus in follow (or “view only”) mode. You can select the bus in the Aux Bus Assign Group and follow what crosspoints are being selected (remotely), but you cannot change crosspoints. In this configuration, the bus is controlled from another location.

Please consult with your facility engineer to learn what operational mode has been programmed for each remote Aux panel in your facility. Refer to Chapter 8 of the *Synergy Q/MD or Q/MD-X Engineering Manual* for instructions on configuring remote Aux panel modes.

**Note**

A GPI input can be assigned to override the current signal selection of a remote Aux panel to a pre-configured one. When the GPI trigger is received by the switcher, it will switch the predetermined Aux Bus to a predetermined BNC output. Refer to Chapter 8 of the *Synergy Q/MD or Q/MD-X Engineering Manual* for details.
Using a Remote Aux Panel

Before attempting to use your Assignable Remote Aux Panel, ensure that it is properly connected to the communication cabling chain that goes back to the main control panel. Also, ensure that the specific Aux Bus video output is connected to the input of the desired destination device.

Use the following procedure to operate a Remote Aux Panel in Regular Mode:

1. Ensure that the Aux Bus that is being controlled by the remote Aux panel is routed to the desired location or device.

   Note
   
   If the Remote Aux Panel is in Follow Mode, you will not be able to change the output assigned from the control panel. You will be able to view different Aux Buses; however, you will not be able to alter the output.

2. Select the Aux Bus that you want to control as follows:

   • Synergy 1 Q/MD — Press Assign 1 through 10 to assign the remote Aux panel to the corresponding Aux Bus. Refer to the following table to determine which Aux bank and Bus is mapped to each button.

<table>
<thead>
<tr>
<th>Remote Aux Panel Assign Buttons</th>
<th>Aux Bus Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assign 1</td>
<td>Bank 1: Bus 1</td>
</tr>
<tr>
<td>Assign 2</td>
<td>Bank 1: Bus 2</td>
</tr>
<tr>
<td>Assign 3</td>
<td>Bank 1: Bus 3</td>
</tr>
<tr>
<td>Assign 4</td>
<td>Bank 1: Bus 4</td>
</tr>
<tr>
<td>Assign 5</td>
<td>Bank 1: Bus 5</td>
</tr>
<tr>
<td>Assign 6</td>
<td>Bank 1: Bus 6</td>
</tr>
<tr>
<td>Assign 7</td>
<td>Bank 1: Bus 7</td>
</tr>
<tr>
<td>Assign 8</td>
<td>Bank 1: Bus 8</td>
</tr>
<tr>
<td>Assign 9</td>
<td>Bank 2: Bus 1</td>
</tr>
<tr>
<td>Assign 10</td>
<td>Bank 2: Bus 2</td>
</tr>
</tbody>
</table>

   • Synergy 1.5 Q/MD and 2 Q/MD/X — Press Assign 1 through 12 to assign the remote Aux panel to the corresponding Aux Bus. Refer to the following table to determine which Aux bank and Bus is mapped to each button.

<table>
<thead>
<tr>
<th>Remote Aux Panel Assign Buttons</th>
<th>Aux Bus Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assign 1</td>
<td>Bank 1: Bus 1</td>
</tr>
<tr>
<td>Assign 2</td>
<td>Bank 1: Bus 2</td>
</tr>
<tr>
<td>Assign 3</td>
<td>Bank 1: Bus 3</td>
</tr>
<tr>
<td>Assign 4</td>
<td>Bank 1: Bus 4</td>
</tr>
</tbody>
</table>
Synergy 2.5 Q/MD and 3, 3.5 and 4 Q/MD-X — The ASSIGN +4 and ASSIGN +8 buttons are used in conjunction with the ASSIGN 1 through ASSIGN 4 buttons to access the higher numbered Aux Buses. Press the ASSIGN +4 or ASSIGN +8 button to light it, and then press the desired ASSIGN 1 through ASSIGN 4 button. Refer to the table below to determine which Aux bank and Bus as mapped to each button.

<table>
<thead>
<tr>
<th>Remote Aux Panel Assign Buttons</th>
<th>Aux Bus Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assign 5</td>
<td>Bank 1: Bus 5</td>
</tr>
<tr>
<td>Assign 6</td>
<td>Bank 1: Bus 6</td>
</tr>
<tr>
<td>Assign 7</td>
<td>Bank 1: Bus 7</td>
</tr>
<tr>
<td>Assign 8</td>
<td>Bank 1: Bus 8</td>
</tr>
<tr>
<td>Assign 9</td>
<td>Bank 2: Bus 1</td>
</tr>
<tr>
<td>Assign 10</td>
<td>Bank 2: Bus 2</td>
</tr>
<tr>
<td>Assign 11</td>
<td>Bank 2: Bus 3</td>
</tr>
<tr>
<td>Assign 12</td>
<td>Bank 2: Bus 4</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Remote Aux Panel Assign Buttons</th>
<th>Aux Bus Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assign +4 and Assign 1</td>
<td>Bank 1: Bus 5</td>
</tr>
<tr>
<td>Assign +4 and Assign 2</td>
<td>Bank 1: Bus 6</td>
</tr>
<tr>
<td>Assign +4 and Assign 3</td>
<td>Bank 1: Bus 7</td>
</tr>
<tr>
<td>Assign +4 and Assign 4</td>
<td>Bank 1: Bus 8</td>
</tr>
<tr>
<td>Assign +8 and Assign 1</td>
<td>Bank 2: Bus 1</td>
</tr>
<tr>
<td>Assign +8 and Assign 2</td>
<td>Bank 2: Bus 2</td>
</tr>
<tr>
<td>Assign +8 and Assign 3</td>
<td>Bank 2: Bus 3</td>
</tr>
<tr>
<td>Assign +8 and Assign 4</td>
<td>Bank 2: Bus 4</td>
</tr>
</tbody>
</table>

Synergy 2.5 Q/MD/X 3, 3.5 and 4 Q/MD-X — Assignable Panels

<table>
<thead>
<tr>
<th>Remote Aux Panel Assign Buttons</th>
<th>Aux Bus Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assign 1</td>
<td>Bank 1: Bus 1</td>
</tr>
<tr>
<td>Assign 2</td>
<td>Bank 1: Bus 2</td>
</tr>
<tr>
<td>Assign 3</td>
<td>Bank 1: Bus 3</td>
</tr>
<tr>
<td>Assign 4</td>
<td>Bank 1: Bus 4</td>
</tr>
<tr>
<td>Assign +4 and Assign 1</td>
<td>Bank 1: Bus 5</td>
</tr>
<tr>
<td>Assign +4 and Assign 2</td>
<td>Bank 1: Bus 6</td>
</tr>
<tr>
<td>Assign +4 and Assign 3</td>
<td>Bank 1: Bus 7</td>
</tr>
<tr>
<td>Assign +4 and Assign 4</td>
<td>Bank 1: Bus 8</td>
</tr>
<tr>
<td>Assign +8 and Assign 1</td>
<td>Bank 2: Bus 1</td>
</tr>
<tr>
<td>Assign +8 and Assign 2</td>
<td>Bank 2: Bus 2</td>
</tr>
<tr>
<td>Assign +8 and Assign 3</td>
<td>Bank 2: Bus 3</td>
</tr>
<tr>
<td>Assign +8 and Assign 4</td>
<td>Bank 2: Bus 4</td>
</tr>
</tbody>
</table>
3. Select the signal that you want to feed to the Aux Bus output BNC by using one of the following options:

- Press a Crosspoint button to route the associated video signal to the Aux Bus output BNC.

  **Note** If the panel is configured to use shifted crosspoints, hold down the SHIFT button on the remote panel, then press the desired crosspoint to select the shifted video source. Panels that are not configured to use shifted crosspoints assign the SHIFT button as the last of the regular crosspoints.

- Press PV to route the preview output to the Aux Bus.
- Press an MLE button to route the output from that MLE to the Aux Bus.
- Press CLEAN FEED to route the Clean Feed output to the Aux Bus.
- Press PGM to route the PGM output to the Aux Bus.

  **Note** The special crosspoints (such as PV, the MLEs and CLEAN FEED) do not support the shifted function.
Preview Overlay Group

The following figures illustrate the Preview Overlay Group. The location and layout of the Preview Overlay groups vary between control panels.

The buttons in the Preview Overlay Group allow you to control a sophisticated character generator display that is displayed over the selected preview source.

Synergy 3 and 4

Both the Synergy 3 and 4 Q/MD/X control panels use the same Preview Overlay Group. This group provides access to the preview overlay functions. Refer to the section “Preview Overlay Elements” on page 12–14 for more information on each of the preview overlays.

Synergy 2

On the Synergy 2 Q/MD/X control panel, the Preview Overlay buttons are located in the Global Memory System Group. Refer to the section “Preview Overlay Elements” on page 12–14 for more information on each of the preview overlays.

Synergy 1

There is no direct button access to the Preview Overlay functions from the Synergy 1 Q/MD control panel. In order to show the Preview Overlay element, you will have to toggle a specific overlay on or off from the Preview Menu as follows:

1. Navigate to the Preview Overlay Menu 1-2 as follows:
   • Press HOME ⇒ Preview Overlay.
2. Toggle the Preview Overlay element you want to display On or Off to have it shown on the Preview Monitor. Refer to the section “Preview Overlay Elements” on page 12–14 for more information on each of the preview overlays.

3. Press MORE to display the Preview Menu 2-2.

4. Toggle the Preview Overlay element you want to display On or Off to have it shown on the Preview Monitor. Refer to the section “Preview Overlay Elements” on page 12–14 for more information on each of the preview overlays.

Preview Overlay Elements

The Preview Overlay consists of a number of overlays that can be added or removed from the Preview Monitor as desired. These overlays are as follows:

Source ID

The Source Identification overlay displays the name of the current program source, the current transition (and direction), followed by the name of the current preview source. For example:

VTR 1 -W-> CAM 2
CAM 1 -D-> MLE 3

The program source (in red) is displayed on the left and indicates what is currently on-air and will be taken off-air during the next transition. The preview source (in green) is displayed on the right and indicates what will be taken on-air during the next transition. Between the program and preview sources is the transition type. The types of transitions are indicated as follows:

- D = Dissolve
- W = Wipe
- S = DVE Send
- ST = S&T Wipe

Note

The transition type does not indicate the status of the three next transition buttons.

The position of the Source ID overlay can be changed from the Source ID Position Menu.
Use the following procedure to change the size and position of the Source ID overlay of on a Synergy 1 Q/MD control panel:

1. Navigate to the **Source ID Position Menu** as follows:
   - Press **HOME** ⇒ **Preview Overlay** ⇒ **MORE** ⇒ **Source ID**.

   **Note**
   There is no **Preview Overlay Menu 1-2** on the Synergy 2, 3 or 4 Q/MD/X control panels. On these systems, pressing **Preview Overlay** will take you to the **Preview Overlay Menu**, which is the **Preview Overlay Menu 2-2** as shown below.

2. Adjust the position of the Source ID overlay as follows:
   - Use the **X** knob to adjust the horizontal position of the Source ID overlay. You can also use the positioner.
   - Use the **Y** knob to adjust the vertical position of the Source ID overlay. You can also use the positioner.

3. Adjust the size of the Source ID overlay as follows:
   - Use the **Size** knob to select the size of the Source ID overlay. You can select a size ranging from 20 (smallest) to 350 (largest).

This completes the procedure for changing the size and position of the Source ID overlay.

**VTR Timecode**

The **VTR Timecode** overlay displays the timecode of a VTR, DDR, Video Server or other serial-controlled device that is chosen on the **Preset and Program Buses** of the PGM/PST MLE, for example, **12:59:59:23**.

The remote port of the device must be connected to the switcher. For VTRs, the **VTR Remote Control Option** must be installed. For Video Servers, the **Video Server Control Option** must be installed.

**Important**

The **VTR**, Video Server or other serial-controlled device must be selected on the **Preset Bus** of the Program/Preset MLE.

The display is useful for determining if serial controlled devices are properly cued and properly rolling after issuing “play” and “VTR Clip” commands.

When selected, the timecode overlay is updated in real time.

If the color of the timecode overlay is yellow, the video that is selected on the **Preset Bus** is the source device itself. If the color of the timecode overlay is gray, the video that is selected on the
Preset Bus does not match the timecode of the overlay — a different source has been selected, however, the system continues to update and display the timecode value.

The VTR Timecode overlay is made up of three elements, the input BNC of the clips, the timecode of the clips, and the time remaining in the clips.

The position of the VTR Timecode overlay can be changed from the VTR Position Menu.

Use the following procedure to change the size and position of the VTR Timecode overlay on a Synergy 1 Q/MD control panel:

1. Navigate to the VTR Position Menu as follows:
   - Press HOME ⇒ Preview Overlay ⇒ MORE ⇒ VTR.

2. Adjust the position of the VTR overlay as follows:
   - Use the X knob to adjust the horizontal position of the VTR overlay. You can also use the positioner.
   - Use the Y knob to adjust the vertical position of the VTR overlay. You can also use the positioner.

3. Adjust the size of the VTR overlay as follows:
   - Use the Size knob to select the size of the VTR overlay. You can select a size ranging from 20 (smallest) to 350 (largest).

This completes the procedure for changing the size and position of the VTR overlay.

Note

There is no Preview Overlay Menu 1-2 on the Synergy 2, 3 or 4 Q/MD/X control panels. On these system, pressing Preview Overlay will take you to the Preview Overlay Menu, which is the Preview Overlay Menu 2-2 as shown below.
The CENTER overlay places Cross Hairs on the main preview output to indicate the center of the picture, as displayed below:

The CENTER overlay is useful for aligning text and other information (both horizontally and vertically).

Use the following procedure to change the position of the Center overlay on a Synergy 1 Q/MD control panel:

1. Navigate to the Safe Title Menu as follows:
   • Press HOME ⇒ Preview Overlay ⇒ MORE ⇒ Safe Title Center Position.

   **Note**
   There is no Preview Overlay Menu 1-2 on the Synergy 2, 3 or 4 Q/MD/X control panels. On these system, pressing Preview Overlay will take you to the Preview Overlay Menu, which is the Preview Overlay Menu 2-2 as shown below.

   **Note**
   When you press the Safe Title Center Position, both the Center Position and Safe Title overlays will be shown.

2. Select a predefined center as follows:
   • Use the Safe ID knob to select the predefined Safe Title set up. If want to define a Center that is different than the one in the selected Safe Title set up, you can edit it by changing the center position.

   **Note**
   You can alter the name of the Safe ID using the Modify Name softkey, refer to the section “Safe Title Modify Name” on page 12–20. The values set for each Safe ID will remain stored in “personality” memory until you press Reset for each Safe ID to restore the values to their default settings.
3. Press **Center** to display the **Center Menu**.

![Safe Title — Center Menu]

4. Adjust the **X** knob to adjust the horizontal position of the Center overlay. You can also use the positioner.
   - Use the **Y** knob to adjust the vertical position of the Center overlay. You can also use the positioner.

This completes the procedure for changing the position of the Center overlay.

**Safe Title**

The **Safe Title** overlay places a SMPTE standard safe title and safe action grid on screen, as displayed below:

![SMPTE Standard Safe Title and Safe Action Grid]

The **Safe Title** box (inner box) outlines the area that the vast majority of home TV sets will be able to read text inside of.

The **Safe Action** box (outer box) outlines the region that viewers should be able to follow action.

**Note**

The borders of the Safe Action box track with the borders of the Safe Title box.

Use the following procedure to change the position and text size of the Safe Title overlay on a **Synergy 1 Q/MD** control panel:

1. Navigate to the **Safe Title Menu** as follows:
   - Press **HOME** ⇒ **Preview Overlay** ⇒ **MORE** ⇒ **Safe Title Center Position**.

**Note**

There is no **Preview Overlay Menu 1-2** on the **Synergy 2, 3 or 4 Q/MD/X** control panels. On these systems, pressing **Preview Overlay** will take you to the **Preview Overlay Menu**, which is the **Preview Overlay Menu 2-2** as shown below.
2. Select a predefined Safe Title as follows:
   • Use the Safe ID knob to select the predefined Safe Title set up. If want to define a Top/Left that is different than the one in the selected Safe Title set up, you can edit it by changing the center position.

3. Press Top/Left to display the Top/Left Menu.

4. Adjust the position of the top and left sides of the Safe Title overlay as follows:
   • Use the Left knob to adjust the horizontal position of the left side of the Safe Title overlay. You can also use the positioner.
   • Use the Top knob to adjust the vertical position of the top side of the Safe Title overlay. You can also use the positioner.

5. Press Bottom/Right to display the Bottom/Right Menu.

6. Adjust the position of the bottom and right sides of the Safe Title overlay as follows:
   • Use the Right knob to adjust the horizontal position of the right side of the Safe Title overlay. You can also use the positioner.
   • Use the Bottom knob to adjust the vertical position of the bottom side of the Safe Title overlay. You can also use the positioner.

This completes the procedure for changing the position of the Safe Title overlay.
Safe Title Modify Name

Use the following procedure to modify the name of the Safe ID assigned to the bottom knob in the Safe Title Setup Menu on a Synergy 1 Q/MD control panel:

1. Navigate to the Safe Title Menu as follows:
   - Press HOME ⇒ Preview Overlay ⇒ MORE ⇒ Safe Title Center Position.

   **Note**
   There is no Preview Overlay Menu 1-2 on the Synergy 2, 3 or 4 Q/MD/X control panels. On these systems, pressing Preview Overlay will take you to the Preview Overlay Menu, which is the Preview Overlay Menu 2-2 as shown below.

   **Note**
   When you press the Safe Title Center Position, both the Center Position and Safe Title overlays will be shown.

2. Press Modify Name to display the Change Safe Title Name Menu.

   ![Change Safe Title Name Menu](image)

   **Safe Title Setup — Change Safe Title Name Menu**

   3. Use the Safe Title knob to select the Safe ID you want to change the name for.

   4. Edit the desired Safe Title Name as follows:
      - Use the Horizontal knob to move the highlight horizontally.
      - Use the Vertical knob to move the highlight vertically.
      - Use the Space, Prev Letter, Next Letter and Default softkeys to edit the name as required.

   5. Press Accept New Name to save the name as modified.

   **Note**
   The new name will remain stored in “personality” memory until you press Default to reset the name to its default name.

This completes the procedure for changing the Safe ID name of the Safe Title overlay.

Time Clock

The Time Clock overlay places a count-down, count-up, or count-down-then-up timer on the main preview output. This overlay timer can be used in the timing of commercials or other events.

When properly set up, the Time Clock will start counting on every transition, resetting back to zero or the selected preset when a transition is performed on an MLE that the Time Clock has been turned on for, or for a FTB.
Use the following procedure to set up the Time Clock on a Synergy 1 Q/MD control panel:

1. Navigate to the **Time Clock Menu** as follows:
   - Press **HOME** ⇒ **Preview Overlay** ⇒ **MORE** ⇒ **Time Clock**.

   ![Note]

   **Note**

   There is no **Preview Overlay Menu 1-2** on the Synergy 2, 3 or 4 Q/MD/X control panels. On these systems, pressing **Preview Overlay** will take you to the **Preview Overlay Menu**, which is the **Preview Overlay Menu 2-2** as shown below.

2. Press **Position** to display the **Time Clock Position Menu**.

   ![Time Clock Position Menu]

3. Adjust the position of the Time Clock overlay as follows:
   - Use the **X** knob to adjust the horizontal position of the Time Clock overlay. You can also use the positioner.
   - Use the **Y** knob to adjust the vertical position of the Time Clock overlay. You can also use the positioner.

4. Adjust the size of the Time Clock overlay as follows:
   - Use the **Size** knob to select the size of the Time Clock overlay. You can select a size ranging from 20 (smallest) to 350 (largest).
5. Press **Transition** to display the **Preview Trans Menu**.

6. Toggle the **Master** softkey **On** to display the extended **Preview Trans Menu**.

   **Note** When toggled **On**, the **MLE** and **FTB** features will allow the Time Clock to be reset whenever a transition or FTB is run.

7. Select on what transition you want the Time Clock to reset as follows:

   **Note** The example shown here is for a **Synergy 3 Q/MD/X** control panel. The number of MLEs shown will depend on the control panel you have.

   - Toggle the **MLE1** softkey **On** or **Off** to have the Time Clock reset when a transition is performed on MLE 1.
   - Toggle the **MLE2** softkey **On** or **Off** to have the Time Clock reset when a transition is performed on MLE 2.
   - Toggle the **MLE3** softkey **On** or **Off** to have the Time Clock reset when a transition is performed on MLE 3.
   - Toggle the **FTB** softkey **On** or **Off** to have the Time Clock reset when a FTB is performed.

8. Press **Direction** to display the **Direction Menu**.

9. Use the **Going** knob to select the direction you want the Time Clock to run. You can choose from the following:

   - **Up** — Select this option to have the clock count up from zero.
   - **Down** — Select this option to have the clock count down from a preset time to zero. The preset starting time is set from the **Reset Time Menu**.
• **Down->Up** — Select this option to have the clock count down from a preset time to zero and then up from zero. When the clock reaches zero the color of the Time Clock display will turn black.

10. Press **Reset Time** to display the **Reset Time Menu**.

   ![Time Clock](image)

   **Time Clock** — **Reset Time Menu**

   Note

   If the Time Clock direction is set to **Up**, the **Hours**, **Minutes** and **Seconds** values on this menu will be gray. The Direction must be set to either **Down**, or **Down->Up** in order to use this feature.

11. Set the Preset Time for the Time Clock as follows:

   • Use the **Hours** knob to select the number of hours you want the clock to count down from.
   
   • Use the **Minutes** knob to select the number of minutes you want the clock to count down from.
   
   • Use the **Seconds** knob to select the number of seconds you want the clock to count down from.

This completes the procedure for setting up the Time Clock overlay.

**Preview Mask**

The **Preview Mask** overlay places an outline on the main preview output around any active box mask. This function makes it easy to identify various masks, particularly when one may be placed near the edge of the screen.

![Sample Mask Preview Overlay](image)

Note

You can check masks in the various MLEs by pressing the MLE buttons in the “**Effects Control Assignment Section**” — located in the **Effects Control Group** of the switcher. One button is provided for each Keyer in the MLEs and DSKs.
**Hide Overlays**

The **Hide Overlays** button turns off all preview overlay that are currently enabled. When the button is lit, all overlays are hidden, but your total setup is retained. When the button is turned off again, all overlays are restored to the monitor.

**Note**

When **HIDE OVLY** is lit, all enabled overlay buttons also remain lit. In this way, you can see the hidden functions, and then enable or disable them as required during the **hidden** mode.

**Preview Overlay Font Color**

You can adjust the color of the font used for various elements of the preview overlay. Color selections are applied to the fonts, and not to the safe title or other graphical elements.

Use the following procedure to set the color of the fonts used for various preview overlay elements:

1. Navigate to the **Preview Overlay Font Color Menus** as follows:

   • Press **HOME ➔ More ➔ Setup ➔ Personality ➔ Preview Font Colors**.

   ![Preview Overlay Font Color Menu]

2. Use the **Font** knob to select the preview overlay element that you want to change the font color for. You can select from the following:

   • **Time Up** — Select this option to set the color of the **Time Clock** text when the time clock is counting up.

   • **Time Down** — Select this option to set the color of the **Time Clock** text when the time clock is counting down.

   • **VTR Active** — Select this option to set the color of the **VTR Timecode** text when the VTR is running.

   • **VTR Inactive** — Select this option to set the color of the **VTR Timecode** text when the VTR is not running.

   • **Source ID** — Select this option to set the color of the program video on the **Source ID** text.

   • **Tran ID** — Select this option to set the color of the transition type on the **Source ID** text.

   • **Dest ID** — Select this option to set the color of the preset video on the **Source ID** text.

3. Use the **Color** knob to select the color that you want to apply to the text of the selected preview overlay element.

This completes the procedure for setting the color of the fonts used for various preview overlay elements.
Editor Interface

The Editor Interface button in the Global Memory System Group allows the Synergy Q/MD/X switchers to be controlled by an editing system.

Toggle the EDITOR button On to allow remote control from an external editor over the switcher. The Editor Interface Option must be installed. When lit, remote control is enabled, but some local operation can still be performed.

To set up the interface, ensure that you properly connect your edit controller to the EDITOR port on the rear of the Synergy chassis, and properly assign your editor to switcher control from within your editing system.

Refer to the chapter, “Editors/OverDrive” of the Synergy Q/MD or Q/MD-X Engineering Manual for full instructions. Refer to your edit controller installation and operating manuals for details on the capabilities of the remote switcher interface.
External Still Store Interface

Synergy Q/MD/X switchers interface with still store devices using Intelligent Interface protocol. You can access different stills that are stored on the still store device directly from the switcher.

Refer to Chapter 10 of the Synergy Q/MD or Q/MD-X Engineering Manual for configuration instructions. For additional information, refer to the documentation that came with your still store.

Changing the Still ID

Use the following procedure to change the Still ID that the still store device is sending to Synergy:

1. Select the still store crosspoint on the desired MLE.

   The Global Memory System Group switches to Still Store mode, and the display area provides information pertaining to the still store output.

   ![Global Memory System Group Display — Still Store Mode](image)

   The upper line indicates the four digit number of the still that the still store is sending to the switcher.

   If the switcher has not received the requested Still ID from the still store, the line reads:

   **Still not loaded**

   The lower line indicates which channel the still store is using to send stills to the Synergy Q/MD/X switcher.

   When the Global Memory System is in Still Store mode, the VTR CLIP button lights as an indicator.

2. Change the Still ID number by entering the new number using the key pad in the Global Memory System Group.

3. When the new number shows in the display area, press the lit ENTER button.

   The displayed four digit Still ID will return to the original value for a moment after the ENTER button is pressed; however, it updates to the new value after the still store cues the new still image.

This completes the procedure for changing the Still ID from the Synergy switcher.
Character Generator Interface

Synergy Q/MD/X switchers interface with character generators. With the Character Generator software option installed, you can load and run effects, load and navigate through a playlist or a Character Generator (CG) template, and edit CG text directly from the Synergy control panel and keyboard.

The following configurations must be completed before your Synergy switcher can be set up to control the Character Generator:

- Ensure that Character Generator BNCs are configured appropriately. Refer to the section “Setting Up BNC Types” in the chapter, “BNC Configuration and Check” and the section “Setting up Character Generator BNCs” in the chapter, “Character Generators” of the Synergy Q/MD or Q/MD-X Engineering Manual for configuration instructions.

- Ensure that BNCs are associated to the Alpha. Refer to the sections “Setting Up Alphas” and “Setting Up Auto Keys” in the chapter, “BNC Configuration and Check” of the Synergy Q/MD or Q/MD-X Engineering Manual for configuration instructions.

- Ensure that the remote ports are configured appropriately. Refer to the section “Communications Setup” in the chapter, “Character Generators” of the Synergy Q/MD or Q/MD-X Engineering Manual for configuration instructions.

Operating Tip

Refer to your specific Character Generator documentation for additional configuration details.

Leitch (Inscriber) Inca CG

This section provides information on operating your Leitch (Inscriber) Inca CG. The following topics are discussed:

- “Selecting a Mode” on page 12–27
- “Using Sequence Mode” on page 12–28
- “Using Manual Mode” on page 12–31
- “Modifying Text” on page 12–33
- “Modifying an Effect” on page 12–34
- “Selecting Channels” on page 12–39

Selecting a Mode

The Leitch (Inscriber) Inca CG can be operated in either Sequence Mode or Manual Mode:

- **Sequence Mode** – This mode is used to select a sequence file (INS).
- **Manual Mode** – This mode is used to modify individual pages on an as-required basis (ICG).
Selecting a Mode

Use the following procedure to select a mode:

1. Navigate to the Remote Control Select Menu as follows:
   - Press HOME ⇒ Effects ⇒ MORE ⇒ Remote Control Select.
2. Press Character Generator to display the Character Generator Remote Control Menu.
3. Use the BNC knob to select the BNC for your device.
4. Press GO!! to display the Character Generator Control Menu 1-2.

Operating Tip

You can also press the Character Generator crosspoint on the MLE to display the Character Generator Menu 1-2.

5. Press MORE to display the Character Generator Control Menu 2-2.

6. Toggle Mode Seq./Man. between Seq. and Man. as follows:
   - Seq. — Use this option to set the Inscriber CG to Sequence Mode.
   - Man. — Use this option to set the Inscriber CG to Manual Mode.

Note

The current Mode, Channel and Folder/FileName information is saved in non-volatile memory on the switcher and is stored and recalled with the Personality Settings. This allows you to retain your CG settings if the switcher powers down.

This concludes the procedure to select a mode.

Using Sequence Mode

This section includes instructions when the Inscriber CG is set to Sequence Mode in the Synergy menu system.
The following topics are discussed:

- “Selecting a File” on page 12–29
- “Loading a Page” on page 12–29
- “Recalling an Event” on page 12–30
- “Running an Event” on page 12–30

**Selecting a File**

Use the following procedure to select a file while in Sequence Mode:

1. Ensure the Inscriber CG is set to **Sequence Mode** in the Synergy menu system. Refer to the section “Selecting a Mode” on page 12–28 for details.

2. Press **Select File** to select the sequence file.

3. Use the keyboard to enter the address of the required sequence file.

**Important**

A standard PS/2 keyboard is required to input data. Contact Ross Video Technical Support for relevant information.

**Important**

Do NOT place anything on your keyboard or place your keyboard in a position where any of the keys could be accidently pressed. This could result in the Switcher acting unpredictably.

**Loading a Page**

Use the following procedure to load an event to the current program preview:

1. Ensure the Inscriber CG is set to **Sequence Mode** in the Synergy switcher menu system. Refer to the section “Selecting a Mode” on page 12–28 for details.

2. Toggle the **View Lst/Crt** button to **Lst**.

A list of the available events is displayed on the **Character Generator Control Menu**.

---

Synergy Q/MD/X Operator’s Manual (v9.1 MD)  Peripheral Control and More • 12–29
3. Use the middle knob to select an event from the current file.

4. Load the selected event to a Character Generator channel as follows:
   - Press List To PV to load the currently selected page to the Character Generator Preview channel.
   OR
   - Press List to PGM to load the currently selected page to the Character Generator Program channel.

This concludes the procedure to display a list of all events on the Character Generator Program or Preview channel.

**Recalling an Event**

Use the following procedure to recall the page selected in the preview or program channel as an event:

1. Ensure the Inscriber CG is set to Sequence Mode in the Synergy switcher menu system. Refer to the section “Selecting a Mode” on page 12–28 for details.

2. Press MORE to display the Character Generator Control Menu 1-2.

<table>
<thead>
<tr>
<th>Char.</th>
<th>Ctrl.</th>
<th>BNC.</th>
<th>Channels</th>
<th>(1-2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>File: 1000, INS</td>
<td>Events Number: BS</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PV: One (1)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1: Non</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2: Space Shuttle</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Folder/FileName: c:/autosys/1000.INS</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Character Generator Control Menu — Recall CG to PV**

The selected files tag information will be displayed in the PV or PGM column.

3. Recall a selected event to the Preview channel of the Character Generator as follows:
   - Press Recall CG to PV.
   - Select an event using the Synergy Global Memory System to recall it to the Preview channel of the Character Generator. The selected files tag information will be displayed in the PV column.

4. Recall a selected event to the Program channel of the Character Generator as follows:
   - Press Recall CG to PGM.
   - Select an event using the Synergy Global Memory System to recall it to the Program channel of the CG. The selected files tag information will be displayed in the PGM column. This page is now available for keying.

This concludes the procedure to recall the page selected in the Preview or Program channel as an event.

**Running an Event**

Use the following procedure to make the next event available for keying to air:

1. Ensure an event is loaded to the Preview column. Refer to the section “Recalling an Event” on page 12–30 for more information.
2. Press **Run Effect** to advance the Character Generator page displayed in the Preview (PV) column to the Program (PGM) column. This action will automatically display the next page of the list in the Preview column.

This completes the procedure to make the next event available for keying to air.

**Using Manual Mode**

This section includes instructions when the Inscriber CG is set to **Manual Mode** in the Synergy menu system.

The following topics are discussed:

- “**Selecting a Folder**” on page 12–31
- “**Recalling a Page**” on page 12–31
- “**Running an Effect**” on page 12–32

**Selecting a Folder**

All pages that are recalled in manual mode will be searched for in the defined folder.

Use the following procedure to select a folder in Manual mode:

1. Ensure the Inscriber CG is set to **Manual Mode** in the Synergy switcher menu system. Refer to the section “**Selecting a Mode**” on page 12–28 for details.
2. Press **MORE** to display the **Character Generator Control Menu 2-2**.

   ![Character Generator Menu 2-2](image)

3. Select a folder as follows:
   - Press **Select Folder**.
   - Use a standard PS/2 keyboard connected to the Synergy switcher to enter the address of the required folder.

**Important**

Do NOT place anything on your keyboard or place your keyboard in a position where any of the keys could be accidently pressed. This could result in the Switcher acting unpredictably.

This completes the procedure to select a folder in Manual mode.

**Recalling a Page**

Use the following procedure to recall a page in Manual mode:

1. Ensure the Inscriber CG is set to **Manual Mode** in the Synergy switcher menu system. Refer to the section “**Selecting a Mode**” on page 12–28 for details.
2. Press MORE, with the folder loaded to the Character Generator to return to the Character Generator Menu 1-2.

3. Recall a page to the Preview channel of the Inscriber CG as follows:
   • Press Recall CG to PV.
   • Select a file using the Synergy Global Memory System to recall it to the Preview channel of the Character Generator.

   **Important**
   Files stored with non-numerical names can not be recalled this way. Refer to the section “Setting up the Character Generator” in the chapter, “Character Generators” of the Synergy Q/MD or Q/MD-X Engineering Manual.

   The tag information for the file is now displayed in the PV column of the Character Generator Menu 1-2.

4. Recall a page to the Program channel of the Inscriber CG as follows:
   • Press Recall CG to PGM
   • Select a file using the Synergy Global Memory System to recall an event directly to the PGM bus. This event will be taken to air immediately.

   The tag information for the file is now displayed in the PGM column of the Character Generator Menu 1-2.

   This concludes the procedure to recall a page to the Preview or Program channel of the Inscriber CG.

**Running an Effect**

Use the following procedure to move the effect and its tag information in the Preview (PV) column, to the Program (PGM) column:

1. Ensure the Inscriber CG is set to Manual Mode in the Synergy switcher menu system. Refer to the section “Selecting a Mode” on page 12–28 for details.
2. Ensure a file is loaded to the Preview column of the Character Generator Menu. Refer to the section “Selecting a File” on page 12–29 for details.

3. Press Run Effect to advance the current preview file displayed in the preview (PV) column to the program (PGM) column. This action will automatically display the next file in the Preview column.

This concludes the procedure to move the effect in the Preview (PV) column to the Program (PGM) column.

**Modifying Text**

The text displayed in the Preview (PV) column or Program (PGM) column of the Synergy Character Generator Menu can be modified.

*Important* Character Generator parameters that are modified from the switcher are only in effect for the current session.

The following topics are discussed:

- “Modifying PGM Text” on page 12–33
- “Modifying PV Text” on page 12–34

**Modifying PGM Text**

Use the following procedure to modify the Program (PGM) text:

1. Load a page to the PGM Channel of the Inscriber CG.
   - **Sequence Mode** — Refer to the section “Loading a Page” on page 12–29 for instructions on loading a page while in Sequence Mode.
   - **Manual Mode** — Refer to section “Recalling a Page” on page 12–31 for instructions on loading a page while in Manual Mode.

2. Press Change PGM Text to display the CharGen – Change PGM Text Menu.

3. Change the tag information for the event on air by pressing the applicable softkey and editing the text using the keyboard. The menu softkeys are renamed to coincide with the tag names.

*Important* A standard PS/2 keyboard is required to input data. Contact Ross Video Technical Support for relevant information.

*Important* Do NOT place anything on your keyboard or place your keyboard in a position where any of the keys could be accidently pressed. This could result in the Switcher acting unpredictably.
4. Press **UP ONE** to return to the **Character Generator Menu 1-2**.

This concludes the procedure to change the text of a loaded page in the Program (PGM) Channel of the Inscriber CG.

**Modifying PV Text**

Use the following procedure to modify the Preview (PV) text:

1. Load a page to the PV Channel of the Inscriber CG.
   - **Sequence Mode** — Refer to the section “**Loading a Page**” on page 12–29 for instructions on loading a page while in Sequence Mode.
   - **Manual Mode** — Refer to the section “**Recalling a Page**” on page 12–31 for instructions on loading a page while in Manual Mode.

2. Press **Change PV Text** to display the **CharGen – Change PV Text Menu**.

3. Modify the tag information for the event on the PV bus by pressing the applicable softkey and editing the text using a standard PS/2 keyboard connected to the Synergy switcher. The menu softkeys are renamed to coincide with the tag names.

   **Important**

   Do NOT place anything on your keyboard or place your keyboard in a position where any of the keys could be accidently pressed. This could result in the Switcher acting unpredictably.

4. Press **UP ONE** to return to the **Character Generator Menu 1-2**.

   **Note**

   You will not be able to see animations or special effects, and only the first frame of an active texture will be displayed.

This concludes the procedure to change the Preview (PV) text of a loaded page on the Inscriber CG.

**Modifying an Effect**

**Important**

Character Generator parameters that are modified from the switcher are only in effect for the current session.

The following effects can be modified and applied to the Preview video output of the Character Generator when it is transitioned to the Program output (PGM):

- Effect
- Pattern
- Speed
• Ease
• Reverse
• Row Direction.

**Note**
You will not be able to see animations or special effects, and only the first frame of an active texture will be displayed.

**Selecting Effects**
Use the following procedure to select an effect:

1. Navigate to the **Remote Control Select Menu** as follows:
   - Press HOME ⇒ Effects ⇒ MORE ⇒ Remote Control Select.
2. Press **Character Generator** to display the **Character Generator Remote Control Menu**.
3. Use the **BNC** knob to select the BNC for your device.
4. Press **GO!!** to display the **Character Generator Menu 1-2**.

**Operating Tip**
You can also press the Character Generator crosspoint on the MLE to display the **Character Generator Menu 1-2**.

<table>
<thead>
<tr>
<th>Char Gen BNC 9</th>
<th>Channel: A (1-2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>PU: One (1)</td>
<td>FGM: NONE</td>
</tr>
<tr>
<td>1: Home</td>
<td>No Text Info</td>
</tr>
<tr>
<td>2: Space Shuttle</td>
<td></td>
</tr>
<tr>
<td>3:</td>
<td></td>
</tr>
<tr>
<td>4:</td>
<td></td>
</tr>
<tr>
<td>5:</td>
<td></td>
</tr>
<tr>
<td>6:</td>
<td></td>
</tr>
<tr>
<td>Folder/FileName</td>
<td>/auto/samples/ICE</td>
</tr>
</tbody>
</table>

**Character Generator Menu 1-2**

5. Press **Select Effect** to display the **Character Generator – Select Effect Menu**.

<table>
<thead>
<tr>
<th>Char Gen - Select Effect:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Effect: Effect:...Wipe</td>
</tr>
<tr>
<td>Pattern:...Vertical Slide Wipe</td>
</tr>
<tr>
<td>Speed:...15 frames</td>
</tr>
<tr>
<td>Ease:...No Ease</td>
</tr>
<tr>
<td>Reverse:...In</td>
</tr>
<tr>
<td>Row Direction:...Up</td>
</tr>
</tbody>
</table>

**Char Gen Select Effect Menu**
6. Select an effect to modify as follows:

- Press **Effect** to display the **Effect Menu**.

**Char Gen - Select Effect**

<table>
<thead>
<tr>
<th>Current Effect:</th>
<th>Effect Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Effect........Hide</td>
<td>Wipe Push</td>
</tr>
<tr>
<td>Pattern........Vertical Slide Wipe</td>
<td>Hide</td>
</tr>
<tr>
<td>Speed..............15 frames</td>
<td>Reverse</td>
</tr>
<tr>
<td>Ease.............No Ease</td>
<td>Direction</td>
</tr>
<tr>
<td>Reverse.........On</td>
<td></td>
</tr>
<tr>
<td>Row Direction...Up</td>
<td></td>
</tr>
</tbody>
</table>

- Use the **Effect** knob to select an effect type. You can choose between the following:
  - Wipe
  - Push
  - Hide
  - Reveal
  - Dissolve
  - Cut

This concludes the procedure to select the type of effect.

**Selecting the Pattern of an Effect**

Use the following procedure to select the pattern of an effect:

1. Select an effect to modify. Refer to the section “**Selecting Effects**” on page 12–35 for details.

2. Press **Pattern** to display the **Pattern Menu**.

**Char Gen - Select Effect**

<table>
<thead>
<tr>
<th>Current Effect:</th>
<th>Pattern Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Effect........Hide</td>
<td>Hor. Slide</td>
</tr>
<tr>
<td>Pattern........Vertical Slide Wipe</td>
<td>Hor. Split</td>
</tr>
<tr>
<td>Speed..............15 frames</td>
<td>Hor. Split</td>
</tr>
<tr>
<td>Ease.............No Ease</td>
<td>Box</td>
</tr>
<tr>
<td>Reverse.........On</td>
<td>Box</td>
</tr>
<tr>
<td>Row Direction...Up</td>
<td>Row Slide</td>
</tr>
</tbody>
</table>

- Use the **Pattern** knob to select a pattern. You can select from the following:
  - Horizontal Slide Wipe
  - Vertical Slide Wipe
  - Horizontal Split Wipe
  - Vertical Split Wipe
  - Box Wipe
  - Row Slide/Wipe
  - Row by Row Scanline
• Screen Scanline Wipe
• Pixel Wipe

This concludes the procedure to select a pattern of an effect.

**Modifying the Speed of an Effect**

Use the following procedure to modify the number of frames it takes for the effect to end:

1. Select an effect to modify. Refer to the section “Selecting Effects” on page 12–35 for details.
2. Press **Speed** to display the **Speed Menu**.

   ![Char Gen - Select Effect — Speed Menu](image)

3. Use the **Speed** knob to select the speed, in frames, for the transition to occur.
   - You can choose a speed between 0 and 150 frames.

This concludes the procedure to modify the number of frames it takes for the effect to end.

**Ease**

Use the following procedure to modify the result of Ease on the effect:

1. Select an effect to modify. Refer to the section “Selecting Effects” on page 12–35 for details.
2. Press **Ease** to display the **Ease Menu**.

   ![Char Gen - Select Effect — Ease Menu](image)

3. Use the **Ease** knob to select an Ease effect. You can choose between the following:
   - No Ease
   - Ease In
   - Ease Out
   - Ease In&Out

This concludes the procedure to modify the result of Ease on the effect.
**Reverse**

Use the following procedure to reverse the direction of the effect:

1. Select an effect to modify. Refer to the section “Selecting Effects” on page 12–35 for details.

2. Toggle the **Reverse** button between **On** and **Off** as follows:

   - **On** — Select **On** to perform the effect in reverse.
   - **Off** — Select **Off** to perform the effect in the normal forward direction.

This concludes the procedure to reverse the direction of the effect.

**Row Direction**

Use the following procedure to define the direction of the row:

1. Select an effect to modify. Refer to the section “Selecting Effects” on page 12–35 for details.

2. Press **Row Direction** to display the **Row Direction Menu**.

3. Use the **Row Direction** knob to select the direction that you would like the rows of text to be transitioned off the screen. You can choose between the following:

   - **Up**
   - **Down**
   - **Left**
   - **Right**
   - **Static**

This concludes the procedure to define the direction of the row.
Selecting Channels

Use the following procedure to select the channel to setup:

1. Navigate to the Remote Control Select Menu as follows:
   - Press HOME ⇒ Effects ⇒ MORE ⇒ Remote Control Select.
2. Press Character Generator to display the Character Generator Remote Control Menu.
3. Use the BNC knob to select the BNC for your device.
4. Press GO!! to display the Character Generator Menu 1-2.

**Operating Tip**

You can also press the Character Generator crosspoint on the MLE to display the Character Generator Menu 1-2.

5. Press MORE to display the Character Generator Control Menu 2-2.

6. Toggle the Channel A/B button between Channel A and B to select the channel output on the Inscriber CG.
   - **Channel A** — This option sets the output on the Inscriber CG to Channel A.
   - **Channel B** — This option sets the output on the Inscriber CG to Channel B.

This concludes the procedure to select the channel to setup.

Chyron Duet LEX

This section outlines the operation of the Chyron Duet LEX character generator. The following topics are discussed:

- Selecting a Folder
- Recalling a Template to Preview
- Recalling a Template to Program
- Changing Preview Text
- Changing PGM Text
- Swapping Preview and Program
- Playing Animation
Selecting a Folder

Use the following procedure to select a folder from the Chyron Duet LEX:

1. Navigate to the Remote Control Select Menu as follows:
   - Press HOME ⇒ Effects ⇒ MORE ⇒ Remote Control Select.
2. Press Character Generator to display the Character Generator Remote Control Menu.
3. Use the BNC knob to select the BNC for your device.
4. Press GO!! to display the Character Generator Menu 1-2.
5. Press MORE to display the Character Generator Control Menu 2-2.
   - Press Select Directory.
   - Use the keyboard to enter the address of the required folder.

Operating Tip

You can also press the Character Generator crosspoint on the MLE to display the Character Generator Menu 1-2.

6. Select a folder as follows:
   - Press Select Directory.
   - Use the keyboard to enter the address of the required folder.

Important

A standard PS/2 keyboard is required to input data. Contact Ross Video Technical Support for relevant information.

Important

Do NOT place anything on your keyboard or place your keyboard in a position where any of the keys could be accidently pressed. This could result in the Switcher acting unpredictably.

This concludes the procedure to recall a folder from the Chyron Duet LEX character generator.

Recalling a Template to Preview

To recall a template to the Preview (PV) output of the Chyron Duet LEX, you must first select the folder and then enter the template name.

Note

This procedure recalls the selected template to the Preview of the Chyron Duet LEX only and NOT to the Preview Monitor of the Synergy Switcher.
Use the following procedure to recall a template to the Character Generator Preview:

1. Navigate to the Remote Control Select Menu as follows:
   - Press HOME ⇒ Effects ⇒ MORE ⇒ Remote Control Select.
2. Press Character Generator to display the Character Generator Remote Control Menu.
3. Use the BNC knob to select the BNC for your device.
4. Press GO!! to display the Character Generator Menu 1-2.

   ![Operating Tip]
   You can also press the Character Generator crosspoint on the MLE to display the Character Generator Menu 1-2.

5. Select a folder as follows:
   - Press MORE to display the Character Generator Control Menu 2-2.
   - Press Select Directory.
   - Use the keyboard to enter the address of the required folder.

   ![Important]
   A standard PS/2 keyboard is required to input data. Contact Ross Video Technical Support for relevant information.

   ![Important]
   Do NOT place anything on your keyboard or place your keyboard in a position where any of the keys could be accidently pressed. This could result in the Switcher acting unpredictably.

6. Select a template as follows:
   - Press MORE to return to the Character Generator Menu 1-2.
   - Press Recall CG to PV.
   - Select a template using the Synergy Global Memory System to recall it to the Preview of the Chyron Duet LEX.

   ![Important]
   Files stored with non numerical names cannot be recalled using this method. Refer to Chapter 20, “Character Generators” in the Synergy Q/MD or Q/MD-X Engineering Manual, Volume 2 for configuration instructions.
This concludes the procedure to recall a template to the Preview of the Chyron Duet LEX.

**Recalling a Template to Program**

To recall a template to the PGM of the Chyron Duet LEX, you must first select the folder and then enter the template name using the Synergy Character Generator Menu.

1. Navigate to the Remote Control Select Menu as follows:
   - Press HOME ⇒ Effects ⇒ MORE ⇒ Remote Control Select.
2. Press Character Generator to display the Character Generator Remote Control Menu.
3. Use the BNC knob to select the BNC for your device.
4. Press GO!! to display the Character Generator Menu 1-2.

**Important**

This procedure will recall the selected template to the Program of the Synergy Switcher if the BNC assigned to the Chyron Duet LEX is currently on air.

Use the following procedure to recall a template to the PGM of the Chyron Duet LEX:

1. Navigate to the Remote Control Select Menu as follows:
   - Press HOME ⇒ Effects ⇒ MORE ⇒ Remote Control Select.
2. Press Character Generator to display the Character Generator Remote Control Menu.
3. Use the BNC knob to select the BNC for your device.
4. Press GO!! to display the Character Generator Menu 1-2.

**Operating Tip**

You can also press the Character Generator crosspoint on the MLE to display the Character Generator Menu 1-2.

5. Select a folder as follows:
   - Press MORE to display the Character Generator Control Menu 2-2.
   - Press Select Directory.

---

Character Generator — Recall CG to PV Menu

The template information is displayed in the PV column of the Character Generator Menu 1-2.

**Character Generator Menu 1-2**

<table>
<thead>
<tr>
<th>Char Gen: BNC CBI Channel: 1 Dust (BL)</th>
<th>PGM: NONE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Folder: I:Messages</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Recall CG to PV</th>
<th>Recall CG to PGM</th>
<th>Change PU</th>
<th>Change PGM</th>
<th>Play Animation</th>
<th>Swap PV C→PVM</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Character Generator Menu 1-2
• Use the keyboard to enter the address of the required folder.

**Important**
A standard PS/2 keyboard is required to input data. Contact Ross Video Technical Support for relevant information.

**Important**
Do NOT place anything on your keyboard or place your keyboard in a position where any of the keys could be accidently pressed. This could result in the Switcher acting unpredictably.

6. Select a template to recall to the Program of the Chyron Duet LEX as follows:

• Press **MORE** to return to the **Character Generator Menu 1-2**.
• Press **Recall CG to PGM**.
• Select a template using the Synergy **Global Memory System**.

**Important**
Templates stored with non numerical names cannot be recalled using this method. Refer to Chapter 20, “**Character Generators**” in the *Synergy Q/MD or Q/MD-X Engineering Manual, Volume 2* for configuration instructions.

The template information is displayed in the PGM column of the **Character Generator Menu 1-2**.

This concludes the procedure to recall a template to the Program of the Chyron Duet LEX.

**Text**
You can modify text for loaded templates using the Synergy Switcher menu system. The text displayed in either the Preview (PV) column or Program (PGM) column can be modified using a standard PS/2 keyboard connected to the Synergy Switcher.

**Important**
Character Generator parameters that are modified from the Synergy Switcher are only in effect for the current session.

**Changing Preview Text**
Use the following procedure to change the Preview (PV) text for a loaded template on the Chyron Duet LEX:

**Note**
A standard PS/2 keyboard is required to input data.
1. Navigate to the **Remote Control Select Menu** as follows:
   - Press HOME ⇒ Effects ⇒ MORE ⇒ Remote Control Select.
2. Press **Character Generator** to display the Character Generator Remote Control Menu.
3. Use the **BNC** knob to select the BNC for your device.
4. Press **GO!!** to display the Character Generator Menu 1-2.

   ![Operating Tip]
   You can also press the Character Generator crosspoint on the MLE to display the Character Generator Menu 1-2.

5. Select a folder as follows:
   - Press **MORE** to display the Character Generator Control Menu 2-2.
   - Press **Select Directory**.
   - Use the keyboard to enter the address of the required folder.

   ![Important]
   A standard PS/2 keyboard is required to input data. Contact Ross Video Technical Support for relevant information.

   ![Important]
   Do NOT place anything on your keyboard or place your keyboard in a position where any of the keys could be accidently pressed. This could result in the Switcher acting unpredictably.

6. Recall a template to the **PV** column as follows:
   - Press **MORE** to return to the Character Generator Menu 1-2.
   - Press **Recall CG to PV**.
   - Select a template using the Synergy Global Memory System to recall it to the Preview of the Chyron Duet LEX.

   ![Important]
   Templates stored with non numerical names cannot be recalled using this method. Refer to Chapter 20, “Character Generators” in the Synergy Q/MD or Q/MD-X Engineering Manual, Volume 2 for configuration instructions.

   The template information is displayed in the PV column of the Character Generator Menu 1-2.
7. Press **Change PV Text** to display the **Change PV Text Menu**.

8. Change the text for the template on the Preview of the Chyron Duet LEX by pressing the applicable softkeys and editing the text using a standard PS/2 keyboard. The menu softkeys are renamed to coincide with the tag names.

   **Important**
   Do NOT place anything on your keyboard or place your keyboard in a position where any of the keys could be accidently pressed. This could result in the Switcher acting unpredictably.

This concludes the procedure to change the Preview (PV) text for the Chyron Duet LEX.

**Changing PGM Text**

Use the following procedure to change the Program (PGM) text for a loaded template on the Chyron Duet LEX:

1. Navigate to the **Remote Control Select Menu** as follows:
   - Press **HOME** ⇒ **Effects** ⇒ **MORE** ⇒ **Remote Control Select**.
2. Press **Character Generator** to display the **Character Generator Remote Control Menu**.
3. Use the BNC knob to select the BNC for your device.
4. Press **GO!!** to display the **Character Generator Menu 1-2**.

   **Operating Tip**
   You can also press the Character Generator crosspoint on the MLE to display the **Character Generator Menu 1-2**.
5. Select a folder as follows:
   • Press MORE to display the Character Generator Menu 2-2.
   • Press Select Directory.
   • Use the keyboard to enter the address of the required folder.

   Important
   A standard PS/2 keyboard is required to input data. Contact Ross Video Technical Support for relevant information.

   Important
   Do NOT place anything on your keyboard or place your keyboard in a position where any of the keys could be accidently pressed. This could result in the Switcher acting unpredictably.

6. Select a template as follows:
   • Press MORE to return to the Character Generator Menu 1-2.
   • Press Recall CG to PGM.
   • Select a template using the Synergy Global Memory System to recall it to the Program of the Chyron Duet LEX.

   Important
   Templates stored with non numerical names cannot be recalled using this method. Refer to Chapter 20, “Character Generators” in the Synergy Q/MD or Q/MD-X Engineering Manual, Volume 2 for configuration instructions.

The text should now be displayed in the PGM column of the Character Generator Menu 1-2.

7. Press Change PGM Text to display the Change PGM Text Menu.

   Important
   Do NOT place anything on your keyboard or place your keyboard in a position where any of the keys could be accidently pressed. This could result in the Switcher acting unpredictably.

8. Change the text for the event on air by pressing the applicable softkeys and editing the text using a standard PS/2 keyboard. The menu softkeys are renamed to coincide with the tag names.

   This concludes the procedure to change the Program (PGM) text for the Chyron Duet LEX.
**Swapping Preview and Program**

Use the following procedure to exchange what is loaded on the Chyron Duet LEX Preview (PV) with the file loaded on the Program (PGM):

1. Navigate to the Remote Control Select Menu as follows:
   - Press HOME ⇒ Effects ⇒ MORE ⇒ Remote Control Select.
2. Press Character Generator to display the Character Generator Remote Control Menu.
3. Use the BNC knob to select the BNC for your device.
4. Press GO!! to display the Character Generator Menu 1-2.

**Operating Tip**

You can also press the Character Generator crosspoint on the MLE to display the Character Generator Menu 1-2.

5. Recall a template to the PV column as follows:
   - Press MORE to display the Character Generator Control Menu 2-2.
   - Press Select Directory.
   - Use the keyboard to enter the address of the required folder.

**Important**

A standard PS/2 keyboard is required to input data. Contact Ross Video Technical Support for relevant information.

**Important**

Do NOT place anything on your keyboard or place your keyboard in a position where any of the keys could be accidently pressed. This could result in the Switcher acting unpredictably.

6. Recall a template to the PGM column as follows:
   - Press MORE to display the Character Generator Control Menu 2-2.
   - Press Select Folder.
   - Use the standard PS/2 keyboard to enter the address of the required folder.

**Important**

Do NOT place anything on your keyboard or place your keyboard in a position where any of the keys could be accidently pressed. This could result in the Switcher acting unpredictably.
• Press **MORE** to return to the **Character Generator Menu 1-2**.
• Press **Recall CG to PGM**.

7. Toggle the **Swap PV/PGM** button to swap the templates for the PV and PGM.

This concludes the procedure to exchange a loaded template on the Preview (PV) of the Chyron Duet LEX with the loaded template on the Program (PGM).

**Playing Animation**

Use the following procedure to play an animation template:

---

**Important**

No other commands will be processed by the Chyron Duet LEX from the Synergy Switcher until the animation is finished playing.

---

1. Navigate to the **Remote Control Select Menu** as follows:
   - Press **HOME** ⇒ **Effects** ⇒ **MORE** ⇒ **Remote Control Select**.
2. Press **Character Generator** to display the **Character Generator Remote Control Menu**.
3. Use the **BNC** knob to select the BNC for your device.
4. Press **GO!!** to display the **Character Generator Menu 1-2**.

---

**Operating Tip**

You can also press the Character Generator crosspoint on the MLE to display the **Character Generator Menu 1-2**.

---

5. Select a folder from the CG as follows:
   - Press **MORE** to display the **Character Generator Control Menu 2-2**.
   - Press **Select Directory**.
   - Use the keyboard to enter the address of the required folder.

---

**Important**

A standard PS/2 keyboard is required to input data. Contact Ross Video Technical Support for relevant information.

---

**Important**

Do NOT place anything on your keyboard or place your keyboard in a position where any of the keys could be accidently pressed. This could result in the Switcher acting unpredictably.
6. Select an animation template as follows:
   - Press **MORE** to return to the **Character Generator Menu 1-2**.
   - Press **Recall CG to PGM**.
   - Select a template using the Synergy **Global Memory System** to recall it to the Program of the Chyron Duet LEX.

   **Important**
   Files stored with non numerical names cannot be recalled using this method. Refer to Chapter 13, “**Character Generators**” in the **Synergy Series Installation Guide** for configuration instructions.

   The template information is displayed in the PGM column of the **Character Generator Menu 1-2**.

7. Press **Play Animation** to enable the Synergy Switcher to play the selected template.

This concludes the procedure to play an animation file from the Chyron Duet LEX.

**Pinnacle FXDeko II**

This section outlines the operation of the Pinnacle FXDeko II character generator. The following topics are discussed:

- Recalling a Template to Preview
- Recalling a Template to Program
- Swapping Preview and Program

**Recalling a Template to Preview**

To recall a template to the Preview (PV) output of the Pinnacle FXDeko II, you must first select the folder and then enter the template name.

**Note**

This procedure recalls the selected template to the Preview of the Pinnacle FXDeko II only and NOT to the Preview Monitor of the Synergy Switcher.

Use the following procedure to recall a template to the Character Generator Preview:

1. Navigate to the **Remote Control Select Menu** as follows:
   - Press **HOME ⇒ Effects ⇒ MORE ⇒ Remote Control Select**.
2. Press **Character Generator** to display the **Character Generator Remote Control Menu**.
3. Use the **BNC** knob to select the BNC for your device.
4. Press **GO!!** to display the **Character Generator Menu 1-2**.

**Operating Tip**

You can also press the Character Generator crosspoint on the MLE to display the **Character Generator Menu 1-2**.
5. Select a folder as follows:
   - Press **MORE** to display the **Character Generator Control Menu 2-2**.
   - Press **Select Directory**.
   - Use the keyboard to enter the address of the required folder.

   **Important**
   A standard PS/2 keyboard is required to input data. Contact Ross Video Technical Support for relevant information.

   **Important**
   Do NOT place anything on your keyboard or place your keyboard in a position where any of the keys could be accidently pressed. This could result in the Switcher acting unpredictably.

6. Select a template as follows:
   - Press **MORE** to return to the **Character Generator Menu 1-2**.
   - Press **Recall CG to PV**.
   - Select a template using the Synergy **Global Memory System** to recall it to the Preview of the Pinnacle FXDeko II.

   **Important**
   Files stored with non numerical names cannot be recalled using this method. Refer to Chapter 20, “**Character Generators**” in the **Synergy Q/MD or Q/MD-X Engineering Manual, Volume 2** for configuration instructions.

The template information is displayed in the PV column of the **Character Generator Menu 1-2**.

This concludes the procedure to recall a template to the Preview of the Pinnacle FXDeko II.
Recalling a Template to Program

To recall a template to the PGM of the Pinnacle FXDeko II, you must first select the folder and then enter the template name using the Synergy Character Generator Menu.

### Important
This procedure will recall the selected template to the Program of the Synergy Switcher if the BNC assigned to the Pinnacle FXDeko II is currently on air.

Use the following procedure to recall a template to the PGM of the Pinnacle FXDeko II:

1. Navigate to the Remote Control Select Menu as follows:
   - Press HOME ⇒ Effects ⇒ MORE ⇒ Remote Control Select.
2. Press Character Generator to display the Character Generator Remote Control Menu.
3. Use the BNC knob to select the BNC for your device.
4. Press GO!! to display the Character Generator Menu 1-2.

### Operating Tip
You can also press the Character Generator crosspoint on the MLE to display the Character Generator Menu 1-2.

1. Navigate to the Remote Control Select Menu as follows:
   - Press MORE to display the Character Generator Control Menu 2-2.
   - Press Select Directory.
   - Use the keyboard to enter the address of the required folder.

### Important
A standard PS/2 keyboard is required to input data. Contact Ross Video Technical Support for relevant information.

### Important
Do NOT place anything on your keyboard or place your keyboard in a position where any of the keys could be accidently pressed. This could result in the Switcher acting unpredictably.

5. Select a folder as follows:
   - Press MORE to display the Character Generator Control Menu 2-2.
   - Press Select Directory.
   - Use the keyboard to enter the address of the required folder.

6. Select a template to recall to the Program of the Pinnacle FXDeko II as follows:
   - Press MORE to return to the Character Generator Menu 1-2.
   - Press Recall CG to PGM.
   - Select a template using the Synergy Global Memory System.
**Important**

Templates stored with non numerical names cannot be recalled using this method. Refer to Chapter 20, “Character Generators” in the *Synergy Q/MD or Q/MD-X Engineering Manual, Volume 2* for configuration instructions.

The template information is displayed in the PGM column of the Character Generator Menu 1-2.

**Swapping Preview and Program**

Use the following procedure to exchange what is loaded on the Pinnacle FXDeko II Preview (PV) with the file loaded on the Program (PGM):

1. Navigate to the Remote Control Select Menu as follows:
   - Press HOME ➔ Effects ➔ MORE ➔ Remote Control Select.
2. Press Character Generator to display the Character Generator Remote Control Menu.
3. Use the BNC knob to select the BNC for your device.
4. Press GO!! to display the Character Generator Menu 1-2.

**Operating Tip**

You can also press the Character Generator crosspoint on the MLE to display the Character Generator Menu 1-2.

5. Recall a template to the PV column as follows:
   - Press MORE to display the Character Generator Control Menu 2-2.
   - Press Select Folder.
   - Use the keyboard to enter the address of the required folder.

**Important**

Do NOT place anything on your keyboard or place your keyboard in a position where any of the keys could be accidentally pressed. This could result in the Switcher acting unpredictably.

- Press MORE to return to the Character Generator Menu 1-2.
6. Recall a template to the PGM column as follows:
   - Press \textbf{MORE} to display the Character Generator Control Menu 2-2.
   - Press \textbf{Select Folder}.
   - Use the standard PS/2 keyboard to enter the address of the required folder.

   \textbf{Important} Do NOT place anything on your keyboard or place your keyboard in a position where any of the keys could be accidently pressed. This could result in the Switcher acting unpredictably.

   - Press \textbf{MORE} to return to the Character Generator Menu 1-2.
   - Press \textbf{Recall CG to PGM}.

7. Toggle the \textbf{Swap PV/PGM} button to swap the templates for the PV and PGM.

This concludes the procedure to exchange a loaded template on the Preview (PV) of the Pinnacle FXDeko II with the loaded template on the Program (PGM).

\section*{Vizrt Viz|Trio Character Generator}

This section outlines the operation of the Vizrt Viz|Trio character generator. The following topics are discussed:

- Recalling a File to Preview
- Sending a File from Preview to Program

\subsection*{Recalling a File to Preview}

\textbf{Note} This procedure recalls the selected file to the Preview (PV) of the Viz|Trio Client system \textit{only} and NOT to the Preview Monitor of the Synergy switcher.

To recall a file to the Preview (PV) Window of the Viz|Trio Client system, you must first select Preview as the destination and then enter the file number. The folder that the Synergy switcher defaults to is set on the Viz|Trio Client system during setup. Refer to the section \textbf{“Setting Up the Character Generator”} in the \textit{Synergy Q/MD or Q/MD-X Engineering Manual} for details.

Use the following procedure to recall a file to the Preview Window of the Viz|Trio Client system:

1. Navigate to the Remote Control Select Menu as follows:
   - Press HOME $\Rightarrow$ Effects $\Rightarrow$ MORE $\Rightarrow$ Remote Control Select.
2. Press Character Generator to display the Character Generator Remote Control Menu.
3. Use the BNC knob to select the BNC for your device.
4. Press GO!! to display the Character Generator Menu.

\textbf{Operating Tip} You can also press the Character Generator crosspoint on the MLE to display the Character Generator Menu.
5. Press **Recall CG to PV**.

6. Select a template using the keypad in the **Global Memory System Group** to recall it to the Preview of the Vizrt Viz|Trio.

**Important** Files stored with non-numerical names or those that begin with leading zeros (0) cannot be recalled using the keypad.

The file information is now displayed in the **PV** column of the **Character Generator Menu** and the Preview Window of the Viz|Trio Client system.

This concludes the procedure to recall a template to the Preview Window of the Viz|Trio Client system.

**Sending a File from Preview to Program**

Use the following procedure to send a file from the Preview Window of the Viz|Trio Client system to the Program of the Synergy switcher:

1. Recall the file to the Preview Window of the Viz|Trio Client system as outlined in the section “**Recalling a File to Preview**” on page 12–53.

2. Toggle the **Take PV/PGM** button to send the file from the **Preview Window** to the Program output of the Synergy switcher.

This completes the procedure to send a file from the Preview Window of the Viz|Trio Client system to the Program of the Synergy switcher.
Remote Camera Control Interface

The Synergy switchers can interface with specific remote camera control devices. Remote Camera Controllers allow you to control various aspects of the camera, such as pan, tilt and zoom, depending on the camera you are controlling from the switcher. This section provides procedures to control specific robotic cameras from the Synergy switcher.

**Important**

The Synergy switcher cannot control a Robotic Camera that has been disabled in the OverDrive menus. You must toggle the **EDITOR** button **OFF** to enable control of the camera from the Synergy switcher. Refer to the OverDrive documentation for details.

The **Robotic System Interface** option must be installed in order to control a remote camera mount using the Synergy switcher. In the chapter, “**Robotic Cameras**”, of the **Synergy Q/MD or Q/MD-X Engineering Manual** refer to the “**Communications Setup**” section for full configuration instructions. For information on programming custom controls for your remote camera controller, refer to the same chapter.

Telemeterics Remote Camera Controller

Use the following procedure to control a Telemeterics Remote Camera from your Synergy switcher:

1. Navigate to the **Remote Control Select Menu** as follows:
   - Press HOME ⇒ Effects ⇒ MORE ⇒ Remote Control Select.
2. Press **Robotic Camera** to display the **Robotic Camera Menu**.
3. Use the **BNC** knob to select the BNC that the camera you want to control is connected to.
4. Press **GO!!** to display the **Camera Head Control Menu**.

   **Camera Head Control Menu**

<table>
<thead>
<tr>
<th>Camera Head Control (1-2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>BNC: BNC CUI (CUI)</td>
</tr>
<tr>
<td>Camera: Telemetrics (RL) - Camera 1</td>
</tr>
</tbody>
</table>

   | Pan: | (50,80) ⇐⇑ |
   | Tilt: | (50,80) ↓ |
   | Zoom: | (50,80) ⇆ |

5. Press **Pan/Tilt/Zoom** to display the **Pan/Tilt/Zoom Menu**.
6. Adjust the Pan, Tilt and Zoom of the camera as follows:

   **Operating Tip**

   You can use the positioner instead of the knobs to move the camera around quickly.

   - Use the **Pan** knob to have the camera turn right or left:
Pan Right — Turn the Pan knob to the right (clockwise).
Pan Left — Turn the Pan knob to the left (counter-clockwise).

• Use the Tilt knob to have the camera look up or down:
  ~ Tilt Up — Turn the Tilt knob to the right (clockwise).
  ~ Tilt Down — Turn the Tilt knob to the left (counter-clockwise).

• Use the Zoom knob to have the camera zoom in or out:
  ~ Zoom In — Turn the Zoom knob to the right (clockwise).
  ~ Zoom Out — Turn the Zoom knob to the left (counter-clockwise).

7. Press Lens to display the Lens Menu.

8. Adjust the Iris, Focus and Pedestal of the camera as follows:

   On the Telemetrics Camera, the Iris Control must be set to manual in order to be able to control it from the switcher.

   • Use the Iris knob to have the iris on the camera open and close:
     ~ Iris Open — Turn the Iris knob to the right (clockwise).
     ~ Iris Closed — Turn the Iris knob to the left (counter-clockwise).

   • Use the Focus knob to have the camera focus in or out:
     ~ Focus Background — Turn the Focus knob to the right (clockwise).
     ~ Focus Foreground — Turn the Focus knob to the left (counter-clockwise).

   • Use the Pedestal (Black) knob to adjust the Master Pedestal, or Black levels, for picture contrast and quality.

9. Press Location to display the Location Menu.
10. Adjust the Dolly or Televator/Trolly of the camera as follows:

**Operating Tip**

You can use the positioner instead of the knobs to move the camera around quickly.

- Use the **Dolly** knob to have the camera move left and right on the Camera Track.
- Use the **Televator/Trolly** knob to have the camera move up or down:
  - **Camera Up** — Turn the knob to the **right** (clockwise).
  - **Camera Down** — Turn the knob to the **left** (counter-clockwise).

11. Press **Store Shot** to display the **Store Shot Menu**.

**Note**

If the **ShotOffset** feature is set to **0** on the Synergy **Extra Options Menu**, the shot number displayed on the Synergy **Store Shot** and **Recall Shot Menus** will not match the Shot Box number on the Telemeterics camera. Refer to the **Synergy Q/MD or Q/MD-X Engineering Manual** for information on setting this menu option.

12. Store the current shot as follows:

- Use the **Shot** knob to select the location (0-63) you wish to store the current shot.
- Press **Perform Store** to store the shot in the selected location.

13. Press **Recall Shot** to display the **Recall Shot Menu**.

14. Recall a saved shot as follows:

- Use the **Shot** knob to select the location (0-63) you wish to recall a shot from.
- Press **Perform Recall** to recall the shot from the selected location.

This completes the procedure for controlling a Telemeterics Remote Camera from the Synergy switcher.
Sony Robotic Camera Controller

Use the following procedure to control a Sony Robotic Camera from your Synergy switcher:

1. Navigate to the Remote Control Select Menu as follows:
   - Press HOME ⇒ Effects ⇒ MORE ⇒ Remote Control Select.
   - Press Robotic Camera to display the Robotic Camera Menu.
   - Use the BNC knob to select the BNC that the camera you want to control is connected to.
   - Press GO!! to display the Camera Head Control Menu 1-2.

2. Press Robotic Camera to display the Robotic Camera Menu.
3. Use the BNC knob to select the BNC that the camera you want to control is connected to.
4. Press GO!! to display the Camera Head Control Menu 1-2.
5. Press Pan/Tilt/Zoom to display the Pan/Tilt/Zoom Menu.
6. Adjust the Pan, Tilt and Zoom of the camera as follows:
   - Use the Pan knob to have the camera turn right or left:
     - Pan Right — Turn the Pan knob to the right (clockwise).
     - Pan Left — Turn the Pan knob to the left (counter-clockwise).
   - Use the Tilt knob to have the camera tilt up or down:
     - Tilt Up — Turn the Tilt knob to the right (clockwise).
     - Tilt Down — Turn the Tilt knob to the left (counter-clockwise).

Operating Tip
You can use the positioner instead of the knobs to move the camera around quickly.

Operating Tip
You can press the crosspoint button that is assigned to the Robotic Camera you want to control to display the Camera Head Control Menu directly.

Operating Tip
You can use the positioner instead of the knobs to move the camera around quickly.
• Use the **Zoom** knob to have the camera zoom in or out:
  ~ **Zoom In** — Turn the **Zoom** knob to the **right** (clockwise).
  ~ **Zoom Out** — Turn the **Zoom** knob to the **left** (counter-clockwise).

7. Toggle the **D-Zoom** between **On** and **Off** as follows:
   • **On** — Select this option to set the Zoom feature to **Digital** with a zoom limit of 48x.
   • **Off** — Select this option turn the Digital Zoom feature off. The Zoom feature is now set to **Optical** with a zoom limit of 18x.

   **Operating Tip**
   Refer to the Sony documentation for more information on using the Digital Zoom feature of your robotic camera.

8. Press **Lens** to display the **Lens Menu**.

   ![](camera-head-control.png)

   **Camera Head Control - Lens Menu**

   **Operating Tip**
   Refer to your robotic camera documentation for details on selecting the required shutter speed for your particular camera.

9. Toggle the **Mode** button between **Manual** and **Auto** as follows:
   • **Manual** — Select this option to allow you to set the Lens values from the Synergy switcher. This option must be enabled to use the Synergy **Lens Menu**.
   • **Auto** — Select this option to have the robotic camera control the Lens values.

10. Adjust the Iris, Focus and Shutter speed of the camera as follows:
    • Use the **Iris** knob to have the iris on the camera open and close:
      ~ **Iris Open** — Turn the **Iris** knob to the **right** (clockwise).
      ~ **Iris Closed** — Turn the **Iris** knob to the **left** (counter-clockwise).
    • Use the **Focus** knob to have the camera focus in or out:
      ~ **Focus Background** — Turn the **Focus** knob to the **right** (clockwise).
      ~ **Focus Foreground** — Turn the **Focus** knob to the **left** (counter-clockwise).
    • Use the **Shutter Speed** knob to adjust the shutter speed of the camera.

   **Operating Tip**
   Refer to your robotic camera documentation for details on selecting the required shutter speed for your particular camera.

11. Press **Picture** to display the **Picture Menu**.
12. Adjust the White Balance, Picture Effect or Image Ratio of the camera as follows:

- Use the **White Balance Mode** knob to match the mode the white balance color temperature with the light source. This creates an accurate reproduction of natural colors. You can choose from the following:
  - **Auto** — Select this option to permit the camera to automatically find the best possible white balance.
  - **32K** — Select this option to set the color temperature to 3200 Kelvin which is suitable for indoor lighting.
  - **64K** — Select this option to set color temperature to 6400 Kelvin which is suitable for outdoor lighting.

- Use the **Effect** knob to apply a special effect to the image. You can choose from the following:
  - **None** — Select this option to ensure that no effects are applied.
  - **Negative** — Select this option to display a brightness and color-converted form of the image.
  - **Black and White (B&W)** — Select this option to display a gray-scale image.

- Use the **Image Ratio** knob to set the image ratio of the camera output.

13. Press **Store Shot** to display the **Store Shot Menu**.

14. Store the current shot as follows:

- Use the **Shot** knob to select the location (1-6) you wish to store the current shot in.

  **Note**
  
  The Sony robotic camera can store and recall up to 6 shots.

- Press **Perform Store** to store the shot in the selected location.

15. Press **Recall Shot** to display the **Recall Shot Menu**.
16. Recall a saved shot as follows:
   - Use the **Shot** knob to select the shot (1-6) you wish to recall.
   - Press **Perform Recall** to recall the shot from the selected location.

17. Press **MORE** to display the **Camera Head Control Menu 2-2**.

18. Toggle the **IR Receive** button between **On** and **Off** as follows:

   **Important**
   
   The Synergy switcher can control up to 8 robotic cameras whereas the Sony Infrared Remote Controller has a limit of 3. Ensure that when the Infrared Remote Controller is enabled, that you are controlling the desired camera(s).

   Refer to the Sony documentation for information on using the Infrared Remote Controller with multiple robotic cameras.

   - **On** — Select this option to allow both the Synergy switcher and the Sony Infrared Remote Controller to control up to 3 Sony robotic cameras. Any values changed by the Infrared Remote Controller are updated on the Synergy switcher.
   
   - **Off** — Select this option to turn the Infrared Remote Controller off. The Infrared Remote Controller is set to **Off** by default.

This completes the procedure for controlling a Sony robotic camera from the Synergy switcher.
Eagle Pan Tilt System

**Note**
The knob values in the *Remote Control Select Menu* for the Eagle Pan Tilt System display velocity and not position. This means that as you adjust the camera, the change in values will be displayed in the *Remote Control Select Menu*. However, the values will return to 0 once you stop adjusting your camera.

Use the following procedure to control an Eagle PT-101 Pan Tilt System from your Synergy switcher:

1. Navigate to the *Remote Control Select Menu* as follows:
   - Press **HOME ⇒ Effects ⇒ MORE ⇒ Remote Control Select**.

2. Press **Robotic Camera** to display the *Robotic Camera Menu*.

3. Use the **BNC** knob to select the BNC that the camera you want to control is connected to.

4. Press **GO!!** to display the *Camera Head Control Menu 1-2*.

5. If you are using a Fujinon/Canon lens with your Eagle Pan Tilt System, you can toggle the **Lens Mode** as follows:
   - Press **MORE** to display the *Camera Head Control Menu 2-2*.
   - Toggle the lens mode to set the type of lens control. Press the **Speed/Position** button to toggle between settings. You can choose from the following:
     - **Speed** — Use this option to enable the Speed Mode for adjusting the lens. A message is displayed in the main area of the *Camera Head Control Menu* to toggle the Lens Mode to **Position** before attempting to save a prepared shot. This is the default setting.
     - **Position** — Use this option to enable the Position Mode for adjusting the lens. You must select this option before setting up and saving a shot.
   - Press **MORE** to display the *Camera Head Control Menu 1-2*.

**Operating Tip**
You can also press the crosspoint button that is assigned to the Eagle Pan Tilt System you want to control to display the *Camera Head Control Menu* directly.

**Important**
When you toggle the Lens Mode from **Speed** to **Position**, the Eagle Pan Tilt System returns to its default position. Refer to your Eagle documentation for details on this function.
6. Press **Pan/Tilt/Zoom** to display the **Pan/Tilt/Zoom Menu**.

<table>
<thead>
<tr>
<th>Camera Head Control (C-2)</th>
<th>Pan:</th>
<th>(θ,β) ↦</th>
</tr>
</thead>
<tbody>
<tr>
<td>BNC: BNC CUI (CBI)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Camera: Eagle (RI) - Camera #</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tilt:</td>
<td>(θ,β)</td>
<td></td>
</tr>
<tr>
<td>(θ,β) ↦</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zoom:</td>
<td>(θ,β)</td>
<td>↩</td>
</tr>
</tbody>
</table>

**Camera Head Control - Pan/Tilt/Zoom Menu**

7. Adjust the Pan, Tilt and Zoom of the camera as follows:

   • Use the **Pan** knob to have the camera turn right or left:
     - **Pan Right** — Turn the **Pan** knob to the **right** (clockwise).
     - **Pan Left** — Turn the **Pan** knob to the **left** (counter-clockwise).

   • Use the **Tilt** knob to have the camera tilt up or down:
     - **Tilt Up** — Turn the **Tilt** knob to the **right** (clockwise).
     - **Tilt Down** — Turn the **Tilt** knob to the **left** (counter-clockwise).

   • Use the **Zoom** knob to have the camera zoom in or out:
     - **Zoom In** — Turn the **Zoom** knob to the **right** (clockwise).
     - **Zoom Out** — Turn the **Zoom** knob to the **left** (counter-clockwise).

   ![Operating Tip]
   You can also use the positioner, instead of the knobs, to adjust the pan, tilt and zoom values.

8. Press **Lens** to display the **Lens Menu**.

<table>
<thead>
<tr>
<th>Camera Head Control (C-2)</th>
<th>Iris:</th>
<th>(θ,β) ↦</th>
</tr>
</thead>
<tbody>
<tr>
<td>BNC: BNC CUI (CBI)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Camera: Eagle (RI) - Camera #</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Focus:</td>
<td>(θ,β)</td>
<td></td>
</tr>
<tr>
<td>(θ,β) ↦</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pedestal (Black):</td>
<td>(θ,β)</td>
<td>↩</td>
</tr>
</tbody>
</table>

**Camera Head Control - Lens Menu**

9. Adjust the Iris, Focus and Pedestal of the camera as follows:

   • Toggle the **Iris Mode** to **Manual**.

   • Use the **Iris** knob to have the iris on the camera open and close:
     - **Iris Open** — Turn the **Iris** knob to the **right** (clockwise).
     - **Iris Closed** — Turn the **Iris** knob to the **left** (counter-clockwise).

   • Use the **Focus** knob to have the camera focus in or out:
     - **Focus Background** — Turn the **Focus** knob to the **right** (clockwise).
     - **Focus Foreground** — Turn the **Focus** knob to the **left** (counter-clockwise).
• Use the **Pedestal (Black)** knob to adjust the Master Pedestal, or Black levels, for picture contrast and quality.

10. Press and **hold Run Wiper** to activate the Lens Wiper on the camera connected to the Eagle Pan Tilt System.

11. Store the current shot as follows:

   **Important**
   If you are using a Fujinon/Canon lens, you must have the Lens Mode set to **Position**, before setting up and saving a shot. A message is displayed in the main area of the **Camera Head Control Menu** to toggle the Lens Mode from **Speed** to **Position** before attempting to save a prepared shot.

   Remember that when you toggle the Lens Mode between **Position** and **Speed**, the Eagle Pan Tilt System returns to its default position. Refer to your Eagle documentation for details on this function.

• Press **Store Shot** to display the **Store Shot Menu**.

   ![Camera Head Control - Store Shot Menu](image)

   • Use the **Shot** knob to select the location (1-31) you wish to store the current shot to.
   • Press **Perform Store** to store the shot in the selected location.

12. Recall a shot as follows:

• Press **Recall Shot** to display the **Recall Shot Menu**.

   ![Camera Head Control - Recall Shot Menu](image)

   • Use the **Shot** knob to select the shot location (1-31) you wish to recall.
   • Press **Perform Recall** to recall the selected shot.

This completes the procedure to control a Eagle Pan Tilt System from your Synergy switcher.
Panasonic Pan/Tilt Head

Use the following procedure to control a Panasonic Pan/Tilt Head from your Synergy switcher:

1. Navigate to the **Remote Control Select Menu** as follows:
   - Press HOME ⇒ Effects ⇒ MORE ⇒ Remote Control Select.

   ![Remote Control Select — Robotic Camera Menu](image)

   You can also press the crosspoint button that is assigned to the Eagle Pan Tilt System you want to control to display the Camera Head Control Menu directly.

2. Press **Robotic Camera** to display the **Robotic Camera Menu**.

3. Use the **BNC** knob to select the BNC that the camera you want to control is connected to.

4. Press **GO!!** to display the **Camera Head Control Menu 1-2**.

5. Press **Pan/Tilt/Zoom** to display the **Pan/Tilt/Zoom Menu**.

6. Adjust the Pan, Tilt and Zoom of the camera as follows:
   - Use the **Pan** knob to have the camera turn right or left:
     - **Pan Right** — Turn the **Pan** knob to the **right** (clockwise).
     - **Pan Left** — Turn the **Pan** knob to the **left** (counter-clockwise).
   - Use the **Tilt** knob to have the camera tilt up or down:
     - **Tilt Up** — Turn the **Tilt** knob to the **right** (clockwise).
     - **Tilt Down** — Turn the **Tilt** knob to the **left** (counter-clockwise).
   - Use the **Zoom** knob to have the camera zoom in or out:
     - **Zoom In** — Turn the **Zoom** knob to the **right** (clockwise).
     - **Zoom Out** — Turn the **Zoom** knob to the **left** (counter-clockwise).
7. Press **Lens** to display the **Lens Menu**.

8. Adjust the Iris or Focus of the camera as follows:
   - Toggle the **Iris Mode** to **Manual**.
   - Use the **Iris** knob to have the iris on the camera open and close:
     - **Iris Open** — Turn the **Iris** knob to the **right** (clockwise).
     - **Iris Closed** — Turn the **Iris** knob to the **left** (counter-clockwise).
   - Use the **Focus** knob to have the camera focus in or out:
     - **Focus Background** — Turn the **Focus** knob to the **right** (clockwise).
     - **Focus Foreground** — Turn the **Focus** knob to the **left** (counter-clockwise).

9. Press **Run Wiper** to activate the Lens Wiper on the camera connected to the Panasonic Pan/Tilt Head.

10. Store the current shot as follows:
   - Press **Store Shot** to display the **Store Shot Menu**.
   - Use the **Shot** knob to select the location (0-49) you wish to store the current shot to.
   - Press **Perform Store** to store the shot in the selected location.

11. Recall a shot as follows:
   - Press **Recall Shot** to display the **Recall Shot Menu**.

---

**Operating Tip**

You can also use the positioner, instead of the knobs, to adjust the pan, tilt and zoom values.
Camera Head Control — Recall Shot Menu

- Use the **Shot** knob to select the shot location (0-49) you wish to recall.
- Press **Perform Recall** to recall the selected shot.

This completes the procedure to control a Panasonic Pan/Tilt Head from your Synergy switcher.

**Vinten AutoCam 200 Controller**

Use the following procedure to control a Vinten AutoCam 200 Controller from your Synergy switcher:

1. Navigate to the **Remote Control Select Menu** as follows:
   - Press **HOME ⇒ Effects ⇒ MORE ⇒ Remote Control Select**.

   **Operating Tip**
   You can also press the crosspoint button that is assigned to the **Vinten AutoCam 200 Controller** you want to control to display the **Camera Head Control Menu** directly.

2. Press **Robotic Camera** to display the **Robotic Camera Menu**.

3. Use the **BNC** knob to select the BNC that the camera you want to control is connected to.

4. Press **GO!!** to display the **Camera Head Control Menu 1-2**.

5. Select a show as follows:
   - Press **Select Show** to display the **Select Show Menu**.
Camera Head Control — Select Show Menu

- Press Refresh Show to update the list of shows available on your device.
- Use the Show knob to select the show you want to recall the shot from.
- Press Load Show to load the show. The Loaded show: field now displays the name of the selected show.

6. Select a shot to recall as follows:

- Press Recall Shot to display the Recall Shot Menu.

Camera Head Control — Recall Shot Menu

- Press Refresh Shots to update the list of available shots for the selected show.
- Use the Shot knob to select the shot position you want to recall.
- Use the Duration knob to set the amount of time to move the camera into the selected shot position.

7. Press Perform Recall to recall the selected shot.

This completes the procedure for controlling a Vinten AutoCam 200 Controller from your Synergy switcher.

Grass Valley CameraMan 3e 3-CCD Robotic Camera

**Note**

On startup, the Grass Valley CameraMan is in Calibration Mode and may be unresponsive to the Synergy switcher for the first 15 seconds.

Use the following procedure to control a Grass Valley CameraMan 3e 3-CCD camera from your Synergy switcher:

1. Navigate to the Remote Control Select Menu as follows:
• Press HOME ➔ Effects ➔ MORE ➔ Remote Control Select.

You can also press the crosspoint button that is assigned to the Grass Valley CameraMan 3e 3-CCD camera you want to control to display the Camera Head Control Menu directly.

2. Press Robotic Camera to display the Robotic Camera Menu.

Remote Control Select

Select a BNC to control via the Remote Menu, then press GO.

BNC:

BNC CBI (2)
BNC CBJ (3)

UTP Router Robotic Camera ChartCam GO!!

Remote Control Select — Robotic Camera Menu

3. Use the BNC knob to select the BNC that the camera you want to control is connected to.

4. Press GO!! to display the Camera Head Control Menu 1-2.

5. Adjust the Pan, Tilt, and Zoom of the camera as follows:

You can use the Positioner to move the camera around.

• Press Pan/Tilt/Zoom to display the Pan/Tilt/Zoom Menu.

Camera Head Control

BNC: BNC CBI (CH1)
Camera: CameraMan (RI) — Port 1

Pan: (50,80) ➔
Tilt: (50,80) ➔
Zoom: (0,80) ➔

Pan/Tilt/Zoom

Store Recall

Pan Tilt Zoom

Camera Head Control — Pan/Tilt/Zoom Menu

• Use the Pan knob to have the camera turn right or left:
  ~ Pan Right — Turn the Pan knob to the right (clockwise).
  ~ Pan Left — Turn the Pan knob to the left (counter-clockwise).

• Use the Tilt knob to have the camera look up or down:
  ~ Tilt Up — Turn the Tilt knob to the right (clockwise).
  ~ Tilt Down — Turn the Tilt knob to the left (counter-clockwise).

• Use the Zoom knob to have the camera zoom in or out:
  ~ Zoom In — Turn the Zoom knob to the right (clockwise).
  ~ Zoom Out — Turn the Zoom knob to the left (counter-clockwise).
6. Adjust the Iris, Focus and Pedestal of the camera as follows:

- Press **Lens** to display the **Lens Menu**.

<table>
<thead>
<tr>
<th>Camera Head Control</th>
</tr>
</thead>
<tbody>
<tr>
<td>BNC: BNC CBI (CBI)</td>
</tr>
<tr>
<td>Camera: CameraMan (RI) – Part 1</td>
</tr>
</tbody>
</table>

- **Iris** knob to have the iris on the camera open and close:
  - **Iris Open** — Turn the Iris knob to the **right** (clockwise).
  - **Iris Closed** — Turn the Iris knob to the **left** (counter-clockwise).

- **Focus** knob to have the camera focus in or out:
  - **Focus Background** — Turn the Focus knob to the **right** (clockwise).
  - **Focus Foreground** — Turn the Focus knob to the **left** (counter-clockwise).

7. Store the current shot as follows:

- Press **Store Shot** to display the **Store Shot Menu**.

<table>
<thead>
<tr>
<th>Camera Head Control</th>
</tr>
</thead>
<tbody>
<tr>
<td>BNC: BNC CBI (CBI)</td>
</tr>
<tr>
<td>Camera: CameraMan (RI) – Part 1</td>
</tr>
</tbody>
</table>

- **Iris Mode** to **Manual**.

<table>
<thead>
<tr>
<th>Camera Head Control — Lens Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Iris: (60.0%) ↔</td>
</tr>
<tr>
<td>Focus: (9.8%) $</td>
</tr>
</tbody>
</table>

- Use the **Iris** knob to have the iris on the camera open and close:

  - **Iris Open** — Turn the Iris knob to the **right** (clockwise).
  - **Iris Closed** — Turn the Iris knob to the **left** (counter-clockwise).

- Use the **Focus** knob to have the camera focus in or out:

  - **Focus Background** — Turn the Focus knob to the **right** (clockwise).
  - **Focus Foreground** — Turn the Focus knob to the **left** (counter-clockwise).

8. Recall a saved shot as follows:

- Press **Recall Shot** to display the **Recall Shot Menu**.

<table>
<thead>
<tr>
<th>Camera Head Control — Store Shot Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shot: (1)</td>
</tr>
</tbody>
</table>

- **Perform Store** to store the shot in the selected location.

**Operating Tip**

When **Iris Mode** is toggled from **Auto** to **Manual**, the Iris value is automatically set to **60.0%**.
Camera Head Control

BNC: BNC CH1 (CH1)
Camera: CameraMan (RI) — Port 1

<table>
<thead>
<tr>
<th>Pan/Tilt</th>
<th>Lens</th>
<th>Store</th>
<th>Recall</th>
<th>Perform</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shot:</td>
<td></td>
<td>Shot</td>
<td>Shot</td>
<td>Recall</td>
</tr>
<tr>
<td>(1)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Camera Head Control — Recall Shot Menu

- Use the **Shot** knob to select the location (1-125) you wish to recall a shot from.
- Press **Perform Recall** to recall the shot from the selected location.

This completes the procedure for controlling a Grass Valley CameraMan 3e 3-CCD camera from the Synergy switcher.
Copy and Swap Functions

The Copy and Swap functions allow you to copy or swap various MLE or Key settings from MLE to MLE or Key to Key. For all copy functions, the destination-source rule applies. You select the destination for the copy and press and hold the appropriate button. With the destination selected, press the source button to copy the information.

The following copy and swap functions are available on most Synergy Q/MD/X switchers:

- “Copy MLE” on page 12–72 — This function allows you to copy the contents of an MLE to another MLE location on the switcher.
- “Copy Key” on page 12–74 — This function allows you to copy the contents of a Keyer to another Key location (in the same MLE, or on a different MLE).
- “Key Swap” on page 12–75 — This function allows you to swap the entire contents of a Keyer with another Key location (in the same MLE, or in a different MLE).
- “Copy Matte” on page 12–76 — This function allows you to copy the contents of a matte generator to any other matte location.
- “Copy Wipe” on page 12–77 — This function allows you to copy a wipe pattern (and all wipe pattern modifiers) from one MLE to another.

Note: The Synergy 1 Q/MD control panel has only one MLE, so the MLE Copy function is not available.

Note: The Synergy 1 Q/MD control panel has only one MLE, so the Copy Wipe function is not available.

Copy MLE

The Copy MLE function allows you to copy the entire contents of an MLE to another MLE location on the switcher. You can copy between physical MLEs as well as from a physical MLE to an Aux Mixer or Aux Mixer/Keyer. MLE settings including crosspoint selection, matte generator values, fader positions, on-air status and Key active status are copied.

Note: The Synergy 1 Q/MD control panel has only one MLE, so the MLE Copy function is not available.

Use the following procedure to copy the contents of one MLE to another MLE:

Caution: If you Copy an MLE to the PGM/PST MLE, the currently selected DSK Source will be overwritten with the current Key Source.

1. If you are copying to an Aux Mixer or Aux Mixer/Keyer, press and hold the Aux Bus Assign button. MLE 1 will go into AuxKey Mode and the active buttons in MLE 1 will flash.

Tip: You can double press the Assign button to latch MLE 1 in AuxKey Mode.
2. Press and **hold** the BKGD button in the **MLE Transition Group** on the **destination** MLE.

3. Press the BKGD button in the **MLE Transition Group** on the **source** MLE.

4. Release both buttons.

The contents of the source MLE have now been copied to the destination MLE.

The following rules apply to the “Copy MLE” function:

- If a re-entry selection is invalid on the destination MLE, **BLACK** is automatically selected when the copy is performed. If a transition type is invalid on the destination MLE, **DISS** is automatically selected.

- If a specific option is not installed on the destination MLE, the system automatically turns the function off.

- When copying from the Program/Preset bus to an MLE, the current **DSK 1** and **DSK 2** selections (that is, the active DSK crosspoints) are turned into **Key 1** and **Key 2** selections, respectively.

- If a specific Keyer was active in the source MLE, it becomes active in the destination MLE.

- When copying from an MLE to the Program/Preset MLE, **Key 1** and **Key 2** selections are turned into **DSK 1** and **DSK 2** selections, respectively.

- Copying to the Program/Preset MLE is disabled when the **EDITOR** button is enabled (when your switcher is being controlled by the OverDrive Production Control System). Copying to the Program/Preset MLE is not supported when your switcher is being controlled by OverDrive. Copying is allowed if you are using a different editor.

- Using **Copy MLE**, a function can be copied to an MLE that does *not* directly support the function with a button. For example, if you copy an MLE that has the **KEY OVER** function button active to a DSK, the DSKs do *not* have a **KEY OVER** button, the function will be copied and implemented.

In these situations, the Synergy Q/MD/X switcher will perform the copy, and set up the desired effect, even though it is not physically supported by a button.

**Note**

If you copy a function that is not supported by a button on an MLE you may not be able to easily turn that function off. If you need to clear an MLE that this has occurred on, you can either reset the MLE, copy another valid MLE to the desired MLE, or recall a memory register on the desired MLE.

The following rules apply when copying to an Aux Mixer or Aux Mixer/Keyer:

- When operating in Aux Mixer or Aux Mixer/Keyer mode, **MLE 1** controls the Aux Mixer or Aux Mixer/Keyer. Therefore, you cannot copy from **MLE 1** to the Aux Mixer or Aux Mixer/Keyer.

- Key properties are only copied if you are copying to an Aux Mixer/Keyer.

- Only the contents of the first keyer are copied to the Aux Mixer/Keyer.
• Aux Mixer/Keyers only support Auto-Select keys so all keys will be converted to Auto-Select keys when copied. Keys not specifically defined as Auto-Select will have a black alpha signal (no video is removed) assigned.

For more information on Aux Mixers and Aux Mixer/keyers, refer to the section, “AuxKey Option”, in the chapter, “Keying”, of the Synergy Q/MD or Q/MD-X Engineering Manual.

Copy Key

The Copy Key function allows you to copy the entire contents of a Keyer to another Keyer in the same MLE, or in a different MLE. You can also copy the contents of a Keyer to a DSK or visa versa.

**Copy MLE Keyer to MLE Keyer**

Use the following procedure to copy the contents of one Keyer to another Keyer:

1. Press and hold any the desired Key Type button in the destination MLE Keyer Group.

   ![Key Type Buttons](Image)

   **Key Type Buttons**

2. Press the active Key Type button in the source MLE Keyer Group. This can be the same MLE or a different MLE.

   ![Key Type Buttons](Image)

   **Key Type Buttons**

3. Release both buttons.

   ![Note](Image)

   **Note** When you copy an MLE Keyer to another MLE Keyer, the entire contents of the source Keyer are copied to the destination, including the selected key crosspoint. For example, if you have an AUTO SELECT Key enabled, the CHROMA KEY settings are also copied.

   This completes the procedure for performing a Copy from a Keyer to a Keyer.
**Copy DSK to DSK**

**Note** If you have locked either of your DSKs, you will not be able to copy the Key information to the locked DSK.

Use the following procedure to copy the contents of one DSK to another DSK:

1. Press and *hold* the desired DSK Source button in the destination DSK.

**Important** Holding down a DSK Source button and pressing a Key Type button in an MLE changes the programmed DSK Source Key type.

2. Press the desired DSK Source button in the source DSK.

3. Release both buttons.

This completes the procedure for performing a Copy from a DSK to a DSK.

**Copy MLE Keyer to DSK**

Use the following procedure to copy the contents of an MLE Keyer to a DSK:

**Important** Holding down a DSK Source button and pressing a Key Type button in an MLE changes the programmed DSK Source Key type. You must press either the Key1 or Key2 button in the MLE Transition Group in order to copy the Key.

1. Press and *hold* the desired DSK Source button in the destination DSK.

2. Press the desired Key button in the source MLE Transition Group.

**Note** If you have locked either of your DSKs, you will not be able to copy the Key information to the locked DSK.

3. Release both buttons.

This completes the procedure for performing a Copy from a Keyer to a DSK.

**Copy DSK to MLE Keyer**

Use the following procedure to copy the contents of a DSK to an MLE Keyer:

1. Press and *hold* any the desired Key Type button in the destination MLE Keyer Group.

2. Press the desired DSK Source button in the source DSK.

3. Release both buttons.

This completes the procedure for performing a Copy from a DSK to a Keyer.

**Key Swap**

The Key Swap function allows you to swap the entire contents of a Keyer with another Key location, in the same MLE, or in a different MLE.
MLE Keyer Swap

Use the following procedure to swap a Keyer:

1. Press and hold any Key Type button in the Key Group of the first Keyer.

2. Press either KEY 1 or KEY 2 in the Transition Group of the second Keyer. This can be the same MLE or a different MLE. The button that you select is the Keyer that is swapped.

3. Release both buttons. Both selected Keyers swap their contents.

This completes the procedure for performing a Swap of the Keyers.

DSK Swap

Use the following procedure to swap a DSK with another DSK, or with an MLE Keyer:

1. Press and hold the DSK Crosspoint that you want to swap.

2. Press either DSK 1, DSK 2, KEY 1 or KEY 2 in the Transition Group of the second DSK or MLE Keyer. This can be the opposite DSK or a different MLE. The button that you select is the Keyer that is swapped.

3. Release both buttons. Both selected Keyers swap their contents.

This completes the procedure for performing a Swap of the DSKs.

Copy Matte

The Copy Matte function allows you to copy the contents of a matte generator to another matte location on the switcher. Any button that is associated with a matte color can be used in the procedure. Refer to the following for a list of valid destinations and sources.

- Destinations
  - BKGD1 (Mattes Group)
  - BKGD2 (Mattes Group)
  - BORD1 (Mattes Group)
  - BORD2 (Mattes Group)
  - PATT (Mattes Group)
• Sources
  ~ WIPE (MLE Transition Group)
  ~ MATTE FILL (MLE Key Group)
  ~ BORD (MLE Key Group)
  ~ BORD (DSK Group)
  ~ MATTE FILL (DSK Group)
  ~ COLOR BKGD1 (MLE Bus)
  ~ COLOR BKGD2 (MLE Bus)

Use the following procedure to copy a matte color:

1. Press and hold any button associated with a matte color in the destination Matte Group.
2. Press any button associated with a matte in the source MLE or switcher function group. The selected matte color is copied to the destination.
3. Release both buttons.

This completes the procedure for performing a Copy Matte Color.

Note: Pressing WIPE (for this procedure) copies the color associated with the wipe edge.

Copy Wipe

The Copy Wipe function allows you to copy a wipe pattern (and all associated modifiers) from one MLE to another.

Use the following procedure to copy a wipe:

1. Press and hold the WIPE button in the destination MLE.
2. Press the WIPE button in the source MLE. All wipe parameters are copied to the destination.
3. Release both buttons.

This completes the procedure for performing a Copy Wipe.
Still-Store

In This Chapter

This chapter provides instructions for transferring images to and from the hard drive of your switcher using drag and drop, and how to use these images in the internal Still-Stores.

The following topics are included:

• Preparing for Image Transfers
• Creating a Connection to Your Switcher
• Transferring Still Images and Animations
• Still-Store
Preparing for Image Transfers

Images are transferred to and from the Synergy Q/MD/X switcher using the WebDAV protocol. Stills and logos are stored on the switcher hard drive, and can be transferred to other control-room devices via Ethernet.

Images must meet the following specifications and naming conventions:

**Image Specifications**

**File type**

Images for the Synergy Q/MD/X switcher can be created in any graphic package that outputs compressed or uncompressed Targa files.

**Still Image File Size**

Still images can be created as either a 24-bit or 32-bit file:

- 24-bit file contains no alpha component
- 32-bit file contains an alpha component

Maximum size of a Still image single frame:

- 1080i format - 1920 pixels by 1080 lines
- 1080psf format - 1920 pixels by 1080 lines
- 720p format - 1280 pixels by 720 lines

**Animated Image File Sizes**

Animated images should be created as a 32-bit file with an alpha component.

Maximum size of an Animated image single frame:

- 1080i format - 1920 pixels by 1080 pixels
- 1080psf format - 1920 pixels by 1080 pixels
- 720p format - 1280 pixels by 720 pixels

**Storage Capacity**

The number of images that can be stored depends upon the size of the image being used. Full screen 1080i images take 5 times the storage of a 480i clip. However, a small, animated logo in 1080i will take much less storage than a full screen 480i clip. The MediaCache for Global-Store option increases the RAM capacity from 256MB to 1GB. This allows storage of up to 4 seconds of uncompressed 1080i playout or 25 Seconds of 480i playout.

Refer to the following table for approximate storage capacity on the hard drive, based on format:
File Naming Conventions

File Names

All file and directory names can be up to 12 characters (not including the file extension). If the name has over 12 characters, the file or directory will not appear on the switcher panel. The filename can contain letters, numbers, and spaces. The characters ! @ # * ( ) / , (comma) ? ' (apostrophe) “” (quotation marks), as well as starting a name with a . (period), cannot be used in the filename.

Animated Images

You must append an underscore (_) and a frame number to the filename before the .tga extension. The frame number must meet the following criteria:

- Each frame number must have between two and five digits.
- Each frame number must have the same number of digits (i.e., you must use leading zeros to pad the frame number length).
- The first frame number must be a series of zeros. Subsequent frames are numbered sequentially.

### Storage Capacity

<table>
<thead>
<tr>
<th>Format</th>
<th>Approximate Size (Bytes)</th>
<th>Number of Stills</th>
<th>1 GB Video (Seconds)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>256 MB</td>
<td>1 GB</td>
</tr>
<tr>
<td>1080i 60 / 59.94 Hz</td>
<td>6,220,844</td>
<td>35</td>
<td>138</td>
</tr>
<tr>
<td>1080i 60 / 59.94 Hz with Alpha</td>
<td>8,294,444</td>
<td>26</td>
<td>104</td>
</tr>
<tr>
<td>1080i 50 Hz</td>
<td>6,220,844</td>
<td>35</td>
<td>138</td>
</tr>
<tr>
<td>1080i 50 Hz with Alpha</td>
<td>8,294,444</td>
<td>26</td>
<td>104</td>
</tr>
<tr>
<td>1080psf 24 / 23.97 Hz</td>
<td>6,220,844</td>
<td>35</td>
<td>138</td>
</tr>
<tr>
<td>1080psf 24 / 23.97 Hz with Alpha</td>
<td>8,294,444</td>
<td>26</td>
<td>104</td>
</tr>
<tr>
<td>1080p 24 Hz</td>
<td>6,220,844</td>
<td>35</td>
<td>138</td>
</tr>
<tr>
<td>1080p 24 Hz with Alpha</td>
<td>8,294,444</td>
<td>26</td>
<td>104</td>
</tr>
<tr>
<td>720p 60 / 59.94 Hz</td>
<td>2,765,339</td>
<td>78</td>
<td>311</td>
</tr>
<tr>
<td>720p 60 / 59.94 Hz with Alpha</td>
<td>3,686,939</td>
<td>58</td>
<td>233</td>
</tr>
<tr>
<td>720p 50 Hz</td>
<td>2,765,339</td>
<td>78</td>
<td>311</td>
</tr>
<tr>
<td>720p 50 Hz with Alpha</td>
<td>3,686,939</td>
<td>58</td>
<td>233</td>
</tr>
<tr>
<td>576i 50 Hz</td>
<td>1,244,699</td>
<td>173</td>
<td>690</td>
</tr>
<tr>
<td>576i 50 Hz with Alpha</td>
<td>1,659,419</td>
<td>129</td>
<td>518</td>
</tr>
<tr>
<td>480i 60 Hz</td>
<td>1,050,299</td>
<td>204</td>
<td>818</td>
</tr>
<tr>
<td>480i 60 Hz with Alpha</td>
<td>1,400,219</td>
<td>153</td>
<td>613</td>
</tr>
</tbody>
</table>
The example below shows the filenames for an animation called *DTVB*.

**Sample file naming for an image with 90 frames:**

- DTVB_0000.tga
- DTVB_0001.tga
- DTVB_0002.tga
- ...
- DTVB_0090.tga

**Folders**

Folder names can be up to 12 characters. If the name has over 12 characters, the folder, and any files contained within it, will not appear on the switcher panel. The filename can contain letters, numbers, and spaces. The characters `! @ # * ( ) / , (comma) ? ' (apostrophe) “”` (quotation marks) cannot be used in the filename.
Creating a Connection to Your Switcher

Transferring still images and animations from your computer to your Synergy Q/MD/X switcher is accomplished just like you would copy or move files and folders on your computer (drag and drop). Before you can transfer files, however, you must establish a connection between your computer and switcher using the WebDAV protocol. WebDAV (Web-based Distributed Authoring and Versioning) is a set of HTTP protocol extensions for collaborative managing and editing of files on remote servers.

**Important**

The steps to create a WebDAV connection between your computer and switcher differ for each operating system and network configuration.

If you need assistance in establishing a WebDAV connection, contact your IT department. The information provided below will allow them to successfully establish a connection.

Drag and drop of still images and animations between the switcher and a computer using the WebDAV protocol has been tested on the following operating systems:

- Microsoft® Windows® 98
- Microsoft Windows XP Professional with Service Pack 1
- Neon Library Version 0.24 or later, used by WebDAV clients such as Konqueror, Nautilus, and Cadaver
- Microsoft Windows 2000
- Mac® OS X 10.4 or later

The WebDAV mount point for your switcher is `http://switcher_ip_address/stills` where `switcher_ip_address` is the network TCP/IP address of your Synergy Q/MD/X switcher. For example, if your switcher has an IP address of 192.168.1.10, the WebDAV mount point would be `http://192.168.1.10/stills`. Refer to the section “Network Setup” in the chapter, “Software Upgrades and Options”, of the Synergy Q/MD or Q/MD-X Engineering Manual for details on setting or determining the IP address of your switcher.

**Note**

Windows XP requires you to add a “/#” to the end of the address when you access the switcher. For example, you would enter “`http://switcher_ip_address/stills/#`”.

The user name and password for accessing the mount point is the same as you use for upgrading your switcher software. By default, the user name is `user` and the password is `password`. Refer to the section “Changing the Synergy Q/MD/X Web Interface Account” in the chapter, “Software Upgrades and Options”, of the Synergy Q/MD or Q/MD-X Engineering Manual for details on changing the user name and password.

You may wish to fill-in the table on the next page with the appropriate settings for your switcher to make it easier to re-create the WebDAV connection at a later date.
Alternate Connection Method

If you are unable to create a WebDAV connection to your switcher, you can create an FTP (File Transfer Protocol) connection to copy stills and animations.

The FTP mount point for your switcher is `ftp://switcher_ip_address` where `switcher_ip_address` is the network TCP/IP address of your Synergy Q/MD/X switcher. For example, if your switcher has an IP address of 192.168.1.10, the FTP mount point would be `ftp://192.168.1.10`. Refer to the section “Network Setup” in the chapter, “Software Upgrades and Options”, of the Synergy Q/MD or Q/MD-X Engineering Manual for details on setting or determining the IP address of your switcher.

The user name and password for accessing the FTP mount point are:

- username: `user`
- password: `password`

Note that these are not the same settings you use for accessing your switcher using the Synergy Q/MD/X Web Interface. Even if you have changed the username or password for the Web Interface, the FTP user name and password does not change.
Transferring Still Images and Animations

Copying images to and from your switcher is just like copying files and folders on your computer. Once the WebDAV connection is established, you can drag and drop files and folders between your computer and switcher. Any computer with the WebDAV connection to your switcher can be used to drag and drop still images and animations.

**Important**

You should only use the WebDAV connection to transfer files between your switcher and computer. If you use the connection to rename, move, or copy images between directories on your switcher, the associated image properties will not be updated. Use the switcher panel to rename or move images between directories. Refer to the section “Renaming a Still or Directory” on page 13–11 and the section “Moving a Still from Directory to Directory” on page 13–18 for information.

Copying Still Images and Animations to your Switcher

Before copying images or animations to your switcher, ensure that you have named them properly. Refer to the section “File Naming Conventions” on page 13–3 for details.

Use the following procedure to copy still images and animations to your switcher:

1. Establish a WebDAV connection between your computer and switcher. Refer to the section “Creating a Connection to Your Switcher” on page 13–5 for details.

2. Open the connection to your switcher in a file-manager type window on your computer (different operating systems have different file management systems).

3. If you wish to create a sub-directory to store your images, do so now. Consult your IT department or operating system documentation if you need help creating directories.

4. Navigate to the sub-directory you wish to store your images in.

5. Open a second file-manager type window on your computer and navigate to the directory where the images or animations you wish to copy are stored.

6. Drag the image and animation files from this window to the window showing the contents of the destination directory on your switcher.

**Note**

You can only cascade 4 sub-directories from the root /stills directory.

Note

Some operating systems require you to press keys on your keyboard while dragging files to indicate you are copying rather than moving them. Consult your IT department or operating system documentation for details on your installation.

This completes the procedure for copying still images and animations to your switcher.
Copying Images and Animations from your Switcher

Before copying images or animations to your switcher, ensure that you have named them properly. Refer to the section “File Naming Conventions” on page 13–3 for details.

Use the following procedure to copy still images and animations from your switcher:

1. Establish a WebDAV connection between your computer and switcher. Refer to the section “Creating a Connection to Your Switcher” on page 13–5 for details.

2. Open the connection to your switcher in a file-manager type window on your computer and navigate to the sub-directory where the images or animations you wish to copy are stored.

3. Open a second file-manager type window on your computer and navigate to the location where you wish to store the images or animations. Also, if you wish to create a sub-directory to store your images, do so now.

4. Drag the image and animation files from the window showing the contents of your switcher to the window showing the contents of the sub-directory on your computer.

This completes the procedure for copying still images and animations from your switcher.

Legacy Image and Animation Files

Important  This section only applies if you have upgraded your switcher from a version prior to 5.0.

Versions of Synergy Q/MD/X software prior to 5.0, used a proprietary software package called ImageMover to handle the copying of still images and animations between your computer and switcher. ImageMover automatically appended the appropriate suffix to each file and also performed some conversions during the copy resulting in extra files being created on the switcher that are no longer used. These files were of the type:

- *
  - .sti and .stp — These files were associated with still images
  - .ali and .alp — These files were associated with alpha channels

If you used ImageMover with previous versions of Synergy Q/MD/X software, your switcher may contain some legacy files. They are no longer required and may be deleted if you are using software version 5.0 or greater. If you delete these files and then revert to a switcher software version prior to 5.0, your Global-Store still images and animations will no longer be available.

Operating Tip  Some operating systems do not show file extensions by default. Enable the viewing of file extensions so you can differentiate between actual images and the *.sti, *.stp, *.ali, and *.alp legacy files. Consult your IT Department or operating system documentation for assistance.
Still-Store

There are two types of still-stores available for your Synergy Q/MD/X switcher:

- **Global-Store** — Global-Store consists of three independent channels of stills that are available as inputs to every MLE on your switcher. Hundreds of full screen stills and logos can be stored on the hard drive, and to the Global-Store cache as needed.

- **MLE-Store** — MLE-Store consists of four independent channels of stills that are unique to each MLE. Hundreds of full screen stills and logos can be stored on the hard drive, and to the MLE-Store cache as needed. You need the XFX MLE-Store option installed on every MLE you which to have access to MLE-Store images.

Global-Store and MLE-Store each come standard with 256 Megabytes of RAM storage. This translates to at least 30 full screen 1080i images with key. The number of images increases considerably when smaller images like logos are stored. Thousands of additional images can be loaded from the hard drive of the switcher.

**Important**

Be careful when assigning MLE-Store buttons to crosspoint buttons when you do not have the MLE-Store option for each MLE in your switcher. The assigned crosspoint button will be inoperable on MLEs without the MLE-Store option. See the section “Setting Up Panel Buttons” in the chapter, “BNC Configuration and Check”, of the Synergy Q/MD or Q/MD-X Engineering Manual for details.

### Selecting a Still for a Still-Store Channel

Selecting a still image allows you to select a particular still from a directory on the hard drive and assign it to a particular Still-Store Channel. This image can then be taken on-air by selecting one of the Still-Store crosspoints.

Use the following procedure to assign a still to a Still-Store channel:

**Important**

If you are selecting a still for an MLE-Store channel, be aware that each MLE-Store has independent channels. If you want your image to appear in the same channel across all MLE-Stores, you will have to load it in the same channel in each MLE-Store.

**Caution**

Pressing **0** and **ENTER** on the keypad in the Global Memory System Group will remove the still from the Still-Store channel that is currently shown on the display in the Global Memory System Group.

**Operating Tip**

If you know the 4 digit number of the still, you can select the crosspoint button assigned to the desired Still-Store Channel and then enter the number of the still on the keypad in the Global Memory System Group and press **ENTER**. The still will be loaded into the selected Still-Store Channel.

1. Navigate to the Still Store Menu as follows:

   - Press **HOME ⇒ Effects ⇒ Still Store**.
The **Still-Store Menu** displays the stills that are currently loaded into the various channels (there are three Global-Store channels and four MLE-Store channels), as well as the pertinent information about each of the stills.

- **Channel** — The Channel line indicates which channel the still has been loaded into.
- **“Name”** — The name of the current still is shown below the channel listing.
- **Number** — The Number line indicates the number of the currently loaded still. You can use this number to load a still into a Still-Store channel by entering it on the keypad in the **Global Memory System Group**.
- **Size** — The Size line indicates the size, in pixels, of the currently loaded still.
- **Alpha** — The Alpha line indicates whether a still has an alpha associated with it (Video), is an alpha (Alpha), or doesn’t have an alpha (No).
- **Frames** — The Frames line indicates the length of an animated still.

2. Use the **Still-Store Select** knob to select the still-store you wish to work with. You can select from the following:
   - **Global-Store** — Global-Store (common across all MLEs)
   - **MLE1** — MLE-Store for MLE 1
   - **MLE2** — MLE-Store for MLE 2 (Synergy 2-4 Q/MD/X only)
   - **MLE3** — MLE-Store for MLE 3 (Synergy 3-4 Q/MD-X only)
   - **MLE4** — MLE-Store for MLE 4 (Synergy 4 Q/MD-X only)

3. Select the channel you want to assign a still to as follows:
   - Use the **Channel** knob to select the Still-Store channel you want to assign a still to (Global-Store has three available channels and each MLE-Store has four).

   **Note**
   As you select the channel you will notice a box surrounds the Channel you have selected.

4. Press **Select/Manage** to display the **Select Still for Channel Menu 1-2**.
5. Select the directory that contains the still you want to assign to the channel as follows:

   • Use the Contents knob to select the directory that contains the still you want to assign.

   Operating Tip
   Selecting the <UP ONE> and pressing Select will take you to the higher level directory.

   • Press Select to select that directory as the Current Directory. The change will be shown in the Path:/ just below the menu title.

6. Assign a still to the selected Still-Store channel as follows.

   • Use the Contents knob to select the still that you want to assign.

   Operating Tip
   All names that end with a “/” are directories.

   Note
   Selecting an image that is larger than the current video format, or whose position will cause it to be off screen, can cause corrupt video output.

   • Press Select to assign the selected still to the selected Still-Store channel.

   Note
   If you are selecting an Auto Select Key, you must have another Still-Store channel associated with the current one to load the Key Alpha into. Refer to Chapter 7, “BNC Configuration and Check” in the Synergy Q/MD or Q/MD-X Engineering Manual for more information on setting up Auto Select Keys.

   If you receive an error message, or you want to abort the loading of a still, you can press 0 and then ENTER on the keypad in the Global Memory System Group. This will clear the selected Still-Store channel.

This completes the procedure for assigning a still to a Still-Store channel.

Renaming a Still or Directory

Use the following procedure to rename a still or directory:

1. Navigate to the Still-Store Menu as follows:

   • Press HOME ⇒ Effects ⇒ Still Store.
2. Press **Select/Manage** to display the **Select Still for Channel Menu 1-2**.

   **Note**
   You do not need to specify a Still-Store channel, changes to names or numbers are applied across all channels.

3. Use the **Contents** knob to select the still or directory that you want to rename.

4. Press **Rename** to display the **Rename File or Directory Menu**.

   **Operating Tip**
   This menu can also be used to renumber a still.

5. Create a new name for the selected still or directory as follows:

   **Note**
   Certain punctuation characters may not be used in a name:
   `! @ # & * ( ) / , (comma) ? ' (apostrophe)
   " (quotation marks). You also cannot start a name with a . (period).

   **Operating Tip**
   A Standard PS/2 keyboard can be used to perform the same actions as pressing or rotating the **System Control** buttons and knobs.
   Refer to the section “**Using a Keyboard**” on page 2-20 for more information on using the keyboard.

   - Use the **Horizontal** knob to move the highlight horizontally to select a letter, number or symbol. Any invalid characters will be skipped as you scroll through the characters.
   - Use the **Vertical** knob to move the highlight vertically to select a letter, number or symbol. Any invalid characters will be skipped as you scroll through the characters.
   - Press **Prev Letter** to move to the previous letter.
• Press **Next Letter** to move to the next letter.
• Press **Space** to insert a blank space in the name (spaces will be converted to underscore characters (_) when the system accepts the name).

6. Press **Accept New Name** to accept the new name.

**Note**

If there is another still or directory at the current directory level with the same name as you have just entered, an error message will appear prompting you to choose another name.

This completes the procedure for renaming a still or directory.

**Renumbering a Still**

Use the following procedure to renumber a still:

1. Navigate to the **Still-Store Menu** as follows:
   • Press **HOME** ⇒ **Effects** ⇒ **Still Store**.
2. Press **Select/Manage** to display the **Select Still for Channel Menu 1-2**.

**Note**

You do not need to specify a Still-Store channel, changes to names or numbers are applied across all channels.

3. Use the **Contents** knob to select the still that you want to renumber.
4. Press **UP ONE** to display the **Still-Store Menu**.
5. Press **On Air Properties** to display the **Still-Store Properties Menu**.
6. Press Rename/Renumber to display the Rename/Renumber Still Menu.

7. Renumber the still as follows:
   - Enter the new number for the selected still on the keypad in the Global Memory System Group.
   - Press ENTER to save the new number.

   This menu can also be used to rename a still.

   **Important**
   If another still exists with the same number, the new number will not be recorded.

   **Note**
   If you have not changed the name of the still you do not need to press Accept New Name in order to save the changes to the still number.

This completes the procedure for renumbering a still.

**Creating a Directory**

Use the following procedure to create a directory:

1. Navigate to the Still-Store Menu as follows:
   - Press HOME ⇒ Effects ⇒ Still Store.
2. Press Select/Manage to display the Select Still for Channel Menu 1-2.

   **Note**
   You do not need to specify a Still-Store channel, changes to directories are applied across all channels.
Select Still for Channel Menu 1-2

Operating Tip

Selecting the <UP ONE> and pressing Select will take you to the higher level directory.

3. Select the directory you want to create a new directory in as follows:

- Use the Contents knob to select the directory you want to create a directory in.
- Press Select to select that directory as the Current Directory. The change will be shown in the Path:/ just below the menu title.

4. Press Create Directory to display the Create Directory Menu.

Note

You can only cascade 4 sub-directories from the root directory. If you have selected a sub-directory that is 4 sub-directories down from the root directory, the Create Directory button will appear gray and you will not be able to create another sub-directory at that level.

Create Directory Menu

5. Create a name for the new directory as follows:

Note

Certain punctuation characters may not be used in a name:

! @ # & * ( ) / , (comma) ? ' (apostrophe) " (quotation marks).

Operating Tip

A Standard PS/2 keyboard can be used to perform the same actions as pressing or rotating the System Control buttons and knobs.

- Use the Horizontal knob to move the highlight horizontally to select a letter, number or symbol. Any invalid characters will be skipped as you scroll through the characters.
- Use the Vertical knob to move the highlight vertically to select a letter, number or symbol. Any invalid characters will be skipped as you scroll through the characters.
- Press Prev Letter to move to the previous letter.
- Press Next Letter to move to the next letter.
1.

6. Press **Accept New Name** to create the new directory. If there is another directory at the current directory level with the same name as you have just entered, an error message will appear prompting you to choose another name.

   ![Note Image]
   
   **Note**
   Any space characters will be converted to underscore characters (_), when the system accepts the name.

This completes the procedure for creating a directory.

## Deleting All Stills in a Directory

Use the following procedure to delete all unlocked stills in a directory:

1. Navigate to the **Still-Store Menu** as follows:
   - Press **HOME** ⇒ **Effects** ⇒ **Still Store**.

2. Press **Select/Manage** ⇒ **MORE** to display the **Select Still for Channel Menu 2-2**.

   ![Select Still for Channel Menu 2-2 Image]
   
   **Note**
   You do not need to specify a Still-Store channel, changes to directories are applied across all channels.

3. Select the directory you want to delete all the still from as follows:
   - Use the **Contents** knob to select the directory that contains the stills you want to delete.
   - Press **Select** to select that directory as the **Current Directory**. The change will be shown in the **Path://** just below the menu title.

   ![Select Still for Channel Menu 2-2 Image]

   **Operating Tip**
   Selecting the <UP ONE> and pressing **Select** will take you to the higher level directory.
4. Press **Delete All** to display the **Delete All Contents Screen**.

```
This will delete all contents of this directory, are you sure?
```

![Delete All Contents Screen](image)

5. Press **Yes** to delete all stills in the directory.
6. Press **No** to return to the previous menu.

This completes the procedure for deleting all the stills in a directory.

## Deleting an Individual Still or Directory

Use the following procedure to delete a still or directory:

1. Navigate to the **Still-Store Menu** as follows:
   - Press **HOME** ⇒ **Effects** ⇒ **Still Store**.
2. Press **Select/Manage** ⇒ **MORE** to display the **Select Still for Channel Menu 2-2**.

   ![Select Still for Channel Menu 2-2](image)

3. Use the **Contents** knob to select the directory or still that you want to delete.

   ![Operating Tip](image)

   **Operating Tip**

   Selecting the `<UP ONE>` and pressing **Select** will take you to the higher level directory.

4. Press **Delete** to display the **Delete Entry Screen**.

   ![Note](image)

   **Note**

   You cannot delete a directory that contains sub-directories or stills. Delete the stills or sub-directories from this directory first. The **Delete** button will be gray if you cannot delete the selected directory.
Delete Entry Screen

5. Press **Yes** to delete the selected still or directory.
6. Press **No** to return to the previous menu.

This completes the procedure for deleting an individual still or directory.

### Moving a Still from Directory to Directory

You can cut and paste a still from one directory to another using the menu system on the switcher. This allows you to organize your stills without the need for a computer and WebDAV connection.

Use the following procedure to move a still from one directory to another:

1. Navigate to the **Still-Store Menu** as follows:
   - Press HOME ⇒ Effects ⇒ Still Store.
2. Press **Select/Manage** to display the **Select Still for Channel Menu 1-2**.

#### Note

You do not need to specify a Still-Store channel, changes to stills or directories are applied across all channels.

3. Select the directory that contains the still you want to move as follows:
   - Use the **Contents** knob to select the directory that contains the stills you want to move.
   - Press **Select** to select that directory as the **Current Directory**. The change will be shown in the **Path:/** just below the menu title.

4. Press **MORE** to display the **Select Still for Channel Menu 2-2**.

5. Cut the still as follows:
   - Use the **Contents** knob to select the still you want to move.
   - Press **Cut** to remove the selected still from the current directory.
6. Press **MORE** to display the **Select Still for Channel Menu 1-2**.
7. Select the directory that you want to move the still to as follows:
   - Use the Contents knob to select the directory that you want to move the still to.
   - Press Select to select that directory as the Current Directory. The change will be shown in the Path:/ just below the menu title.

8. Press MORE to display the Select Still for Channel Menu 2-2.

9. Paste the still as follows:
   - Press Paste to paste the still to the current directory.

This completes the procedure for moving a still from one directory to another.

**On-Air Properties**

The on-air properties menu allows you to adjust the position, display mode, and animation attributes of the selected Still-Store still.

**Important**

If you revert your switcher to an older software version, loaded stills and properties may be lost. Contact Ross Video Technical Support for details.

Use the following procedure to adjust the on-air properties of the images in the Still-Store.

1. Navigate to the Still-Store Menu as follows:
   - Press HOME ⇒ Effects ⇒ Still Store.

2. Press Select/Manage to display the Select Still for Channel Menu 1-2.

**Note**

You do not need to specify a Still-Store channel, changes to stills or directories are applied across all channels.

3. Select the directory that contains the still you want to adjust as follows:
   - Use the Contents knob to select the directory that contains the stills you want to set the on-air properties for.
   - Press Select to select that directory as the Current Directory. The change will be shown in the Path:/ just below the menu title.

4. Use the Contents knob to select the still that you want to adjust the on-air properties for.

5. Press Select to assign the selected still to the current Global-Store Channel.

**Operating Tip**

Selecting the <UP ONE> and pressing Select will take you to the higher level directory.
6. Press **UP ONE** to display the **Still-Store Menu**.

7. Press **On Air Properties** to display the **Still-Store Properties Menu**.

8. Adjust the **Position** of the stills as follows:
   - Press **Position** to display the **Position Menu**.

   - Use the **X knob** to adjust the **X-Position** of the still image.
   - Use the **Y knob** to adjust the **Y-Position** of the still image.

   **Note**
   Images cannot be positioned off-screen. If your image is full-screen, you cannot modify the position.

9. Adjust the **Still Properties** of the still as follows:
   - Press **Still Properties** to display the **Still-Store Properties Menu**.
• Use the **Shaped** knob to set the still as either shaped or unshaped. You can choose between the following:

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Unshaped</strong></td>
<td>Select this option to have the switcher create a <em>multiplicative still</em>. With unshaped stills, the alpha cuts a hole based on the gradient values of the alpha. Shades of gray are translated into transparency levels, giving the still a soft edge. Unshaped stills are considered true linear alphas.</td>
</tr>
<tr>
<td><strong>Shaped</strong></td>
<td>Select this option to have the switcher create an <em>additive still</em>. With shaped stills, the alpha channel cuts a hole based on the monochrome value of the alpha. Shades of gray are translated into either white or black, giving the still a hard edge.</td>
</tr>
</tbody>
</table>

• Use the **Play Mode** knob to select the **Field/Frame** display mode you want to use. You can select between the following:

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Frame</strong></td>
<td>Select this option to have the entire frame of the still image displayed.</td>
</tr>
<tr>
<td><strong>Swap</strong></td>
<td>Select this option to have field 1 and field 2 of the image swapped when they are displayed (this option is only available for interlaced video formats).</td>
</tr>
<tr>
<td><strong>Field1</strong></td>
<td>Select this option to have field 1 of the still image displayed (this option is only available for interlaced video formats).</td>
</tr>
<tr>
<td><strong>Field2</strong></td>
<td>Select this option to have field 2 of the still image displayed (this option is only available for interlaced video formats).</td>
</tr>
</tbody>
</table>

10. Set the **Animation** characteristics of an animation as follows:

• Press **Animation** to display the **Animation Menu**.

<table>
<thead>
<tr>
<th>Still-Store Animation Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global-Store (size: 1024 MB, Free: 988 MB) - Channel</td>
</tr>
<tr>
<td>Name: Synergy</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Looping</th>
<th>Reverse</th>
<th>AutoPlay</th>
<th>Display Frame</th>
<th>Play Speed</th>
<th>Trim</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes/No</td>
<td>Yes/No</td>
<td>Yes/No</td>
<td>Yes/No</td>
<td>Yes/No</td>
<td>Yes/No</td>
</tr>
</tbody>
</table>

Global-Store Properties — Animation Menu

• Toggle **Looping** to set whether the animation will start over when it reaches the last frame of the animation.
• Toggle **Reverse** to set whether the animation plays forward or in reverse.
• Toggle **AutoPlay** to set whether the animation automatically starts to play when it is taken on-air.
• Toggle **Display Frame** to **On** to enable this feature.

  • Use the **Displayed** knob to display a specific, single frame, from the animation. The animation stops and only the selected frame is displayed.
  • Press **Create Thumbnail** to create a thumbnail from the selected frame. This thumbnail is used for the animation on the Still-Store menus.
• Toggle **Play Speed** to **On** to enable this feature.
  ~ Use the **Speed** knob to select the speed that you want the animation to play out at.

• Toggle **Trim** to **On** to enable this feature.
  ~ Use the **Start Frame** knob to select the frame that you want the animation to start at.
  ~ Use the **End Frame** knob to select the frame that you want the animation to end at.

This completes the procedure for adjusting the on-air properties of the images in the Still-Store.

**Default Stills**

You can assign a still as being default for each Still-Store channel. When a still is set as default, it will be loaded into the assigned Still-Store channel on startup.

**Assigning Default Stills**

Use the following procedure to assign a still as default to a Still-Store Channel.

---

**Important**

If you assign an Auto Key as a default still, the Still-Store channel that is assigned to the alpha for the still will overwrite any default assignment for that channel. For example, if Global-Store channel 3 is assigned as the alpha for Global-Store channel 1, setting an Auto Key as default in Global-Store 1 will also set the alpha as the default in Global-Store 3.

1. Navigate to the **Still-Store Menu** as follows:
   - Press HOME ⇒ Effects ⇒ Still Store.

   ![Still-Store Menu](image)

2. Use the **Still-Store Select** knob to select the still-store you wish to work with. You can select from the following:
   - **Global-Store** – Global-Store (common across all MLEs)
   - **MLE1** – MLE-Store for MLE 1
   - **MLE2** – MLE-Store for MLE 2 (Synergy 2-4 Q/MD/X only)
   - **MLE3** – MLE-Store for MLE 3 (Synergy 3-4 Q/MD-X only)
   - **MLE4** – MLE-Store for MLE 4 (Synergy 4 Q/MD-X only)
3. Select the Still-Store channel you want to assign the default still to as follows:
   • Use the Channel knob to select the Global-Store channel you want to assign the default still to.
4. Press Select/Manage to display the Select Still for Channel Menu 1-2.
5. Select the directory that contains the still you want to assign as the default still as follows:
   • Use the Contents knob to select the directory that contains the stills you want to set as default.
   • Press Select to select that directory as the Current Directory. The change will be shown in the Path:/ just below the menu title.
6. Use the Contents knob to select the still that you want to set as default.
7. Press Select to assign the selected still to the current Global-Store Channel.
8. Press UP ONE to display the Still-Store Menu.

9. Press Assign As Default to assign the selected still as the default still for that particular Still-Store Channel.

The new default still has been assigned to the selected Still-Store channel.

This completes the procedure for assigning a still as default for a Still-Store channel.

**Viewing Default Stills**

Use the following procedure to view the current default still for a Global-Store Channel.

1. Navigate to the Still-Store Menu as follows:
   • Press HOME ⇒ Effects ⇒ Still Store.
2. Use the Still-Store Select knob to select the still-store you wish to work with. You can select from the following:
3. Select the Still-Store channel you want to view the default still for as follows:

- Use the Channel knob to select the Still-Store channel you want to view the default still for.

4. Press **View Defaults** to display the **Still-Store Defaults Menu**.

<table>
<thead>
<tr>
<th>Channel 1</th>
<th>Channel 2</th>
<th>Channel 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number: 168</td>
<td>Number: 169</td>
<td>Number: 175</td>
</tr>
</tbody>
</table>

**Still-Store Defaults Menu**

- **Operating Tip**: Press **Reload Defaults** to reload the default stills into the Still-Store channels.

This completes the procedure for viewing the default still for a Still-Store channel.

**Capturing Stills**

You can capture an image from your Preview or Aux-Bus outputs and save it as a still for later use. Both full-screen images and cropped sections of full-screen images can be captured.

**Important**

You can only capture still images using the Global-Store. You cannot capture stills when using an MLE-Store.

**Performing a Capture**

Use the following procedure to capture a still image using the Global-Store:

1. Navigate to the **Still-Store Menu** as follows:

   - Press **HOME ⇒ Effects ⇒ Still Store**.
2. Use the **Still-Store Select** knob to select **Global-Store**.

3. Press **Capture** to display the **Global-Store Capture Menu**.

4. Press **Source** to display the **Global-Store Capture Source Menu**.

5. Use the **Vid Src** knob to select the source output for the still you wish to capture. You can select from the following:
   - **Preview** — The Preview (Preset) bus output of the bottom MLE on your switcher.
   - **Bnk/Aux_{nm}** — An Aux-Bus output where \( n \) is the Aux Bus bank number and \( m \) is the Aux Bus assign number.

6. Use the **Frames to Capture** knob to select the number of frames you want to capture.

7. Use the **Alpha Capture** knob to select whether to capture an associated alpha channel with the image. You can select from the following:
   - **No** — No alpha channel will be captured.
   - **Yes** — The associated alpha channel will be captured.

8. Press **Pos Size** to display the **Global Store Capture Position/Size Menu**.

---

**Note**

Alpha channel capture is only supported when capturing from an Aux-Bus output. You cannot capture an alpha channel from the Preview (Preset) bus.

---

The top of the menu displays **Full Screen Capture** indicating that the entire video frame will be captured. The left side of the menu displays the following information:

- **Size** — The size (in pixels) of the captured image.
- **Alpha** — Shows **Yes** to indicate that you have selected to capture the associated alpha-channel or **No** to indicate that no alpha channel will be captured.
- **Frames** — The number of frames to capture. Capturing a still captures a single frame only.
• **Saving to dir** — The directory on the switcher hard drive where the capture will be saved.

9. Adjust the size and position of the area to capture as follows:
   - Use the **Size** knob to adjust the size of the area to capture. The aspect ratio of the area remains constant as you resize it.
   - Use the **X** knob to move the capture area along the X-Axis. You cannot move the capture area if it is set to full-screen.
   - Use the **Y** knob to move the capture area along the Y-Axis. You cannot move the capture area if it is set to full-screen.

10. Press **Top Left** to display the **Global Store Capture Top/Left Menu**.

11. Move the top-left corner of the capture area as follows:
   - Use the **Left** knob to move the top-left corner along the X-Axis.
   - Use the **Top** knob to move the top-left corner along the Y-Axis.

   **Note** Only the top-left corner of the capture area is adjusted. The remaining corners remain pinned to their locations and the aspect ratio of the capture area changes as you modify the top-left corner.

12. Press **Bottom Right** to display the **Global Store Capture Bottom/Right Menu**.

13. Move the bottom-right corner of the capture area as follows:
   - Use the **Right** knob to move the bottom-right corner along the X-Axis.
   - Use the **Bottom** knob to move the bottom-right corner along the Y-Axis.

   **Note** Only the bottom-right corner of the capture area is adjusted. The remaining corners remain pinned to their locations and the aspect ratio of the capture area changes as you modify the bottom-right corner.
14. Press **Capture** to capture the image contained in the capture area. The image is stored as a Targa (.tga) file in the directory indicated at the left side of the menu. If you captured an associated alpha channel, the Targa file will include an 8-bit alpha channel.

This completes the procedure for capturing a still image using the Global-Store.

**Notes on Capturing Alpha Channels**

- Captured alpha channels are embedded in the Targa (.tga) file as an 8-bit alpha channel.
- If you have **Alpha Capture** set to **Yes**, and the video or still that you are capturing has no associated alpha channel, no alpha will be captured.
- If you have two Global-Store channels configured as an auto select key (see the section “Setting Up Still-Store Auto Keys” in Chapter 7 of the Synergy Q/MD or Q/MD-X Engineering Manual), and you load a new image into the video signal channel while leaving the alpha channel unchanged, you should disable **Alpha Capture**. If you leave it enabled, the captured video image will not match the captured alpha image and the resulting Targa file will appear incorrectly.

**Changing the Capture Directory**

Captured stills are stored in the top-level of the Still-Store directory structure by default. Typically, you will want to store captured stills in various sub-directories for organizational purposes.

Use the following procedure to change the directory where captured stills are stored:

1. Navigate to the **Still-Store Menu** as follows:
   - Press HOME ⇒ Effects ⇒ Still Store.

<table>
<thead>
<tr>
<th>Still-Store Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel 1</td>
</tr>
<tr>
<td>Bars</td>
</tr>
<tr>
<td>Number: 8</td>
</tr>
<tr>
<td>Size: 1528x1080</td>
</tr>
<tr>
<td>Alpha: No</td>
</tr>
<tr>
<td>Frames: 1</td>
</tr>
</tbody>
</table>

2. Use the **Still-Store Select** knob to select Global-Store.
3. Press **Capture** to display the **Global-Store Capture Menu**.
4. Press **Change Directory** to display the **Select Capture Directory Menu 1-2**.

<table>
<thead>
<tr>
<th>Select Still for Channel 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Path: /ROSG/ (1-2)</td>
</tr>
<tr>
<td>Contents:</td>
</tr>
<tr>
<td>10001/</td>
</tr>
<tr>
<td>400/</td>
</tr>
<tr>
<td>500/</td>
</tr>
<tr>
<td>720p/</td>
</tr>
<tr>
<td>4star/</td>
</tr>
</tbody>
</table>

   | Select | Rename | Create Directory | Up One | Down One |

5. Select the directory where you wish to save captured stills as follows:
• Use the **Contents** knob to select the directory where you wish to store captured stills.

• Press **Select** to select that directory. The change will be reflected next to the **Path:/** label, just below the menu title.

6. Press **UP ONE** to return to the **Global-Store Capture Menu**.

This completes the procedure for changing the directory where captured stills are stored.

**Other Capture Directory Menu Functions**

You can also perform the following tasks from the **Select Capture Directory Menu 1-2**:

• Renaming directories and stills (refer to the section “**Renaming a Still or Directory**” on page 13–11 for details)

• Creating directories (refer to the section “**Creating a Directory**” on page 13–14 for details)

• Deleting directories and stills (refer to the section “**Deleting an Individual Still or Directory**” on page 13–17 for details)

• Deleting all files in a directory (refer to the section “**Deleting All Stills in a Directory**” on page 13–16 for details)
Clip Control

In This Chapter

This chapter provides instructions for programming and running VTR, Video Server and Audio Server clips. The following topics are discussed in this chapter:

- VTR Clip Control
- Clip Control Overview
- Programming VTR Custom Control Buttons
- Programming Clips
- Programming VTR Clips
- Programming Audio Server Clips
- Programming Video Server Clips
- Running VTR Clips
- Application Notes

Note

If you are using the Leitch ASC series of Video Servers, please review section “Application Notes” on page 14–17 for important information regarding clip performance.
VTR Clip Control

The overall VTR Clip Control function allows you to set up, recall and run clips from three categories of serially controlled devices: VTRs, Video Servers and Audio Servers. Each device must be connected to the Synergy Q/MD/X System via RS-422 communications and properly set up using a series of installation setup menus.

Please note the following prerequisites for proper clip control operation:

- **VTR Clip Control**
  For proper operation with VTRs (and other serially controlled transports such as DDRs), the VTR Remote Control Option must be installed, each serially controlled VTR must be assigned as a VTR during installation and assigned the Betacam Protocol.

- **Audio Server Clip Control**
  For proper operation with Audio Servers, the Audio Server Control Option must be installed, each serially controlled audio server must be assigned as a VTR during installation and assigned the Digicart Protocol.

- **Video Server Clip Control**
  For proper operation with Video Servers, the Video Server Control Option must be installed, each serially controlled video server must be assigned as a VTR during installation and assigned the Louth (VDCP) Protocol.

Clip Control Overview

Four procedures are used to properly set up and play clips from a VTR, Audio Server or Video Server:

- **VTR Communications Setup**
  This procedure allows you to set up the BNC name, communications, protocol and preroll interval of the device.

- **Programming VTR Custom Control Buttons**
  This procedure allows you to assign dedicated Custom Control buttons to specific transport control (and clip) functions. This procedure is recommended for Audio Servers, but optional for VTRs and Video Servers.

- **Programming VTR Clips**
  A VTR clip typically consists of two pieces of information: a physical device connected to the system and a timecode register. Additional data is also included for Video and Audio Servers. Using the VTR Clips Menu, you can select a serial controlled device, and then program, name, preview and store clips in one of 100 clip registers.

- **Using VTR Clips**
  Once clip data is stored, you can press VTR CLIP in the Global Memory System Group, enter a clip register, cue the device (that is associated with the clip) and bring the clip to air.

  Different methods can then be used to play clips on-air:

  ~ Clips can be run (played) manually, using either a Custom Control button or the dedicated transport control softkeys in the Remote Control Menu.
Using the **ROLL VTR** button in Play mode, clips can be brought to air manually by the operator.

Using the **ROLL VTR** button in Arm or Armed Always modes, clips can be brought to air automatically using the transition area buttons.

Each procedure is explained in detail in the following sections.

### Important
Clips for VTRs, Video Servers and Audio Servers are saved in memory only upon exit of the **VTR Clips Menu**, but you can also store **VTR Clip Registers** to disk. Note also that in a power failure situation, all clip registers are protected.

### Programming VTR Custom Control Buttons

**Note**
This procedure is recommended for **Audio Servers**, but optional for **VTRs** and **Video Servers**.

When you set up your VTR, Video Server, and Audio Server clips using the **VTR Clips Menu**, transport control commands (such as **PLAY** and **STOP**) are located on the menu as standard. In addition, when you recall VTR and Video Server clips from memory for use during on-air production, transport control commands are also present on the individual **Remote Control Menus**.

With these facts in mind, you may (or may not) want to program these standard commands on individual **Custom Control** buttons for VTRs and Video Servers. Remember that **Custom Control** buttons do give you the ability to string groups of commands together (including transport controls and the ability to cue specific clips repeatedly), as follows:

- For automatic device control during transitions, remember that the **ROLL VTR** button (in Arm mode) in the **MLE Transition Group** automatically rolls the device that is selected on any bus in the MLE.
- For the **Digicart** Audio Server, which does not have a **Remote Control Menu**, programming a group of **Custom Control** buttons is recommended.
- If you do choose to program **Custom Control** buttons, at the minimum, you should program **four** functions: **PLAY**, **STOP**, **FF** and **REV**. These will allow you to control the selected device from the switcher panel, once the clip has been cued.

Refer to Chapter 11 in the **Synergy Q/MD** or **Q/MD-X Engineering Manual** for detailed instructions.

### Programming Clips

The next step in VTR clip operations is to program VTR, Video Server and Audio Server clips using the **VTR Clips Menu**. The menu is a **programming** menu, rather than a live menu, and is designed to set up clips for later use on-air.

This menu allows you to perform the following functions:

- Select a serial controlled device and a clip number.
- Grab or enter a timecode (and other device-specific data), name the clip, and store it in a clip register. Up to 100 clips can be stored (using registers **00** to **99**).
- Cue and preview each clip.
- For Video Servers, trim the inpoint and outpoint of the clip.
Procedures are provided below for programming VTR clips, Video Server clips, and Audio Server clips. The steps vary slightly for each device, because the VTR Clips Menu changes depending upon the selected device.

**Programming VTR Clips**

Use the following procedure to program VTR clips:

1. Ensure that your VTR communication has been properly set up. If not, refer to Chapter 9 “Communications Setup” in the Synergy Q/MD or Q/MD-X Engineering Manual for instructions.

2. Navigate to the VTR Clips Menu 1-2 as follows:
   - Press HOME ⇒ MORE ⇒ Clips ⇒ VTR Clips.

3. Press **Clip Type**.

4. Select a VTR clip register to program as follows:
   - Use the **Clip** knob to select the clip register that you want to program (00 through 99).
   - Use the **Device** knob to select a VTR.

5. Press **Name Clip** to give the VTR clip a name — one that you want to appear in your list of clip registers, in the display of the Global Memory System Group, and on the Remote Control Menu. The Clip Name Menu appears.

   - Use the **Horizontal** and **Vertical** knobs (in conjunction with the editing softkeys) to enter the desired clip name. A Standard PS/2 keyboard can be used to perform the same actions as pressing or rotating the System Control buttons and knobs.

   **Important**

   Do not enter a space as the first or last character of a clip name.

6. Press **Accept New Name** to complete the naming procedure and return to the VTR Clips Menu 1-2. On the VTR Clips Menu 1-2, the selected name appears in the status area and adjacent to the highlighted **Clip** (in the right-hand column).
7. To select the timecode for the clip, two methods are available.

To **manually enter a timecode**:

- Press **Hours Minutes** to display the **Hours Minutes Menu**.
  
  
  - Use the **Hours** knob to select the hours value.
  - Use the **Minutes** knob to select the minutes. The values appear in the **Inpoint** field in the status area as you select them.
  - Press **Seconds Frames**.
  - Use the **Seconds** knob to select the seconds.
  - Use the **Frames** knob to select the frames.
  - Press **Cue to Inpoint** to cue the VTR to the new inpoint value.

To **grab a timecode**:

- Press **MORE** to display the **VTR Clips Menu 2-2**.
  
  
  - Cue the VTR to the desired timecode using the available transport controls: **Rewind, Back Frame, Pause, Play, Ahead Frame** and **Fast Forward**.
  - When the VTR is paused on the desired frame, press **MORE ⇒ MORE** to return to the **VTR Clips Menu 1-2**.
• Press **Grab Timecode** to complete the procedure. The grabbed value now appears in the **Timecode** field in the status area.

8. Repeat steps 3 through 7 for any additional VTR clip registers that you wish to program. In addition to programming new clips, remember that these steps can also be used to edit existing clip registers.

### Programming Audio Server Clips

Use the following procedure to program Audio Server clips:

1. Ensure that your Audio Server communication has been properly set up. If not, refer to Chapter 9 “Basic Communications Setup” in the *Synergy Q/MD or Q/MD-X Engineering Manual* for instructions.

2. Navigate to the **VTR Clips Type Menu 1-3** as follows:
   - Press **HOME** ⇒ **MORE** ⇒ **Clips** ⇒ **VTR Clips**.

3. Press **Clip Type** to display the **VTR Clips Type Menu 1-3**.
   - Use the **Clip** knob to select the clip register that you want to program (00 through 99).
   - Use the **Device** knob to select an Audio Server. The remote control port for the Audio Server appears in parentheses. Once the device is selected, the **VTR Clips Menu** changes to show softkey labels and status fields that are specific to programming “Audio Server” clips only.

4. Press **Name Clip** to display the **Clip Name Menu**.
   - The name you give the Audio Server clip will appear in your list of clip registers and in the display of the **Global Memory System Group**.
   - Use the **Horizontal** and **Vertical** knobs plus the editing softkeys to enter the desired name. A Standard PS/2 keyboard can be used to perform the same actions as pressing or rotating the **System Control** buttons and knobs.

   **Important**

   Do not enter a space as the first or last character of a clip name.

   **Note**

   The bottom **Enable/Disable** function can be ignored. Because there is no **Remote Control Menu** for Audio Servers, all Digicart clips must be run from **Custom Control** buttons.

This completes the procedure for programming VTR clips.

**Note**

VTR clips are saved in memory only upon exit of the **VTR Clips Menu**, but you can also store them to disk.
The new name now appears in the status area and adjacent to the highlighted **Clip** (in the right-hand column).

5. Press **Cut Index** to select the ID of the clip.

**Note**

Digicart cuts are identified by a *drive, directory and cut* — rather than by a timecode.

- Use the **Drive** knob to select the desired drive on the Digicart.
- Use the **Directory** knob to select the desired directory within the drive.
- Use the **Cut** knob to select the desired cut within the directory.

The numeric values appear in the **Cut Id** field in the status area as you select them. Once the ID is entered, the **Cut Name** and **Cut Time** values will be retrieved from the Digicart.

6. Press **Play** and **Stop** as desired to play the clip without using **Custom Control** buttons.

7. Repeat steps 3 through 5 for any additional Audio Server clips that you wish to program.

In addition to programming new clips, remember that these steps can also be used to edit existing clip registers.

**Note**

Audio Server clips are saved in memory *only* upon exit of the **VTR Clips Menu**, but you can also store them to disk.

This completes the procedure for programming Audio Server clips.
Programming Video Server Clips

Use the following procedure to program Video Server clips:

1. Ensure that your Video Server communication has been properly set up. If not, refer to the chapter, “Basic Communications Setup”, in the Synergy Q/MD or Q/MD-X Engineering Manual for instructions.

2. Navigate to the VTR Clips Menu 1-2 as follows:
   • Press HOME ⇒ MORE ⇒ Clips ⇒ VTR Clips.

3. Press Clip Type.
   • Use the Clip knob to select the clip register that you want to program (00 through 99).
   • Use the Device knob to select a Video Server.
   The remote control port of the Video Server appears in parentheses. Once the device is selected, the VTR Clips Menu changes to show softkey labels, status fields and timeline that are specific to programming “Video Server” Clips only.

4. Press Name Clip to give the Video Server Clip a name.
   The new name will appear in your list of clip registers, in the display of the Global Memory System Group, and on the Remote Control Menu.
   • Use the Horizontal and Vertical knobs plus the editing softkeys to enter the desired name. A Standard PS/2 keyboard can be used to perform the same actions as pressing or rotating the System Control buttons and knobs.
   • Press Accept New Name to return to VTR Clips Menu 1-2, where the new name now appears in the status area and in the right-hand column.

   Important
   Do not enter a space as the first or last character of a clip name.

   • Press Accept New Name to return to VTR Clips Menu 1-2, where the new name now appears in the status area and in the right-hand column.

5. If you already know the ID of the clip (as previously determined on the server itself) press Enter ID to enter the ID. The Enter Louth ID Menu is displayed.
Enter Louth ID Menu

- Use the **Horizontal** and **Vertical** knobs, plus the editing softkeys, to enter the desired ID.

**Operating Tip**

A Standard PS/2 keyboard can be used to perform the same actions as pressing or rotating the **System Control** buttons and knobs.

- Press **Accept New Name** to return to **VTR Clips Menu 1-2**.

The new ID now appears in the status area and in the right-hand column.

6. If you want to choose the ID from a list that was previously loaded from the Video Server, and that now resides in the switcher memory, press **Choose ID**.

<table>
<thead>
<tr>
<th>VTR Clips Menu 1-2 — Choosing ID from List</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clip: 07</td>
</tr>
<tr>
<td>Device: BNC CBI (R1)</td>
</tr>
<tr>
<td>ID: &quot;A-Show Kids You Care&quot;</td>
</tr>
<tr>
<td>Duration: 00:00:16:25</td>
</tr>
</tbody>
</table>

**Operating Tip**

When you pressed **Choose ID**, the softkey label changed to **Refresh & Choose ID**. If you want to refresh (reload) the clip list on the switcher, press **Refresh & Choose ID**. This function is useful if new clips have recently been loaded on the selected Server.

The right-hand column displays current list of clips loaded onto the switcher from the server. The status area shows the number of clips currently in memory (e.g. Showing 100 of 100 Clips).

- Use the **x1**, **x10** and **x100** knobs to scroll quickly through the list as required.

In the status area, the **ID** and **Duration** fields automatically update as you scroll, and the head frame for each clip will be visible if you have the Server selected on Preset.

The display indicates the progress of the loading operation (e.g., **Loading 24 of 24 Clips**), and when complete, you can use the **x1**, **x10** and **x100** knobs to scroll through the list and choose a clip.

When a clip is loaded, the Timeline status bar indicates that the segment is cued to the top (or **Start**) frame.
7. To **Play** the clip, press **MORE** to display the **VTR Clips Menu 2-2**.

```
VTR Clips Menu 2-2 — Video Server Transport Controls

- Play the Video Server clip as desired, using the available transport controls: **Rewind**, **Back Frame**, **Pause**, **Play**, **Ahead Frame** and **Fast Forward**. As the clip plays, the bar on the timeline changes accordingly.
- If you **Pause** the clip in the middle, you can quickly cue the clip as follows:
  ~ Press **MORE** to display the **VTR Clips Menu 1-2**.
  ~ Press **Cue**.
```

8. If you want to trim the inpoint and outpoint of the clip, navigate to the **Inpoint/Outpoint Menu** as follows:

```
- From the **VTR Clips Menu 1-2**, press **Inpoint Outpoint**.
```

```
Inpoint/Outpoint Menu — Disabled

The **Enabled** softkey allows you to trim the start and end frames, or revert back to the original marks as stored on the Video Server.

If you choose different start and end frames to use on-air, the original points remain unchanged on the Video Server. In this way, you can create sub-clips from a long master Video Server clip — directly on the Synergy Q/MD/X switcher. You can also simply trim a clip to choose more desirable points as required.

- Toggle the **Enabled** softkey to **Yes** in order to trim the start and end frames of the clip. Please continue with step 9.
- Toggle the **Enabled** softkey to **No** in order to revert back to the original timecode marks of the clip. The label "**Inpoint/Outpoint is currently Disabled**" appears in the status area. Any trims that were previously entered while the menu was enabled are safely stored in memory. If at some point you toggle back to **Yes**, the trimmed marks will automatically re-appear.
```
9. Toggle the **Enabled** softkey to **Yes** to display the expanded Inpoint/Outpoint Menu.

![Inpoint/Outpoint Menu — Enabled]

- Toggle the **Edit** softkey to **In** or **Out** to edit (or trim) the inpoint or outpoint of the clip, respectively.

![Operating Tip]

- To grab a timecode for the selected point (**In** or **Out**), press **MORE** to display the **VTR Clips Menu 2-2**. Use the available transport controls to cue the server to the desired frame.

  When the Server is paused on the desired frame, press **MORE** to return to the **Inpoint/Outpoint Menu**, then press **Grab Timecode** to complete the procedure.

  The grabbed value now appears in the **Inpoint** or **Outpoint** field as appropriate.

- To complete the procedure, press **UP ONE** to return to **VTR Clips Menu 1-2**, where the new inpoint and outpoint will be displayed — provided that the **Enabled** softkey is toggled to **Yes**.

10. Repeat steps 3 through 9 for any additional Video Server clip registers that you wish to program. Remember that these steps can also be used to edit existing clip registers.

![Note]

*Video Server clips are saved in memory only upon exit of the VTR Clips Menu, but you can also store them to disk.*

This completes the procedure for programming Video Server clips.

**Running VTR Clips**

Once all VTR, Audio Server and Video Server clip registers have been programmed, the final step is to use the **VTR CLIP** button to recall your clips and run them.

Use the following procedure to use VTR, Video Server and Audio Server clips on-air:

1. Ensure that the clips you want to use are properly set up on the **VTR Clips Menu 1-2**, and that all desired VTR and Video Server clips are “enabled.” Only the enabled VTR and Video Server clips will appear on the **Remote Control Menu**.
2. Ensure that you can monitor the timecode of the VTR or Video Server on the Preview monitor:
   • Select the VTR or Video Server on the Preset Bus (of the Program/Preset MLE).
   • In the Preview Overlay Group, press VTR TC to toggle the “VTR Timecode” overlay On.
3. Select the VTR or Video Server (that you want to cue) on any bus. Select the preview output of that MLE on the Preview Bus to view the VTR or Video Server.
4. Ensure that your “next transition” includes BKGD.
5. In the Global Memory System Group, press VTR CLIP. Using the keypad (in the Global Memory System Group), enter the clip register number (from 00 to 99).

**Operating Tip**
You can have a keypad automatically delegated to clip ID entry. Refer to the section, “Keypad Clip Entry” on page 4–10 for more information.

The display shows the clip register and the clip name (as entered on the VTR Clips Menu), and the Remote Control Menu for VTRs or Video Server clips automatically appears.

- The figure below illustrates a sample Remote Control Menu for VTR clips.

The Remote Control Menu (for VTRs) displays three columns of information plus transport control softkeys.

- **Column 1 (Current Clip)** displays the selected clip name, its Inpoint value plus its current timecode location.
- **Column 2 (Clip to Cue)** displays information for the clip that is selected with the middle knob — from the list in Column 3. The clip name plus its starting timecode value is shown.
- **Column 3 (VTR Clip (00))** displays the list of filtered (enabled) VTR clips, as selected on VTR Clips Menu 1-2.

<table>
<thead>
<tr>
<th>Remote Control Menu 1-2 for VTR Clips</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Device:</strong> UTRI (R1) <strong>Type:</strong> BetaCAM</td>
</tr>
<tr>
<td><strong>Current Clip</strong> Clip: &quot;UTR Clip&quot;  <strong>Clip to Cue</strong> Clip: &quot;UTR Clip&quot;</td>
</tr>
</tbody>
</table>
| Speed: 100%

Note: There is no Remote Control Menu for Audio Server clips. To run an Audio Server clip, select the clip as shown in step 5 below, then run the clip using Custom Control buttons.
• The figure below illustrates a sample Remote Control Menu for Video Server clips.

<table>
<thead>
<tr>
<th>Remote Control Menu 1-2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device: Ross SMS (R1)</td>
</tr>
<tr>
<td>Type: VDCP</td>
</tr>
<tr>
<td>Channel: 1</td>
</tr>
<tr>
<td>Current Clip: &quot;M-A-Intr&quot;</td>
</tr>
<tr>
<td>Clip to Clue: &quot;M-A-Intr&quot;</td>
</tr>
<tr>
<td>Duration: 00:00:19:01</td>
</tr>
<tr>
<td>In/Out: None Set</td>
</tr>
<tr>
<td>Rewind</td>
</tr>
<tr>
<td>Fast Forward</td>
</tr>
</tbody>
</table>

Remote Control Menu 1-2 for Video Server Clips

The Remote Control Menu (for Video Servers) displays three columns of information, the timeline of the clip, plus transport control softkeys.

~ Column 1 (Current Clip) displays the selected clip name, its ID, the clip duration plus the selected inpoint and outpoint. The In/Out Field only appears if the Inpoint/Outpoint Menu was left enabled as the clip was programmed.

~ Column 2 (Clip to Clue) displays information for the clip that is selected with the middle knob — from the list in Column 3. The clip name, ID and duration are shown. Just like column 1, the In/Out Field only appears if the Inpoint/Outpoint Menu was left enabled — otherwise, the label None Set appears.

~ Column 3 (M-A-Intr (00)) displays the list of filtered (enabled) Video Server clips, as selected on VTR Clips Menu 1-2.

6. To play or preview the clip manually from the menu, use the available transport control commands as required: Rewind, Play, Pause, and Fast Forward.

7. To run a VTR clip in slow motion, refer to section “VTR Play Speed Control – Slow Motion” on page 14–15.

8. To cue the current clip, or to cue another clip for playback, rotate the center knob and select a clip from the list, and press Cue Clip. Remember that the list is filtered based on the clips that were enabled on VTR Clips Menu 1-2.

9. To roll the VTR or Video Server manually from the control panel, the following steps are required:
   • Set the Roll VTR Mode to Play.
   • Navigate to the Personality Menu 1-3 as follows:
     ~ Press HOME ⇒ MORE ⇒ Setup ⇒ Personality.
   • Toggle the Roll VTR Mode softkey to Play. In this mode, ROLL VTR button action is momentary.
   • Ensure that the VTR or Server is selected on the PST or KEY bus, then press ROLL VTR. This action immediately plays the device. The transition that brings on the device must be initiated manually with the Fader or automatically using CUT or AUTO TRANS.

10. To roll the VTR or Video Server automatically from the control panel using a transition, the following steps are required:
   • Set the Roll VTR Mode to Arm.
• Navigate to the **Personality Menu 1-3** as follows:
  ~ Press **HOME ⇒ MORE ⇒ Setup ⇒ Personality**.

• Toggle the **Roll VTR Mode** softkey to **Arm**. Here, the **ROLL VTR** button is *latching*, and it remains latched until toggled off manually.

• Press the **ROLL VTR** button to arm the switcher. Then select, as desired, a VTR associated crosspoint for one or more of the two Keys and the **PST** bus, including MLE re-entries. Each bus can only deal with one VTR/Server, so at most three devices can be rolled at the same time.

• When you press **CUT** or **AUTO TRANS** in the transition area of the MLE, the VTRs and/or Servers will roll. The switcher will then start the transition at the end of the largest preroll of all the devices.

**Note**

If the output of the MLE is not used for on-air transitions (except in the Keyer area), do not roll the VTRs or apply the preroll. Arm mode is intended for MLEs that are part of the on-air composition.

Please note the following important points regarding the use of clips on-air:

• The **ROLL VTR** button is not included in memory recall functions.

• The **ROLL VTR** button can be used to roll VTRs and Servers selected on *any* bus on the MLE. Re-entry selections that include a VTR or Video Server are also allowed.

• If you set the **ROLL VTR** to Arm mode and then select a VTR or Video Server directly on the **PGM** bus, the VTR/Server immediately rolls. Once the preroll is complete, the source will be taken to air. In this case, selecting the VTR or Server *once* activates preroll, but pressing the source *twice* bypasses the preroll wait and takes the device to air immediately. The hot-punch **ROLL VTR** in Arm mode works only if the MLE is already on-air.

**Note**

If you take a VTR/Server to air using the **ROLL VTR** button in Arm mode, the device continues to roll until the pause or the stop button is pressed.

If you do not stop the VTR/Server and you take another source on **PGM**, and then retake the rolling VTR/Server, it will come to air only after the preroll time has elapsed again.

• If the **ROLL VTR** button is armed and the fader is used to start the transition, the preroll interval is ignored.

• You can *manually* navigate to the **Remote Control Menu** as follows:
  ~ Press **HOME ⇒ Effects ⇒ Remote Control Select**.
  ~ Use the middle knob to select the desired device.
  ~ Press **Go to Remote Menu**.
VTR Play Speed Control – Slow Motion

When running VTR clips, press **Play Speed** to control the playing speed of the VTR clip, either forward or reverse in slow motion.

### Remote Control Slow Motion Menu

- Use the **VTR Clip** knob to select the VTR clip whose play speed and direction you wish to adjust.
- Use the **Speed** knob to set the direction and rate at which the clip will play.
  
  ~ 200% = fast play speed  
  ~ 100% = normal play speed  
  ~ 0% = tape pause  
  ~ -100% = normal play speed in reverse  
  ~ -200% = fast play speed in reverse  
- Double press **Play Speed** to return to 100% speed.

### Looping a Clip

Looping allows for the seamless repetition of a video clip and is useful for moving backgrounds, spinning logos, or any where that repetitive video is required.

Use the following procedure to enable looping playback for a video clip:

1. Navigate to the **Video Server Remote Control Menu 2-2** as follows:
   
   - Select the crosspoint on any bus that is mapped to the Video Server you wish to control.
   - Press **MORE** to display the **Video Server Remote Control Menu 2-2**.

---

**Video Server Remote Control Menu 2-2 — Looping Enabled**
2. Press **Loop** to toggle clip-looping on and off. You can select between the following:

- **On** — Clips will loop indefinitely when played (until playback is stopped). A looping icon appears next to the clip time code display on the **Remote Control** and **VTR Clips** menus.
- **Off** — Clips will play once and then stop.

**Note**

If you turn looping **Off** while a clip is playing, the clip will finish playing the current iteration and then stop.

3. Cue and play any video clips as needed. Refer to the section “**Running VTR Clips**” on page 14–11 for more information on running clips.

This completes the procedure for enabling looping playback for a video clip.

Your video server may require time to re-cue the clip in order to give seamless looping playback. There is a VDCP Extra Option that allows you to configure how much lead time your video server needs to ensure smooth looping. Refer to the section, “**Setting up the Switcher**”, in the chapter, “**Video Servers (VDCP)**”, of the *Synergy Q/MD or Q/MD-X Engineering Manual* for more information.
Application Notes

The following technical discussion applies to the Leitch ASC series of Video Servers only.

Using Clips and Subclips on the Leitch ASC

A bug exists on the Leitch VR series of servers, and it appears in Leitch software versions 2.70 and earlier. Regarding inpoints and outpoints, the Leitch ASC uses the wrong “zero timecode” to cue clips that are requested from the Synergy Q/MD/X System. Specifically:

- Assuming a master clip named “CLIP”, the Leitch ASC allows the user to construct a subclip of CLIP, with a working name of SUBCLIP. This function is performed on the Leitch itself.

- For this example, SUBCLIP has a starting mark that occurs 5 seconds into CLIP.

- When SUBCLIP is cued from Synergy, and no inpoint or outpoint is marked on the Inpoint/Outpoint Menu, there is no problem with cueing.

- However, when Synergy attempts to cue SUBCLIP with an inpoint of 12 seconds, the clip actually cues with an inpoint of 7 seconds — 12 seconds from the inpoint of the parent clip (CLIP), rather than from the inpoint of the SUBCLIP.

- There are several work-arounds:
  - If you use subclips that have been entered on the Leitch ASC, do not use inpoint/outpoint marking from Synergy.
  - Do not use subclips at all (as programmed on the Leitch ASC). Instead, only use the parent clips, and program subclips using Synergy inpoint/outpoint marking.
  - If you must use subclips from the Leitch ASC, make allowances for the error as described above. Look at the starting mark of the subclip (e.g., 5 seconds), and add that value to the Synergy defined inpoint or outpoint mark.

- As a recommendation, please check your Leitch ASC software version, and verify if the problem as described above occurs. If so, use one of the work-arounds listed in this section.
Squeeze & Tease MD Basic Operation

In This Chapter

This chapter provides information for using the basic features of the Squeeze & Tease MD option. The following topics are discussed in this chapter:

- Working in 3D Space
- Using the Positioner / Joystick
- Menu Structure
- 3D Guidelines
- Flying Keys
- Assigning Multiple Channels to a Flying Key
- Channel Layering and Intersect
- Frontside/Backside Video

Note

Squeeze & Tease MD cannot be used with a 1080p video format at this time.
Squeeze & Tease MD operates by manipulating Keys in 3 dimensional space. This allows you to position Keys in front of or behind other Keys, and make Keys appear larger or smaller than they are, apply environmental effects to the Keys such as lighting, or apply video manipulation effects such as colorization. To apply any of the Squeeze & Tease MD effects to a Key, you must have the FLY KEY button in the MLE Key Group or Downstream Keyer Group on. This tells the switcher to assign some of the Squeeze & Tease MD resources to the selected Keyer. When Squeeze & Tease MD resources are applied to a Keyer, the selected Key type (Self Key, Auto Select, Chroma Key or PST PATT) is said to be Flying. You can fly any type of Key, provided you have the available channels of DVE to assign to the Keyer. Refer to the section “Flying Keys” on page 15–17 for more information on Flying Keys.

When you fly a Key, the video signal for that Key is contained in an image. By positioning or rotating, or applying other linear, environmental, or color effects to the image, you are defining how you want the switcher to display the video signal for that flying Key.

The image can be positioned anywhere in the virtual 3D world; however, it will only be visible on screen if it is within the Visible Area. This allows you to perform transition effects where the image appears to fly in from one side. The image is being taken from a position outside of the Visible Area into the Visible Area.
Working in 3D Space

In order to maximize the features of the Squeeze & Tease MD system, it helps to have a basic understanding of three-dimensional (3D) space. Three axes (X, Y, and Z) are used to define 3D space. The position of an image on each of the three axes determines its location in 3D space.

- **X** — Refers to the horizontal (left-right) position of the image on the screen.
- **Y** — Refers to the vertical (up-down) position of the image on the screen.
- **Z** — Refers to the distance (forwards-backwards) of the image on the screen.

**Image Location in 3D Space**

The center point of the screen is the zero point. Each axis has a positive and negative region.

- Moving an image to the left of the center (or zero) point locates it in **-X space**.
- Moving an image to the right of the center point locates it in **+X space**.
- Moving an image below the center point locates it in **-Y space**.
- Moving an image above the center point locates it in **+Y space**.
- Moving an image closer to you locates it in **-Z space**.
- Moving an image away from you locates it in **+Z space**.

**Position Coordinates**

The 3D space you work with in this system has upper and lower limits. *Position coordinates* are used to define an image location in 3D space and are shown as a unit measurement on the menus. A change in position of **1.000** units is equal to a move of 1 full screen. For example, to move the image 2 screens to the right, adjust the X-Axis value to **2.000**.

Changing the location of an image in 3D space does not affect the size or shape of the image. However, when an image is moved forward, it appears larger on the screen. When located at a greater distance in 3D space, it appears smaller.

Position coordinates can be adjusted using the joystick positioner or the knobs on the menu.

- You can move an image **144.000** full screen widths in either direction on the **X-Axis**.
- You can move an image **144.000** full screen heights in either direction on the **Y-Axis**.
- You can move an image **400.000** full screen widths in either direction on the **Z-Axis**.
You may want to think of the 3D working area as a cube with a defined width (X-Axis), height (Y-Axis), and depth (Z-Axis).

The **Z-Axis** works somewhat differently than the other axes because it is the equivalent of **250** screen widths in each direction. Images can be moved on the Z-Axis until they become so small they disappear from view.

### Screen and Image Location

You can manipulate images in different ways within 3D space to achieve creative results.

When working with images, keep in mind that 3D space extends beyond the visible area of the screen. Images can be positioned and manipulated outside of the viewable area to create some interesting effects.

The **S&T MD Position/Crop Menu 1-2** displays the screen in relation to the 3D world.

When viewing your work on a monitor, you may want to picture the 3D space as a cube with the visible area and the perspective point positioned within it.

The **viewpoint** is the point in space that the image is viewed from.

The **visible area** is the area within 3D space that can be seen from the viewpoint. The following illustration displays how the visible area extends from the viewpoint.
Images can be manipulated outside the visible area to create specific effects. For example, an image can be rotated in such a way that it appears to roll into view from a point outside the screen and roll out of view on the other side.

It is also possible to move an image to a point behind the viewer. For example, you can manipulate an image so that it appears to come towards the viewpoint and keeps going until it passes by the viewer. For this effect, the image will get larger as it moves towards the viewpoint and then disappear.

You can also create a circular motion effect where the image sweeps across the screen in a large arc that appears to continue behind the viewer.

**Perspective**

Since you are viewing 3D images on a two-dimensional surface (the screen), it is important to recognize how depth is perceived. This involves understanding relative size, parallax and viewpoint perspective.

**Relative Size**

When working with the Z-Axis, images that are closer appear larger than images further away. Zooming the image changes the distance between the image and the viewpoint, but does not change the size of the image. Images that are closer will also appear over top of images that are further away.
Parallax Effect

If you are manipulating two images at once, you may notice that the image closer to you appears to be moving faster than the one that is further away. This effect is known as motion parallax. It occurs because images that are closer to you move farther across your field of view than images in the distance.

Although both images are moving at the same rate, the closer image will reach the end of the field of view first, giving the impression that it was moving faster.

Viewpoint and Perspective

Another effect you may notice when you move an image left or right on the X-Axis is that it appears to change its angle of rotation. The image appears to move in a sweeping motion, although its angle of rotation remains unchanged. This is because the viewpoint is not being moved along with the image. Since the image is moving but the viewpoint is not, you are seeing the image from a different angle.

The same effect can be seen when moving an image up or down on the Y-Axis when using a fixed viewpoint. If the image is moved higher in 3D space, you see the image as if you are looking up at it.
Movement and Perspective on the Y-Axis

In Squeeze & Tease MD, you can change the viewpoint to create a different perspective. You can also choose to have the viewpoint repositioned along with the image to eliminate perspective effects.

Image Rotation

Rotation can occur around the X, Y, or Z-Axes. Rotation values are shown as a spin number on the menus.

The pivot point of the rotation (point of rotation) can be set to any point on or off the plane of the image to produce a variety of creative effects. The default pivot point is the center of the image.

A rotation of 1.000 is equal to a 360° rotation (one complete revolution).

- A rotation value of 0.250 is equal to a 90° rotation.
- A rotation value of 0.500 is equal to a 180° rotation.

Rotation can be adjusted from 0.001 to 20.000 in either direction (-20.000 to +20.000), so you can create an effect that involves up to 40 complete rotations. The greater the rotation value (negative or positive), the more times the image will spin around the pivot point.

Note

Changing the position of an image in 3D space does not change the pivot point. The pivot point is relative to the image. For example, if you adjust the pivot point to the top right-hand corner of the image, then move the image, the pivot point will still be at the top right-hand corner of the image.
**X-Axis Rotation**

The image rotates horizontally about the Y-Axis. A positive rotation will spin the image from left to right and a negative rotation will spin it from right to left.

![X-Axis Rotation Diagram](image1)

**Y-Axis Rotation**

The image rotates vertically about the X-Axis. A positive rotation will spin the image from top to bottom and a negative rotation will spin it from bottom to top.

![Y-Axis Rotation Diagram](image2)

**Z-Axis Rotation**

The image rotates about the Z-Axis. A positive rotation will spin the image clockwise and a negative rotation will spin the image counter-clockwise.

![Z-Axis Rotation Diagram](image3)
In the menu, an R is shown in the lower right-hand corner of the image to indicate its orientation.

![Image Orientation](image.png)

**Image Centering**

The **CENTER** button in the **Positioner Area** is used to reset the image to the default values.

- Press the **CENTER** button once to reset the values on the current menu.
- Double-press the **CENTER** button to reset all of the image values.

You can also reset specific parameters (for example, Z location) using the **CENTER** button and the softkeys. Individual centering is discussed at the end of each associated chapter.

**Channel Control Options**

When manipulating images in the **Squeeze & Tease MD** system, you have the option of controlling one video channel or selecting multiple video channels in a single Keyer. Image position and rotation can be controlled for each video channel independently or the channels may be locked and controlled together.

**Single Channel**

This control is used when you want to manipulate one image at a time.

**Multiple Channels**

Select both channels to have two images in a single Keyer and when you want to give the same command to both channels at the same time. Both channels can be selected when using any of the 3D tools such as crop, position, or rotation. If the channels selected have different values, for example, different positions in 3D space, the menu will indicate that the values are different and no position, rotation or cropping coordinates will be displayed. The menu will show the position of both channels in the 3D viewable field.

---

**Note**

As you rotate an image, the relative directions of rotation (the positive and negative rotation) may swap if you switch from one axis to another without centering the image.
Multiple Channel Selection

Selecting multiple channels is particularly useful if you want to move or rotate both Keyframes at the same rate. Each Keyframe will rotate around the pivot point you have selected for that channel.

Conclusion

The rest of this chapter deals with the operation of the **Squeeze & Tease MD** system. Now that you understand the basic concepts of how the system works, the best way to learn how to create specific effects is with some hands-on practice to get a “feel” for the system. Use the positioner to try different image placements and experiment by changing the pivot point and rotation values. In the end, your knowledge of position and rotation coordinates will help you manipulate your images creatively and accurately for repeatable results.

**Note**

Keep in mind that adjusting position, rotation or cropping values will adjust each channel based on its current state.

**Note**

Refer to the section “*Introduction to Keying*” on page 7–2 for a complete description of MLE Keyers and Downstream Keyers. The operational descriptions provided in the remainder of this chapter refer only to the 3D capabilities of Flying Keys.
Using the Positioner / Joystick

The 3-Axis Positioner (also known as the joystick) allows you to manipulate images in 3D space. The movement of the positioner controls the movement of images or objects in 3D space. Some basic movements and their corresponding directions are illustrated below.

- **X-Axis** — Move the Positioner **left or right** to control the horizontal position or rotation of the image.
- **Y-Axis** — Move the Positioner **up and down** to control the vertical position or rotation of the image.
- **Z-Axis** — Twist the top portion of the Positioner **clockwise and counter-clockwise** to control the depth of the image on the screen. Twisting the positioner **clockwise** zooms the image toward you, while twisting it **counter-clockwise** zooms the image away from you. When rotating an image, twist the Positioner **clockwise** to rotate the image clockwise, twist it **counter-clockwise** to rotate the image counter-clockwise.
Menu Structure

This section provides an introduction to the Squeeze & Tease MD menu system. A more detailed description of these menu functions is located in section “Flying Keys” on page 15–17.

There are two possible ways to navigate to the Squeeze & Tease MD Main Menu. One way is through pressing the FLY KEY on the associated MLE KEY Group. The other way is through the Main Menu.

Through the FLY KEY

Navigating to the Squeeze & Tease MD Main Menus using the Fly Key in the MLE FLY Group is the most direct method and will be the method that is most frequently used.

Use the following procedure to navigate to the Squeeze & Tease MD Main Menu 1-2 with the FLY KEY button:

1. Press FLY KEY to display the S&T MD Position/Crop Menu 1-2.

   **Note** You must select a FLY KEY for the MLE that has the Squeeze & Tease MD option installed. If you select an MLE that does not have Squeeze & Tease MD installed, you will receive an error message.

2. Press UP ONE to display the Squeeze & Tease MD Main Menu 1-2.

   **Note** Throughout the remainder of this manual, you will see instructions such as, “Press FLY KEY MORE Advanced Positioning.” In these cases, FLY KEY refers to the physical FLY KEY button and not a softkey.

This completes the procedure for navigating to the Squeeze & Tease MD Main Menu 1-2 with the FLY KEY button.
Through the Main Menu

You can navigate to the **Squeeze & Tease MD Main Menu** through the **Main Menu**. This process will take you to the same menu as the **FLY KEY** method, but is not as direct.

Use the following procedure to navigate to the **Squeeze & Tease MD Main Menu** via the menu system:

1. Press **HOME** to display the **Main Menu 1-2**.

2. Press **Effects** to display the **Effects Menu 1-2**.

3. Press **Squeeze & Tease Setup** to display the **Squeeze & Tease Setup Menu**.

4. Use the top and middle knobs to select the **MLE** and **Key** for the Key you want to fly.

5. Press **Modify** to display the **S&T MD Position/Crop Menu**.

6. Press **UP ONE** to display the **Squeeze & Tease MD Main Menu 1-2**.
This completes the procedure for navigating to the Squeeze & Tease MD Main Menu via the menu system.
The following is a menu tree diagram for the Squeeze & Tease MD option.

Squeeze & Tease MD Main Menu 1
- Position / Crop
- Border
- Sequence
- Management
- Preprocessor
- Lighting

Squeeze & Tease MD Main Menu 2
- WARP

S&T MD Sequence Menu
- Load/Save
- Previous
- Sequence
- Next
- Insert
- Keyframe
- Duration
- Overwrite
- Keyframe

S&T MD Border Menu
- Size
- Style
- Color
- Advanced
- Auto Defaults
- Channel

S&T MD Border Color Menu
- RGB
- HSL
- Edit
- Color 1
- Edit
- Color 2
- Edit
- Color 3
- Default Colors

S&T MD Position/Crop Menu
- Position
- Rotation
- Pivot
- Presets
- Pivot
- Position
- Aspect
- On/Off
- Channel

S&T MD Position/Crop 2
- Crop
- Horizontal
- Verticale
- On/Off
- On/Off
- Transparancy
- Freez
- On/Off
- Advanced
- Positioning
- Channel

S&T MD Advanced Positioning Menu
- Spin
- Viewpoint
- Locate
- Channel

Channel Management Menu
- Channel 1
- On/Off
- Channel 2
- On/Off
- Layering

S&T MD Lighting Menu
- Lighting
- Auto Follow
- Luminance
- Channel
- Setup
- Position
- Presets
- On/Off
- Clipping
- Channel

S&T MD Preprocessor Menu
- Defocus
- Mosaic
- Posterize
- Clonerize
- Strobe
- Channel

S&T MD Preprocessor Menu
- Hold
- Spline
- Delete
- Delete
- Wipe
- Keyframe
- Workspace
- Modifier

S&T MD Lighting Menu
- Channel
3D Guidelines

The Fly Key function allows you to apply 3D DVE effects to all of the Key types, with the ability to control the position and rotation of the Key along all three axes in 3D space.

Note

Ensure that the Squeeze & Tease MD option is installed in the selected MLE. Refer to Chapter 6 “Software Upgrades and Options” in your Synergy Q/MD or Q/MD-X Engineering Manual for instructions on how to verify the status of your installed hardware and software options.

Fly Key Rules

There are a number of important rules that apply to the operation of the FLY KEY. These rules apply to both the MLE Keyers and the Downstream Keyers:

- You can Fly any type of Key.
- You can fly any combination of Keys in an MLE.
- You cannot Fly a MultiDSK Key (MultiDSK option) on any switcher, or Downstream Key (Mix/DSK option) on the half MLE (PGM/PST) in a Half MLE switcher.
- Self Keys, Auto Select Keys and Chroma Keys require 2 DVE channel resources from the same channel card to fly. One channel for the fill and another for the alpha. To use a preset pattern Key without the Fly Key mode, press FLY KEY to disable the mode and display the Preset Pattern Setup Menu.
- If PST PATT is already on and the Fly Key mode is off, pressing PST PATT again will not automatically enable Fly Key. This feature only works when you change to the Preset Pattern mode.
- If FLY KEY is enabled, changing the Key type to Self Key, Auto Select or Chroma Key automatically turns the Fly Key mode off and switches to the selected Keying mode.
- Advanced Picture Frame Borders can only be applied to Preset Pattern Keys.
Flying Keys

Different Key types require a different number of Squeeze & Tease channels to fly. The different Key types and the required number of channels are:

- Self Keys — 2 Squeeze & Tease channels required.
- Auto Select Keys — 2 Squeeze & Tease channels required.
- Chroma Keys — 2 Squeeze & Tease channels required.
- Preset Pattern Keys — 1 Squeeze & Tease channel required.

The S&T MD Position/Crop Menu

The S&T MD Position/Crop Menu is the main menu that is used when flying a Key. When you first press FLY KEY on an MLE with the Squeeze & Tease MD option installed, the S&T MD Position/Crop Menu is displayed.

The Status Area in the top, left-hand corner of the display shows the menu name and the number of Squeeze & Tease channels in use. Below that, the MLE and Keyer in use are displayed. In the Central Status Area, three graphic boxes are provided to assist you in quickly visualizing the Position, Rotation and Point of Rotation for the image:

- The larger Position box shows the entire 3D view in which images are being manipulated. The smaller box, inside the 3D view, shows the actual image (for example, the Key that you are flying).
- The Rotation box shows the 3D orientation of the image in relation to the field of view. As you change the Rotation coordinates, the box shows the rotation of the image.
- The Point of Rotation box shows the Pivot Point around which the image rotates.

These graphic boxes combine to provide a visual status of the image parameters. As you switch between Keyers, the graphics are updated, providing a quick reference when working with multiple images on screen.

Note: When you press PST PATT, the system automatically selects FLY KEY, selects a full screen image by default, and displays the S&T MD Position/Crop Menu.
Assigning Multiple Channels to a Flying Key

Your Synergy Q/MD/X switcher allows you to assign a second video channel to each keyer as long as there are sufficient Squeeze & Tease MD resources available. The two video channels in this combined key can be manipulated separately or together.

Channel Listing

There is a Channel Listing on some of the Squeeze & Tease MD menus that shows the status of the channels for a specific Keyer. It is located in the lower right corner of the status bar.

<table>
<thead>
<tr>
<th>Display</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>When a channel is assigned to the currently selected Keyer, and is the active channel, the channel number is shown as highlighted.</td>
</tr>
<tr>
<td>2</td>
<td>When a channel is assigned to the currently selected Keyer but is not the active channel, the channel number is shown in its normal view.</td>
</tr>
</tbody>
</table>

Assigning Channels to MLE Key Groups

To create an MLE key group, you must assign two channels of video to a single Keyer. Once created, you can choose to work with both channels simultaneously (the two video channels are locked together), or individually. You can only combine two channels when working with Preset Pattern keys.

Use the following procedure to assign two channels to an MLE key group:

1. Select the PST PATT button on the MLE key group.
2. Press FLY KEY in the MLE Keyer Group to assign the first available DVE channel, or channels, to the Keyer and display the channels as in use.

Operating Tip

If you toggle the FLY KEY button Off, the DVE channel that was assigned to the MLE Keyer will be released and available for use.
3. Select a video source for the first channel by pressing a crosspoint button on the MLE Key bus.

4. To assign a second Key to the same Keyer, press and hold the PST PATT Key and press the FLY KEY. The Channel Management Menu 1-2 is displayed.

![Channel Management Menu 1-2]

The middle portion of the menu shows a summary of the Squeeze & Tease MD channels allocated to each Keyer in each MLE of your switcher.

![Channel Management Menu 1-2]

Notice at the bottom left of the menu that Channel 1 is already On. This happens automatically when you press FLY KEY.

5. Toggle the second channel to On by pressing Channel 2. This assigns the second channel to the MLE Key Group. The S&T MD Position/Crop Menu 1-2 is displayed.

![S&T MD Position/Crop Menu 1-2]

Notice that both channels are now displayed at the bottom right of the menu and Channel 2 is selected.

6. Select a different video signal for the second channel by pressing a different crosspoint button on the MLE Key bus. Both channels are now assigned to the Keyer.

The MLE Key bus displays a bright button and a dim button – the bright button indicates the “in use” crosspoint.

This completes the procedure for assigning two channels to an MLE Key Group.

---

Note: The information shown here depends on the number of MLEs in your switcher and the Squeeze & Tease Mode Personality setting. Refer to the section, “Squeeze & Tease Mode”, in the chapter, “Completing Setup”, of the Synergy Q/MD or Q/MD-X Engineering Manual for more information.
### Downstream Keyer Groups (Synergy 2, 3, 4 Q/MD/X only)

**Note**

The Synergy 1 Q/MD switcher does not have full a Downstream Keyer. The MultiDSK option cannot be used to Fly a Key. The Synergy 1.5, 2.5 and 3.5 Q/MD and Q/MD-X switcher cannot perform a Fly Key in the Downstream Keyer. The Mix/DSK option cannot be used to Fly a Key.

Channels are assigned slightly differently in the Downstream Keyer (DSK) Groups because they do not have Key type buttons as part of the group.

**Note**

The Squeeze & Tease MD option must be installed for the PGM/PST MLE in order to be able to assign Downstream Keyer Groups.

Use the following procedure to assign multiple channels to a DSK:

1. Select Key type and crosspoint source in the DSK you want to fly. Refer to the section “Using Downstream Keys” on page 7–50 for more information on setting up a DSK.
2. Press **FLY KEY** in the Downstream Keyer Group to assign the first available DVE channel to the DSK and display the channel as in use.
3. Assign another video signal to the DSK by pressing and holding the source button in the DSK, revealing the corresponding input on the PST bus. The input can be changed by pressing another crosspoint on the PST bus while still holding the source button.
4. To assign a second channel to the DSK, press and hold the source button and press the **FLY KEY** on the DSK.
   - If available, it assigns the other channel, and makes it in use.
   - If the second channel is not available, an error message appears on the menu.
   - If two channels are already assigned, you can unassign the “in use” channel by pressing and holding the DSK crosspoint and pressing the **FLY KEY** on the DSK.

This completes the procedure for assigning multiple channels to a DSK.

### Selecting Channels in an MLE Key Group

Once you have created an MLE key group, you can work with the two video channels simultaneously or individually. You can select which channels you wish to work with from any of the Squeeze & Tease MD menus that have the Channel Listing in the lower right corner of the status bar.

Use the following procedure to select different channels in an MLE key group:

1. Create an MLE key group if you have not already done so. Refer to the section “Assigning Channels to MLE Key Groups” on page 15–18 for instructions on how to do this.
2. From any Squeeze & Tease MD menu with the Channel Listing in the lower right corner of the status bar, toggle which channel is currently active by pressing **Channel**. You can toggle between the following:
   - **Channel 1** — The video in the first MLE key group channel is selected.
• **Channel 2** — The video in the second MLE key group channel is selected.

3. Alternately, double-press the **Channel** softkey to lock the two channels together.

You can now operate on both channels simultaneously.

4. If you wish to unlock the two channels, Press **Channel**. The channels unlock and **Channel 1** is selected.

This completes the procedure for selecting different channels in an MLE key group:
Channel Layering and Intersect

When working with combined channels, use this feature to change the order of the channel layers as well as whether a channel pops to the front as it moves in front of the other channel or intersects with the other channel.

Use the following procedure to adjust the layer of images in the same Keyer:

1. Navigate to the S&T MD Channel Management Menu 1-2 as follows:
   - Press FLY KEY ⇒ UP ONE ⇒ Channel Management.

2. Use the Layering knob to select the layering option that you want to apply.
   - **Auto** — Channel layering is determined by the system based on the Z position, or depth, in 3D space of each channel. This is the default.
   - **Intersecting** — Both channels intersect.
   - **Chan1onTop** — Channel 1 always appears in front of Channel 2.
   - **Chan2onTop** — Channel 2 always appears in front of Channel 1.

**Note**
Using the intersecting option with planes that are almost parallel to each other or with planes that have Aspect applied may not produce the desired effect.
Frontside/Backside Video

Normally, when you rotate a flying key around to expose the back side, the video image shows as a backwards representation of the displayed video signal (as if the backside of the key was transparent). For a different effect, you may wish to have the back side of a flying key display a different image than the front side.

Use the following procedure to adjust the frontside and backside video of a key:

1. Navigate to the S&T MD Channel Management Menu 2-2 as follows:
   - Press FLY KEY ⇒ UP ONE ⇒ Channel Management ⇒ MORE.

   ![S&T MD Channel Management Menu 2-2](image)

   2. Toggle backside video to On as follows:
      - **Channel 1** — Toggles backside video for the flying key (or channel 1 when using combined keys)
      - **Channel 2** — Toggles backside video for channel 2 when using a combined key.

   ![S&T MD Channel Management Menu 2-2 — Backside Video](image)

2. Select a video source for the backside video as follows:
   - Use the **Front** knob to select the crosspoint for the Front side.
   - Use the **Back** knob to select the crosspoint for the Back side.
   - Use the **Auto Flip** knob to automatically flip the backside video when the image is rotated. Refer to the section, “Auto Flip” below.

   ![S&T MD Channel Management Menu 2-2 — Backside Video](image)

   This completes the procedure for displaying separate video on the front and back sides of a flying key.

   **Note**

   Invalid buttons are omitted from the list, so the button numbers may sometimes skip.

   **Operating Tip**

   You can use the buttons on the Key bus to select the crosspoint for the side that is currently visible.
**Auto Flip**

If you rotate an image so that the back is visible, the video appears backwards. The same is true when using a Front and Back video.

Auto Flip is used to automatically flip the image when rotated. When using an image that contains text, this feature ensures that the text appears correctly at all times.

Use the **Auto Flip** knob to select one of the following options:

- **None** — The backside video appears **backwards** when the image is rotated.
- **H Flip** — The video is flipped **horizontally**.
- **V Flip** — The video is flipped **vertically**.
- **H-V Flip** — The video is flipped both **horizontally** and **vertically**.

**Using Frontside/Backside Video with Squeeze & Tease Wipes**

When running a Squeeze & Tease Wipe, any Frontside/Backside and Auto Flip information contained in the wipe itself will not be recognized. In order to run Frontside/Backside and Auto Flip effects with a wipe, the effects will have to be applied to the wipe when it is loaded up.

Use the following procedure to use **Frontside/Backside** and **Auto Flip** features in a Squeeze & Tease Wipe:

1. Load the Squeeze & Tease Wipe.
2. On the **Channel Management Menu 2-2**, toggle the backside video for the desired channels to **On**.
   - Use the **Front** knob to select the front crosspoint.
   - Use the **Back** knob to select the back crosspoint.
   - Use the **Auto Flip** knob to select an Auto Flip option.
3. Run the Squeeze & Tease Wipe.

   The Squeeze & Tease Wipe will use the selected **Frontside/Backside** and **Auto Flip** settings.

   This completes the procedure for using the **Frontside/Backside** and **Auto Flip** features in a Squeeze & Tease Wipe.

**Using Frontside/Backside Video with Sequences**

Crosspoints are not stored in the sequence itself; a sequence can be run on a different key, or with different crosspoints.

Use the following procedure to use **Frontside/Backside** and **Auto Flip** features in a sequence:

1. Load the sequence.
   - On the **Channel Management Menu 2-2**, toggle the backside video for the desired channels to **On**.

   You can make this process easy to repeat in the future by saving these settings in a memory register and then recalling it as needed.

   The Frontside/Backside Video feature cannot be used with background Squeeze & Tease Wipes.
• Use the **Front** knob to select the front crosspoint.
• Use the **Back** knob to select the back crosspoint.
• Use the **Auto Flip** knob to select an Auto Flip option.

2. Run the sequence.

   The sequence will use the selected **Frontside/Backside** and **Auto Flip** settings.

This completes the procedure for using the **Frontside/Backside** and **Auto Flip** features in a sequence.
Position/Crop Functions

In This Chapter

This chapter provides detailed instructions for using the Squeeze & Tease MD Position/Crop functions.

The following topics are discussed in this chapter:

• Image Position
• Image Pivot Location
• Image Rotation
• Image Aspect Ratio
• Image Cropping
• Image Transparency
• Image Freeze
• Individual Centering
Position/Crop Menu

When you press **FLY KEY** the system automatically displays the **S&T MD Position/Crop Menu 1-2**.

<table>
<thead>
<tr>
<th>Position</th>
<th>Rotation</th>
<th>Point of Rotation</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

From the **S&T MD Position/Crop Menus** you can access the following features:

- Image Position
- Image Pivot Location
- Image Rotation
- Image Aspect Ratio
- Image Cropping
- Image Transparency
- Image Freeze

**Note**

You must select a **FLY KEY** for the **MLE** that has the Squeeze & Tease MD option installed. If you select an **MLE** that does not have Squeeze & Tease MD installed, you will receive an error message.

**Operating Tip**

To select any of the other major **Squeeze & Tease MD** functions, press **UP ONE** to access the **Squeeze & Tease MD Main Menu 1-2**.
Image Position

The **Position** softkey allows you to adjust the position of the image in 3D viewing area of the screen. You can use either the top, middle or bottom knobs, or the positioner to adjust the position of the image.

Use the following procedure to adjust the position of an image:

1. Navigate to the **S&T MD Position/Crop Menu 1-2** as follows:
   - Press **FLY KEY**.
2. Press **Position** to display the **Position Menu**.

   ![](S&T MD Position / Crop — Position Menu)

   **S&T MD Position / Crop — Position Menu**

   Use the **knobs** as follows to adjust the position of the image in the 3D viewing space:
   - Use the **X Location** knob to adjust the horizontal position. (Positive values move the image to the right.)
   - Use the **Y Location** knob to adjust the vertical position. (Positive values move the image up.)
   - Use the **Z Location** knob to adjust the distance the image is from the center point. (Positive values move the image away from you.)

Use the **Positioner** as follows to adjust the position of the image in the 3D viewing space:

   - Move the **Positioner** left or right to control the horizontal position of the image on screen.
   - Move the **Positioner** up or down to control the vertical position of the image on screen.
   - Twist the **Positioner** knob clockwise and counter-clockwise to change the distance of the image from the zero point (for example, move it closer or further away from you).

### Operating Tip

Using the positioner allows you to move the image into position more quickly than using the knobs.

### Note

You can **not** change the size of the image. You can only change the **distance** of the image from the zero point.

Refer to the section “**Using the Positioner / Joystick**” on page 15–11 for additional information on the 3-axis positioner.
X-Axis Position

Use either the Positioner or the X Location knob to move the image from side-to-side. The graphics in the Position box assist you by providing a visual representation of the image location.

Notice that as you move the image left and right, the X Location value decreases and increases. This value indicates the relative position of the image in relation to the center of the 3D view. A value of 1.000 or -1.000 is equal to one full screen width right or left, respectively.

Y-Axis Position

Use either the Positioner or the Y Location knob to move the image up or down. The graphics in the Position box assist you by providing a visual representation of the image location.

Notice that as you move the image up and down, the Y Location value increases and decreases. This value indicates the relative position of the image in relation to the center of the 3D view. A value of 1.000 or -1.000 is equal to one full screen width up or down, respectively.

Z-Axis Position

Use either the Positioner or the Z Location knob to move the image towards or away from you. The graphics in the Position box assist you by providing a visual representation of the image location.
Notice that as you move the image towards and away from you, the Z Location value decreases and increases. This value indicates the relative position of the image in relation to the center of the 3D view. A value of 1.000 or -1.000 is equal to one full screen width away from or towards you, respectively.
Image Pivot Location

The Point of Rotation is the point in 3D space where the image is rotated around. Before pressing the Rotation button, ensure your Point of Rotation or Pivot Point is set.

Use the following procedure to adjust the pivot location of an image:

1. Navigate to the S&T MD Position/Crop Menu 1-2 as follows:
   - Press FLY KEY.
2. Press Pivot Presets to display the Pivot Preset Menu. This menu allows you to use one of the preset points (applies to channels only, does not apply to objects).
   OR
   Press Pivot Position to display the Pivot Position Menu. This menu allows you to set the point yourself.

Pivot Presets

Pressing the Pivot Presets displays the Pivot Presets Menu.

Operating Tip

If you have cropped the image, the dotted line in the Point of Rotation area will represent the original size of the image and the solid line the cropped image.

S&T MD Position / Crop — Pivot Presets Menu

The Point of Rotation boxes indicate the current point in 3D space that the image is going to be rotated around. This point is represented by a small circle inside each box. To select a new location for the pivot point, use the Pivot knob to select the pivot location you want to use.

Note

As you scroll through the pivot points, the small circle represented the pivot point changes position.
Pivot Position

Pressing the **Pivot Position** button displays **Pivot Position Menu**.

**Operating Tip**

If you have cropped the image, the dotted line in the Point of Rotation area will represent the original size of the image and the solid line the cropped image.

The **Point of Rotation** boxes indicate the current point in 3D space that the image is going to rotate around. This point is represented by a small circle inside each box. To select a new location for the pivot point, use the **X Location**, **Y Location**, and **Z Location** knobs as follows:

- Use the **X Location** knob to move the pivot along the **X-Axis**.
- Use the **Y Location** knob to move the pivot along the **Y-Axis**.
- Use the **Z Location** knob to move the pivot along the **Z-Axis**.

**Note**

As you scroll through the pivot points, the small circle represented the pivot point changes position.
Image Rotation

Once the **Pivot Point** has been selected, press the **Rotation** softkey to allow for rotation control. Notice that the knob labels change to **Rotation**. Use the **Positioner** or the top, middle, and bottom knobs to adjust the rotation of the image in the X-Axis (horizontally), in the Y-Axis (vertically), and in the Z-Axis, around the **Pivot Point**.

Use the following procedure to adjust the rotation of an image:

1. Navigate to the **S&T MD Position/Crop Menu 1-2** as follows:
   - Press **FLY KEY**.
2. Press **Rotation** to display the **Rotation Menu**.

**Operating Tip**

If you have cropped the image, the dotted line in the Point of Rotation area will represent the original size of the image and the solid line the cropped image.

**Operating Tip**

The **Rotation** box has an “R” in the lower right hand corner of the box. This “R” serves as a visual reference to assist in orienting the image as it is being manipulated.

**X-Axis Rotation**

Move the **Positioner left or right**, or turn the **X Rotation** knob, to rotate the image horizontally around the Y-Axis. The graphics in the **Position** and the **Rotation** box will change to reflect the rotation.

Notice that as you rotate the image back and forth, the **X Rotation** value decreases and increases. This value indicates the relative rotation of the image. A value of 1.000 or -1.000 is equal to one full screen rotation (360º) in either direction.
Y-Axis Rotation

Move the **Positioner up or down** or turn the **Y Rotation** knob to rotate the image vertically around the X-Axis. The graphics in the **Position** and the **Rotation** box will change to reflect the rotation.

Notice that as you rotate the image back and forth, the **Y Rotation** value decreases and increases. This value indicates the relative rotation of the image. A value of 1.000 or -1.000 is equal to one full screen rotation (360°) in either direction.

Z-Axis Rotation

Twist the **Positioner** top knob **clockwise** or **counter-clockwise**, or turn the **Z Rotation** knob to rotate the image around the Z-Axis. The graphics in the **Position** and the **Rotation** box will change to reflect the rotation.

Notice that as you rotate the image back and forth, the **Z Rotation** value decreases and increases. This value indicates the relative rotation of the image. A value of 1.000 or -1.000 is equal to one full screen rotation (360°) in either direction.
Image Aspect Ratio

The Aspect feature enables you to squeeze or stretch an image horizontally and/or vertically. Use the following procedure to adjust the aspect ratio and size of an image:

1. Navigate to the S&T MD Position/Crop Menu 1-2 as follows:
   • Press FLY KEY.
2. Press Aspect to display the Aspect Menu.
3. Toggle the Aspect softkey to turn this feature On or Off.

You can adjust the size of the image by using the top, middle and bottom knobs, or by using the positioner. These adjustments are made as follows:

- **X Aspect** — Turn the X Aspect knob to squeeze or stretch the image horizontally.
- **Y Aspect** — Turn the Y Aspect knob to squeeze or stretch the image vertically.
- **Size** — Turn the Size knob to squeeze or stretch the image in both directions at the same time. The Size function is independent of the X Aspect and Y Aspect. For example, if you set the X Aspect to 2.000, the Y Aspect to 1.000 and the Size to 2.000, the width of the image (X Aspect) will be quadrupled and the height (Y Aspect) will be doubled.

The Aspect box and the Position box dynamically change to show the effect. The Aspect box displays the original edge of the source image and the new aspected edge (dotted line).
Image Cropping

Cropping an image allows you bring the sides of an image in, reducing the viewable area, but not changing the size of the image.

Use the following procedure to adjust the cropping of an image:

1. Navigate to the S&T MD Position/Crop Menu 1-2 as follows:
   - Press FLY KEY.
2. Press MORE (to display the S&T MD Position/Crop Menu 2-2).
3. Press Crop Horizontal to display the Crop Horizontal Menu.
   OR
   Press Crop Vertically to display the Crop Vertically Menu.

   Notice that the Point of Rotation graphic box has been replaced with a graphic box labelled Cropping. This graphic will show how the original image is being cropped. The crop values will range from 0.000, no cropping, to 1.000, full cropping. Full cropping will result in no image being displayed on the screen.

Crop Horizontal

Press the Crop Horizontal button to display the Crop Horizontal Menu. Use the knobs or positioner to adjust the left and right edge of the image as follows:

- **Left Edge** — Use the Left Edge knob, or positioner, to adjust the amount of cropping on the left side of the image.
- **Right Edge** — Use the Right Edge knob, or positioner, to adjust the amount of cropping on the right side of the image.
- **Left & Right Edge** — Use the Left & Right Edge knob, or rotate the positioner, to simultaneously adjust the amount of cropping on the left and right side of the image.
The **Cropping** box and the **Position** box *dynamically* change to show the effect of the cropping. As well, the **Cropping** box displays the original edge of the source image and the cropped edge (dotted line).

**Crop Vertical**

Press the **Crop Vertical** button to display the **Crop Vertical Menu**. Use the knobs or positioner to adjust the upper and lower edge of the image as follows:

- **Upper Edge** — Use the **Upper Edge** knob, or positioner, to adjust the amount of cropping on the top of the image.
- **Lower Edge** — Use the **Lower Edge** knob, or positioner, to adjust the amount of cropping on the bottom side of the image.
- **Upper & Lower Edge** — Use the **Upper & Lower Edge** knob, or rotate the positioner, to simultaneously adjust the amount of cropping on the top and bottom side of the image.

The **Cropping** box and the **Position** box *dynamically* change to show the effect of the cropping. As well, the **Cropping** box displays the original edge of the source image and the cropped edge (dotted line).
Image Transparency

The **Transparency** function allows you to adjust the transparency of the image. You can make the image completely opaque (**0% Transparency**) or completely transparent (**100% Transparency**).

Use the following procedure to adjust the transparency of an image:

1. Navigate to the **S&T MD Position/Crop Menu 1-2** as follows:
   - Press **FLY KEY**.
2. Press **MORE** (to display the **S&T MD Position/Crop Menu 2-2**).
3. Press **Transparency** to display the **Transparency Menu**.

   **Note**
   
   If the effects is not **On** (not yet in use), you must press the softkey again to toggle the effect **On**.

4. Toggle the **Transparency** softkey to turn this feature **On** or **Off**:
   - **Off** — When the Transparency effect is Off, the menu area will be blank and the effect is not applied to the image.
   - **On** — When the Transparency effect is On, the menu area allows you to adjust how the effect is applied to the image.

   **S&T MD Position / Crop — Transparency Menu**

5. Use the **Transparency** knob to adjust the transparency level of the image.

   **Operating Tip**
   
   As you adjust the level of transparency, the graphic in the Transparency area will change to represent the current percentage of transparency.

   - **0.0%** — The image is completely opaque and the graphic in the Transparency area is filled black. At this setting there will be no difference between the original image and image with the Transparency effect applied to it.
   - **100%** — The image is completely transparent and the graphic in the Transparency area is empty. At this setting the image will not be visible on screen.

This completes the procedure for adjusting the Transparency of an image.
Image Freeze

The Freeze effect will pause the video of the current image, creating a temporary still. While the video is frozen, you still have complete control over the image, including position and rotation.

If you are working with two combined channels with one frozen and one not, the Freeze option will appear grayed out (unavailable). Both channels must have the same Freeze state to enable this effect when working with combined channels. The Freeze option is always available when you work with individual channels.

Use the following procedure to freeze a video signal in an image:

1. Navigate to the S&T MD Position/Crop Menu 1-2 as follows:
   - Press FLY KEY.
2. Press MORE (to display the S&T MD Position/Crop Menu 2-2).
3. Toggle the Freeze softkey to turn this feature On or Off:
   - Off — When the Freeze effect is Off, the video for the current image plays normally.
   - On — When the Freeze effect is On, the video for the current image will be frozen. This is applied to the currently selected image (Channel) and Keyer only. All other images active on that Keyer will be unaffected.

Note: The label "— Video Frozen —" is displayed for every image and Keyer that is frozen. If you select an image that is not currently frozen, this label will not appear, even if both images are on the same Keyer.

This completes the procedure for freezing a video image.
Individual Centering

To return a specific Position/Crop parameter to its default setting, press and hold the appropriate softkey and press the CENTER button in the Positioner Group.

- **S&T MD Position/Crop Menu 1-2**
  - ~ F1 + CENTER resets the Position values (X, Y, and Z).
  - ~ F2 + CENTER resets the Rotation values (X, Y, and Z).
  - ~ F3 + CENTER returns the Pivot Preset to Center.
  - ~ F4 + CENTER resets the Pivot Position (X, Y, and Z).
  - ~ F5 + CENTER defaults the Aspect (turns it Off and resets X, Y, and Size).

- **S&T MD Position/Crop Menu 2-2**
  - ~ F1 + CENTER reset the Horizontal Cropping value (Left and Right).
  - ~ F2 + CENTER resets the Vertical Cropping value (Top and Bottom).
  - ~ F3 + CENTER defaults the Transparency (turns it Off and defaults the setting).
  - ~ F4 + CENTER turns the Freeze Off.
Advanced Positioning

In This Chapter

This chapter provides detailed instructions for using Advanced Positioning in Squeeze & Tease. The following topics are discussed in this chapter:

- Advanced Positioning Menu
- Spin
- Viewpoint
- Locate
- Individual Centering
Advanced Positioning Menu

When you press the **FLY KEY** button, the system automatically displays the **S&T MD Position/Crop Menu 1-2**.

Navigate to the **Advanced Positioning Menu** from the **S&T MD Position/Crop Menu 1-2** as follows:

1. Press **MORE** to display the **S&T MD Position/Crop Menu 2-2**.
2. Press **Advanced Positioning** to display the **S&T MD Advanced Positioning Menu**.

From the **S&T MD Advanced Positioning Menu** you can access the following features:

- Spin
- Viewpoint
- Locate
Spin

Use this feature when you want to rotate an image in 3D space relative to the fixed reference frame of the screen (as opposed to a pivot point on the image itself).

Use the following procedure to adjust the spin of an image:

1. Navigate to the S&T MD Advanced Positioning Menu as follows:
   - Press FLY KEY ⇒ MORE ⇒ Advanced Positioning.
2. Press Spin to display the Spin Menu.

   ![Spin Menu Diagram]

3. Use the knobs or the Positioner to rotate the image as follows:

   - **X Spin** — Use the X Spin knob to spin the image around the X-Axis of the screen.
   - **Y Spin** — Use the Y Spin knob to spin the image around the Y-Axis of the screen.
   - **Z Spin** — Use the Z Spin knob to spin the image around the Z-Axis of the screen.

   This completes the procedure for adjusting the spin of an image.

If you are using the Spin feature in a sequence, you must choose Spin as the rotation type for that sequence in the Sequence Menu 2-2. Refer to the section “Introduction to Sequences and Wipes” on page 19–2 for detailed information on working with sequences.
**Viewpoint**

Use this feature to change the perspective or point-of-view of the image on the screen. This feature can be used to create an effect where the image appears to have a different vanishing point on the screen. Refer to the section “Perspective” on page 15–5 for a detailed explanation of viewpoint.

Use the following procedure to adjust the viewpoint of the image:

1. Navigate to the **S&T MD Advanced Positioning Menu** as follows:
   - Press **FLY KEY ⇒ MORE ⇒ Advanced Positioning**.
2. Press **Viewpoint** to display the **Viewpoint Menu**.

3. Use the knobs or the positioner to change the viewpoint as follows:

   ![Viewpoint Menu](image)

   **S&T MD Advanced Positioning — Viewpoint Menu**

   - **X Location** — Use the **X Location** knob to move the viewpoint left or right along the X-Axis.
   - **Y Location** — Use the **Y Location** knob to move the viewpoint up or down along the Y-Axis.
   - **Z Location** — Use the **Z Location** knob to move the viewpoint towards or away from the image, along the Z-Axis.

This completes the procedure for adjusting the viewpoint of an image.
Locate

Use this feature to move the image and the viewpoint together. This feature is used when you want to move the image without changing its appearance or shape. With this feature enabled, the apparent angle of the image is always the same, so there is no change in perspective when the image is moved in 3D space.

Use the following procedure to adjust the location of the image:

1. Navigate to the S&T MD Advanced Positioning Menu as follows:
   - Press FLY KEY ⇒ MORE ⇒ Advanced Positioning.
2. Press Locate to display the Locate Menu.

3. Use the knobs or the positioner to adjust the position of the image as follows:

   - **X Locate** — Use the X Locate knob to move the viewpoint and image right or left along the X-Axis.
   - **Y Locate** — Use the Y Locate knob to move the viewpoint and image up or down along the Y-Axis.

This completes the procedure for adjusting the location of an image.
Individual Centering

To return a specific Advanced Positioning parameter to its default setting, press and hold the appropriate softkey and press the **CENTER** button in the **Positioner Group**.

- **F1 + CENTER** defaults the **Spin** settings (X, Y, and Z).
- **F2 + CENTER** defaults the **Viewpoint** settings (X and Y).
- **F3 + CENTER** defaults the **Locate** settings (X and Y) for channels only, not objects.
In This Chapter

This chapter provides instructions for applying Advanced Picture Frame Borders to Squeeze & Tease Flying Keys.

The following topics are discussed in this chapter:

- Picture Frame Borders Menu
- Border Size
- Border Appearance
- Border Style
- Border Color
- Working with Multiple Channels
- Individual Centering
Picture Frame Borders Menu

When you press **FLY KEY** the system automatically displays the **S&T MD Position/Crop Menu 1-2**.

![S&T MD Position / Crop Menu 1-2](image)

**S&T MD Position / Crop Menu 1-2**

Navigate to the **S&T MD Border Menu** from the **S&T MD Position/Crop Menu 1-2** as follows:

1. Press **UP ONE** to display the **Squeeze & Tease MD Main Menu 1-2**.

![Squeeze & Tease MD Main Menu 1-2](image)

**Squeeze & Tease MD Main Menu 1-2**

2. Press **Border** to display the **S&T MD Border Menu**.

![S&T MD Border Menu](image)

**S&T MD Border Menu**

The status area in the top-left corner displays the menu name, the **MLE** in use and the **Key** in use. You can toggle between channels when working with borders or select both channels. Refer to the section “**Working with Multiple Channels**” on page 18–10 for more detailed instructions.

**Note**
You must select a **FLY KEY** for the **MLE** that has the Squeeze & Tease MD option installed. If you select an **MLE** that does not have Squeeze & Tease MD installed, you will receive an error message.
Border Size

The size of the border turns the border effect on or off and sets the overall size of the border that is applied to the Flying Key. Borders are created from the outside edge of the Flying Key and expand inward.

**Note**  
The size of the border should be set first in order to adjust the appearance of the border.

**Border Size**

Use the following procedure to adjust the border size:

1. Navigate to the S&T MD Border Menu as follows:
   - Press FLY KEY ⇒ UP ONE ⇒ Border.
2. Press Size to display the Size Menu.

![S&T MD Border — Size Menu](image)

**Operating Tip**  
To create the widest possible border, adjust Size to the maximum setting and adjust Softness to the minimum setting.

3. Use the Size knob, or the Positioner, to adjust the size of the border around the flying key.

This completes the procedure for adjusting the border size.

As you adjust the size of the border, it expands inwards from the edge of the Flying Key. The graphic in the Size area of the menu shows the border in relation to the Flying Key. The border is represented by a solid line and the Flying Key is represented by the dashed line.
Border Appearance

The overall appearance of the borders can be adjusted to give different effects. You can adjust the following properties of the Flying Key border:

- Border Softness
- Border Symmetry
- Border Transparency

Border Softness

Border softness values are used to create a soft-edge effect on the inside and outside of the border.

Use the following procedure to adjust the border softness:

1. Navigate to the S&T MD Border Menu as follows:
   - Press FLY KEY ⇒ UP ONE ⇒ Border.
2. Press Size to display the Size Menu.

   S&T MD Border — Softness Menu

3. Use the Softness knob to adjust the softness of the border around the flying key.
   - Negative values of -2.5% or less produce hard edges (no edge softness is visible).
   - At 100% softness, the edges of the border come together to form a point in the center.

   ![Softness Adjustment](Image)

   **Border Softness at 72.0%**
   **Border Softness at 0.0%**

This completes the procedure for adjusting border softness.

The softness is applied to the inner and outer edges of the Flying Key, as well as the border. The amount of softness, and how it is being applied, is shown by the graphic in the Softness area.
Border Symmetry

Symmetry is used to alter the center position of the Flying Key border. As you adjust the symmetry, the relative center of the border expands outward from the true center of the border. The default symmetry of 50.0% sets the relative center to the true center of the border.

Use the following procedure to adjust the border symmetry:

1. Navigate to the S&T MD Border Menu as follows:
   - Press FLY KEY ⇒ UP ONE ⇒ Border.
2. Press Size to display the Size Menu.

    ![Border Symmetry Menu]

3. Use the Symmetry knob to adjust the softness symmetry of the border around the flying key.
   - 0.0% — This will give you a hard inner edge. Adjustments to softness or transparency will be applied almost entirely to the interior edge of the border.
   - 100.0% — This will give you a hard outer edge. Adjustments to softness or transparency will be applied almost entirely to the exterior edge of the border.

This completes the procedure for adjusting border symmetry.

Border Transparency

There are two kinds of transparency that can be applied to the Flying Key border. Edge Transparency allows you to adjust the level of transparency of the outer and inner edges of the border. Interior Transparency allows you to adjust the level of transparency of the center of the border.

Use the following procedure to adjust the border transparency:

1. Navigate to the S&T MD Border Menu as follows:
   - Press FLY KEY ⇒ UP ONE ⇒ Border.
2. Press Advanced to display the Advanced Menu.

    ![Border Transparency Menu]
3. Use the **Edge Trnsp** knob to adjust the transparency of the outer and inner edges of the Flying Key border. As you adjust the Edge Transparency, the outside edges of the border shown on the graphic in the Softness area move downward.

4. Use the **Interior Trnsp** knob to adjust the transparency of the relative center of the Flying Key border. As you adjust the Interior Transparency, the relative center of the border shown on the graphic in the Softness area moves downward. Refer to the section “**Border Symmetry**” on page 18–5 for more information on the difference between the true center and relative center of a Flying Key border.

This completes the procedure for adjusting border transparency.
Border Style

The Style function allows you to change the style of the border that is being applied to the Flying Key. Use the following procedure to adjust the border style:

1. Navigate to the S&T MD Border Menu as follows:
   - Press FLY KEY ⇒ UP ONE ⇒ Border.
2. Press Style to display the Style Menu.
3. Use the Texture knob to select a border texture you want to use.
4. Use the Corners knob to select the type of corner you want to use. You can select between the following:
   - **Diagonal** — Select this option to apply mitered corners to the Flying Key border.
   - **Vertical** — Select this option to apply vertical corners to the Flying Key border.
   - **Horizontal** — Select this option to apply horizontal corners to the Flying Key border.

This completes the procedure for adjusting the border style.

Each style can support up to three colors. The current colors of the border are shown in the middle of the screen. Each style has a default set of color values but these can be modified.

A graphical representation of the corner style is shown on the graphic in the Size area.

**Operating Tip**

- **Diagonal** — Select this option to apply mitered corners to the Flying Key border.
- **Vertical** — Select this option to apply vertical corners to the Flying Key border.
- **Horizontal** — Select this option to apply horizontal corners to the Flying Key border.

Each style can support up to three colors. The current colors of the border are shown in the middle of the screen. Each style has a default set of color values but these can be modified.
Border Color

The Color feature allows you to change the colors used in the border. This feature can be applied to either the active border or all the borders, depending on whether Auto Defaults has been set to On or Off.

Use the following procedure to adjust the border color:

1. Navigate to the S&T MD Border Menu as follows:
   - Press FLY KEY ⇒ UP ONE ⇒ Border.
2. Press Color to display the Color Menu.
3. Press Edit Color 1, Edit Color 2, or Edit Color 3 to display the color information for that color.
4. Press RGB or HSL to select the color adjustment mode.
5. Use the knobs or the Positioner to adjust the color.

This completes the procedure for adjusting border color.

RGB

Press RGB to display and adjust colors using a RGB (Red, Green, Blue) graphic display. The bar graph on the left-hand side of the display shows the level of each color.
Each color that is used in the selected border can be altered using the knobs or the Positioner. The bar to the left of the color wheel shows the relative levels of red, green and blue.

- **Red** — Use the Red knob to adjust the amount of red that is being mixed (0.0% has no intensity and 100.0% has full intensity).
- **Green** — Use the Green knob to adjust the amount of green that is being mixed (0.0% has no intensity and 100.0% has full intensity).
- **Blue** — Use the Blue knob to adjust the amount of blue that is being mixed (0.0% has no intensity and 100.0% has full intensity).

Press the appropriate **Edit Color** softkey to edit each of the border colors. The corresponding graphic will blink to indicate which color you are editing.

**Operating Tip**

Pressing the **Default Color** button will reset the RGB and HSL levels to the default levels. You cannot default the levels if you are controlling multiple Flying Keys with different border styles.

**HSL**

Press **HSL** to display and adjust colors using a HSL (Hue, Saturation, Luminance) graphical display. HSL is the default mode that is displayed on the **S&T MD Border Color Menu**.

- **Luminance** — Use the Luminance knob to change the luminance of the border. The luminance can be adjusted from 0.0% (minimum brightness) to 100.0% (maximum brightness). The bar to the right of the color wheel shows the level of luminance.
- **Saturation** — Use the Saturation knob to change the color saturation of the border. Saturation can be adjusted from 0.0% (monochrome, or no saturation) to 100.0% percent – full color saturation.
- **Hue** — Use the Hue knob to change the color of the border. A full 360 degrees of hue adjustment is provided.

Press the appropriate **Edit Color** softkey to edit each of the border colors. The corresponding graphic will blink to indicate which color you are editing.

**Operating Tip**

Pressing the **Default Color** button will reset the RGB and HSL level to the default levels.
Working with Multiple Channels

You can apply and adjust borders on two channels at the same time. Double-press the Channel softkey to select both channels. The Channels indicator at the top right-hand side of the screen indicates the channel(s) selected. The following table shows how the Border effects behave when working with both channels selected.

<table>
<thead>
<tr>
<th>Border Parameter</th>
<th>Scenario</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size and Softness</td>
<td>All border values are the same for both channels.</td>
<td>The display shows a graphical representation of the border size and softness. The knob values are displayed. The joystick or knobs can be used to create the same sized border with the same softness values for both channels.</td>
</tr>
<tr>
<td></td>
<td>Channel 1 and Channel 2 border values are different.</td>
<td>A message is displayed to indicate the values are different. The border graphic and knob values are not displayed. The joystick or knobs can be used to increase or decrease the border size or softness by an equal percentage. A quick way to give the borders equal size or softness values is to adjust the appropriate value to 100.0% with both channels selected. Then you can adjust the border size or softness to the desired value.</td>
</tr>
<tr>
<td>Softness</td>
<td>All border values are the same for both channels.</td>
<td>The display shows a graphical representation of the border softness. The knob values are displayed. The knobs can be used to adjust the border softness for both channels.</td>
</tr>
<tr>
<td></td>
<td>Channel 1 and Channel 2 border values are different.</td>
<td>A message is displayed to indicate the values are different. The border graphic and knob values are not displayed. The knobs can be used to increase or decrease the border softness by an equal percentage. A quick way to give the borders equal softness values is to adjust the softness to 100.0% with both channels selected. Then you can adjust the softness to the desired value.</td>
</tr>
<tr>
<td>Color</td>
<td>All border values are the same for both channels.</td>
<td>The display shows a graphical representation of the border color. The knob values are displayed. The knobs can be used to adjust the border color for both channels.</td>
</tr>
<tr>
<td></td>
<td>Channel 1 and Channel 2 border values are different.</td>
<td>If both channels have different border colors but the same texture, the following message is displayed: &quot;This will set both channels to the same color?&quot; Press Continue to set both borders to white and black. Press Cancel to exit the Color Menu. If the channels are using different border textures, you can not default the colors. The following message is displayed: &quot;Cannot default the colors when controlling multiple channels having different border textures.&quot;</td>
</tr>
</tbody>
</table>
Individual Centering

To return a specific Border parameter to its default setting, press and hold the appropriate softkey and press the CENTER button in the Positioner Group.

- **F1 + CENTER** defaults the Size settings (Size, Softness, Symmetry).
- **F2 + CENTER** defaults the Style settings (Texture, Corners).

**Note**

If Auto Defaults is toggled to On, the Border Color will also be reset to match the Texture, otherwise the border color will *not* be changed.
Preprocessor Effects

In This Chapter

This chapter provides detailed instructions for applying additional effects to keys in Squeeze & Tease. You can apply any combination of Preprocessor Effects to achieve the look you want.

The following topic is discussed in this chapter:

- Working with Preprocessor Effects
Working with Preprocessor Effects

Preprocessor Effects allow you to perform a number of static effects on an image. These effects are applied directly to the image and are not associated with another Squeeze & Tease effects, such as a wipe.

When you press FLY KEY the system automatically displays the S&T MD Position/Crop Menu 1-2.

Navigate to the S&T MD Preprocessor Menu from the S&T MD Position/Crop Menu 1-2 as follows:

1. Press UP ONE to display the Squeeze & Tease MD Main Menu 1-2.

2. Press Preprocessor to display the S&T MD Preprocessor Menu.

Note
You must select a FLY KEY for the MLE that has the Squeeze & Tease MD option installed. If you select an MLE that does not have Squeeze & Tease MD installed, you will receive an error message.

Operating Tip
The MLE and Key you are applying the various Preprocessor effects to, is indicated directly below the menu title.
From the **S&T MD Preprocessor Menu** you can access the following Preprocessor effects:

- Defocus
- Mosaic
- Posterize
- Colorize
- Strobe

**Defocus**

Use this effect to blur the image vertically and horizontally.

**Operating Tip**

You can use any combination of preprocessor effects on an image simultaneously. Also, when you turn an effect off, the settings for that effect are retained so when re-enabled, you do not have to re-enter the effect parameters.

**Note**

If you are using the **Defocus Effect** on an image with an applied WARP effect, the defocus cannot be applied to the WARP alpha channel. This can cause unexpected edge effects when the image is defocused but the alpha channel is not.

Use the following procedure to apply the **Defocus Effect**:

1. Navigate to the **S&T MD Preprocessor Menu** as follows:
   - Press **FLY KEY ⇒ UP ONE ⇒ Preprocessor**.
2. Press **Defocus** to display the **Defocus Menu**.
3. Toggle the **Defocus** softkey to turn this feature **On** or **Off**.
   - **Off** — When the Defocus effect is Off, the menu area will be blank and the effect is not applied to the image.
   - **On** — When the Defocus effect is On, the menu area allows you to adjust how the effect is applied to the image.

**Note**

If the effects is not **On** (not yet in use), you must press the softkey again to toggle the effect **On**.
4. Adjust the amount of Defocus as follows:
   - Use the **Horiz. Defocus** knob to adjust the amount of *horizontal* defocus.
   - Use the **Vert. Defocus** knob to adjust the amount of *vertical* defocus.
   - Use the **Overall** knob to adjust *both* values by an equal percentage.

This completes the procedure for applying the Defocus Effect.

### Mosaic

Use this effect to transform the image into an arrangement of tiles. The size of the horizontal and vertical tiles is indicated in pixels.

Use the following procedure to apply the **Mosaic Effect**:

1. Navigate to the **S&T MD Preprocessor Menu** as follows:
   - Press **FLY KEY ⇒ UP ONE ⇒ Preprocessor**.
2. Press **Mosaic** to display the **Mosaic Menu**.

**Note**

If the effects is not **On** (not yet in use), you must press the softkey again to toggle the effect **On**.

3. Toggle the **Mosaic** softkey to turn this feature **On** or **Off**:
   - **Off** — When the Mosaic effect is Off, the menu area will be blank and the effect is not applied to the image.
   - **On** — When the Mosaic effect is On, the menu area allows you to adjust how the effect is applied to the image.

![S&T MD Preprocessor — Mosaic Menu](image)

4. Adjust the appearance of the Mosaic effect as follows:
   - Use the **Horiz. Tiles** knob to adjust the size of the *horizontal* tiles in pixels.
   - Use the **Vert. Tiles** knob to adjust the size of the *vertical* tiles in pixels.
   - Use the **Overall** knob to adjust *both* values equally.

This completes the procedure for applying the Mosaic Effect.

### Posterize

Use this feature to adjust the luminance and chrominance of the image. As you decrease the values, the color depth of the image will be reduced. The levels of luminance and chrominance adjustment are indicated.
Use the following procedure to apply the **Posterize Effect**:

1. Navigate to the **S&T MD Preprocessor Menu** as follows:
   - Press `FLY KEY` ⇒ `UP ONE` ⇒ `Preprocessor`.
2. Press **Posterize** to display the **Posterize Menu**.

   **Note**  
   If the effects is not **On** (not yet in use), you must press the softkey again to toggle the effect **On**.

3. Toggle the **Posterize** softkey to turn this feature **On** or **Off**:
   - **Off** — When the Posterize effect is Off, the menu area will be blank and the effect is not applied to the image.
   - **On** — When the Posterize effect is On, the menu area allows you to adjust how the effect is applied to the image.

4. Adjust the appearance of the Posterize effect as follows:
   - Use the **Luma** knob to decrease the depth of the *luminance*.
   - Use the **Chroma** knob to decrease the depth of the *chrominance*.
   - Use the **Overall** knob to decrease *both* values equally.

This completes the procedure for applying the Posterize Effect.

---

**Colorize**

Use this feature to replace the color component of the image with a color of your choice. The levels of hue and saturation are indicated. The default color is gray.

Use the following procedure to apply the **Colorize Effect**:

1. Navigate to the **S&T MD Preprocessor Menu** as follows:
   - Press `FLY KEY` ⇒ `UP ONE` ⇒ `Preprocessor`.
2. Press **Colorize** to display the **Colorize Menu**.

   **Note**  
   If the effects is not **On** (not yet in use), you must press the softkey again to toggle the effect **On**.

3. Toggle the **Colorize** softkey to turn this feature **On** or **Off**:
   - **Off** — When the Colorize effect is Off, the menu area will be blank and the effect is not applied to the image.
• **On** — When the Colorize effect is On, the menu area allows you to adjust how the effect is applied to the image.

4. Adjust the appearance of the Colorize effect as follows:

   **Operating Tip**

   The color wheel in the status area indicates the color that is currently selected.

   • Use the **Hue** knob to adjust the hue or color.
   • Use the **Saturation** knob to adjust the saturation of the color. Saturation can be adjusted from 0 – (monochrome or no saturation) to 100 percent – (full color saturation).

This completes the procedure for applying the Colorize Effect.

**Strobe**

Use this feature to alternate between freezing and running live video. You can adjust the number of live and frozen video frames or fields that will be shown.

Use the following procedure to apply the **Strobe Effect**:

1. Navigate to the **S&T MD Preprocessor Menu** as follows:
   • Press **FLY KEY ⇒ UP ONE ⇒ Preprocessor**.
2. Press **Strobe** to display the **Strobe Menu**.

**Note**

If the effects is not **On** (not yet in use), you must press the softkey again to toggle the effect **On**.
3. Toggle the Strobe softkey to turn this feature **On** or **Off**:

   - **Off** — When the Strobe effect is Off, the menu area will be blank and the effect is not applied to the image.
   - **On** — When the Strobe effect is On, the menu area allows you to adjust how the effect is applied to the image.

   ![S&T MD Preprocessor — Strobe Menu](image)

4. Use the Mode knob to select the mode in which the Strobe effect will be applied. You can choose between the following:

   - **Frame** — Select this option to have the entire Frame, both Fields for an interlaced image, of the image frozen.
   - **Field** — Select this option to have a Field of the image frozen.

   **Note**
   
   If you are using a Progressive video format (e.g., 720p), only **Frame** may be selected. Interlaced video formats can apply either a **Frame** or **Field** based strobe.

   - **Frame** — Select this option to have the entire Frame, both Fields for an interlaced image, of the image frozen.
   - **Field** — Select this option to have a Field of the image frozen.

5. Adjust the duration of the Strobe as follows:

   - Use the Live Frames (Live Fields) knob to adjust the number of live Frames or Fields that will be displayed between frozen images.
   - Use the Frozen Frames (Frozen Fields) knob to adjust length of time, in Frames or Fields, that the image is frozen for. This will be the number of Frames or Fields that would have been drawn if the video was running normally.

   This completes the procedure for applying the **Strobe Effect**.
Sequences and Squeeze & Tease Wipes

In This Chapter

This chapter provides detailed instructions for using the Sequences and Squeeze & Tease Wipes features of Squeeze & Tease.

The following topics are discussed in this chapter:

- Introduction to Sequences and Squeeze & Tease Wipes
- Working with Sequences
- Working with Squeeze & Tease MD Wipes
- Storing Sequences and Squeeze & Tease Wipes
- Recalling Sequences and Squeeze & Tease Wipes
Introduction to Sequences and Squeeze & Tease Wipes

Sequences and Squeeze & Tease Wipes are two powerful groups of Squeeze & Tease feature effects that allow you to create a combination of Key effects and wipes. When learning about these features, try using different combinations of Squeeze & Tease effects to produce original and creative sequences and wipes.

Sequences

A Sequence is a series of effects (both single and multi-channel) that can be created, saved, and run directly from your switcher. You can use any of the 3D functions to manipulate the images in a sequence. For example, a sequence might consist of an image or object that rotates across the screen, moves to a specific location in 3D space and acquires a border or any other 3D effect you choose.

Squeeze & Tease Wipes

A Squeeze & Tease Wipe is a transition that brings an image on-air or moves an image off-air.

For your convenience, a set of pre-programmed sequences and Squeeze & Tease Wipes are supplied on the Product Resources CD-ROM (the sequences and Squeeze & Tease Wipes are pre-installed for you when you purchase a new switcher).

To load the sequences onto your switcher, you must copy the Squeeze & Tease Wipes from the CD-ROM to a USB key. Then, you may recall them on your switcher control panel. Refer to the section “Recalling an Entire Set of Sequences” on page 20–41 for more information.

Note

A sequence can only be run on a flying Key.
**Working with Sequences**

This feature is used to create and run a series of image effects. You can use any combination of parameters such as position, cropping, rotation or borders in your sequences.

To make a sequence, you create a series of Keyframes that define the state and location of the image in 3D space. The system interpolates or “fills in” the frames between the Keyframes to produce a fluid motion effect.

The following example shows a simple sequence with four Keyframes:

1. The image starts in the bottom corner.
2. The image moves to the position shown in Keyframe 1.
3. The image rotates and moves to the position in Keyframe 2.
4. The image moves to the position shown in Keyframe 3.
5. The image acquires a border and moves to the position shown in Keyframe 4.

You can set the type of motion for each Keyframe to show how the image should move or transition to the next Keyframe:

- **Smooth motion** — The image accelerates slowly at the start and decelerates slowly at the end of the sequence. The motion between the Keyframes is a straight line.
• **Spline motion** — The image accelerates slowly at the start and decelerates slowly at the end of the sequence. The motion between the Keyframes is a user modifiable spline-curve that smoothly moves the image through each keyframe. Refer to the section “Modifying Spline Motion” on page 20–16 for information on changing spline motion parameters.

• **Linear motion** — The sequence moves from Keyframe to Keyframe at a constant velocity. This produces a step-motion effect.

You can also specify how quickly you want the sequence to move from Keyframe to Keyframe. The sequences you create can contain both single and multi-channel effects and can be saved and recalled for later use.

When you press **FLY KEY** the system automatically displays the **S&T Position/Crop Menu 1-2**.

**Note**

When attempting to run a sequence on a background rather than a key, it will automatically run as a dissolve.

You cannot select **PST Black** or **Trans PV** with sequence mode.

You must select a **FLY KEY** for the **MLE** that has the Squeeze & Tease option installed. If you select an **MLE** that does not have Squeeze & Tease installed, you will receive an error message.

When attempting to run a sequence on a background rather than a key, it will automatically run as a dissolve.

When you press **FLY KEY** the system automatically displays the **S&T Position/Crop Menu 1-2**.
Press **Sequence** to display the **S&T MD Sequence Menu 1-2**.

The **S&T MD Sequence Menu 1-2** represents the workspace where you edit the content and run the sequence. Changes to sequences are not saved until you use the **Load / Save Sequence** function.

The status area in the top, left hand corner displays the menu name, the channel(s) in use, the crosspoint in use, and any object(s) in use.

In the central status area, the sequence timeline is represented for the Keyer selected. The arrow indicates the insertion point in the timeline (when you add a new Keyframe, it is inserted after the arrow). The current Keyframe is highlighted. The timeline is used to organize and control the Keyframes in the sequence. You can insert, overwrite and delete Keyframes from the timeline.

The **S&T MD Sequence Menu 1-2** provides detailed information about the sequence as follows:

- The **Sequence** title area indicates the sequence name. When creating a new sequence, “New Sequence” is set as a default title. Once a sequence has been saved, any changes to the sequence will be indicated by the word “Modified” appearing next to the sequence name. It will disappear the next time you save the sequence.

- The **Sequence Rate** (shown in minutes, seconds, and frames) indicates the programmed duration of the sequence for the selected Key. For example, when you have four Keyframes that each have a duration of 30 frames, the sequence rate is 00:04.00 (4 seconds or 120 frames).
Remember, the sequence rate determines how fast the sequence will play on the switcher when run via the AUTO TRANS button. When you create the sequence, you establish its duration. This is the default sequence rate. If you want the sequence to run at a different rate, you can set a new rate manually. Refer to the section “Running a Sequence” on page 20–22 for detailed instructions.

- **Keyframes** indicates the number of Keyframes in the sequence.
- Use the **Type** knob to select the motion type you want to apply (smooth, linear, spline).
- Use the **Frames** knob to select the duration of the Keyframe in frames.
- Use the **Rotate** knob to select the type of rotation that will be used for this Keyframe. Select Normal if you have defined the rotation using the Rotation feature in the Position / Crop Menu. If you are using the Spin feature on the Advanced Positioning Menu, you must select Spin as the rotation type.
- Use **Load / Save Sequence** to load a sequence from memory, save a sequence to memory, delete a sequence or rename a sequence. Loading a sequence brings it into the workspace for editing. This memory is separate from the switcher memory system and can contain up to 100 sequences.
- Use **Previous Keyframe** to move to the previous Keyframe in the timeline. Double-press this button to move to the first Keyframe in the sequence.
- Use **Next Keyframe** to move to the next Keyframe in the timeline. Double-press this button to move to the last Keyframe in the sequence.
- Use **Insert Keyframe** to insert the current event as a new Keyframe in the timeline. The Keyframe will be inserted after the arrow.
- Use **Duration** to indicate how long it will take to get from the previous Keyframe to the current Keyframe. (The current Keyframe is highlighted in the timeline.) The first Keyframe in a sequence has a duration of 0 frames by default. This means that at the start of the sequence, the image on screen will snap to the first Keyframe. If you want to transition to the first Keyframe, change the duration of the first Keyframe as follows.
  - Press the **Duration** softkey then use the **Frames** knob to adjust the duration of the Keyframe (in frames).

Operating Tip

> When loading a sequence, the current state of the image is dynamically saved so that a smooth move from the initial state to the first keyframe (and vice versa when running in reverse) can be made. Once you set up and save a sequence, you can use it with different images that start in different positions and orientations. If the duration of the first keyframe is set to a non-zero value, the sequence will smoothly move the image from any initial state to the first keyframe. This initial state is not displayed in the sequence edit or runtime menus.

- Use **Overwrite Keyframe** to save changes to a Keyframe.
Press **MORE** to display the **S&T Sequences Menu 2-2**.

**S&T MD Sequence Menu 2-2**

Like the **S&T MD Sequence Menu 1-2** above, the **S&T MD Sequence Menu 2-2** provides additional information about the sequence as follows:

- Use **Delete Keyframe** to delete the selected Keyframe.
- Use **Delete Workspace** to reset the sequence workspace to its default (empty) state. This feature does not delete the sequence itself from stored memory.
- Use **Wipe Modifier** when working with S&T MD wipes. Refer to the section “**Working with Squeeze & Tease MD Wipes**” on page 20–29.
- Use **Modify Keyframes** to access the **Modify Keyframes Menu 1-1**, and apply changes to more than one keyframe in the sequence. Refer to the section “**Modifying Keyframes**” on page 20–13.

**Creating a Sequence**

Sequences are created to move and modify an image in a series of predetermined effects.

Saved Sequences are recalled or run by accessing the **Runtime Menu** (Refer to the section “**Running a Sequence**” on page 20–22).

**Important** If you wish to run a sequence on a combined key, make sure the sequence was created with a combined key. Running a sequence created with a single key on a combined key will only move the first channel of the combined key.

To create sequences, you work primarily with the various **Squeeze & Tease** menus and the **Pattern Control Group** on the control panel. The figure below illustrates the Pattern Control Group on the Synergy 3 control panel.
The following steps explain how to create a simple, four Keyframe sequence. Try experimenting with different effects and Keyframe durations to get a feel for the creative possibilities of the system.

**Sequence Example**

Use the following procedure to create a simple, four Keyframe sequence:

1. Navigate to the **S&T Position/Crop Menu** as follows:
   - Press **FLY KEY**
     - Position.

   **Note** You must select a **FLY KEY** for the **MLE** that has the Squeeze & Tease option installed. If you select an **MLE** that does not have Squeeze & Tease installed, you will receive an error message.
2. In **S&T Position/Crop Menu**, prepare the first Keyframe in the sequence (refer to the section “Position/Crop Menu” on page 16–2 for details) — for example, the following illustration displays an image that has been positioned and rotated in 3D space.

![S&T Position / Crop Menu – Position](image)

3. Press **UP ONE** to display the **Squeeze & Tease WARP Main Menu 1-2**.

![Squeeze & Tease – Keyframe 1](image)

4. Press **Sequence** to display the **S&T MD Sequence Menu 1-2**.
5. Press **Insert Keyframe** to insert the first Keyframe into the sequence.

6. Press **Duration**.

7. Use the **Frames** knob to adjust the duration, in frames, to **30**.

8. Press **Overwrite Keyframe** to save your changes to the duration.

We will now program another Keyframe to continue the sequence. The image will be rotated from Keyframe 1 to the new Keyframe 2.
9. Press **DVE** in the **Positioner Group** to return to the **S&T Position/Crop Menu**.

10. Use the knobs or the Positioner to move and rotate the image to the desired position.

![Diagram of Squeeze & Tease Keyframe 2]

**Squeeze & Tease – Keyframe 2**

11. Press **DVE** to return to the **S&T MD Sequence Menu**.

12. Press **Insert Keyframe** to insert Keyframe 2.

<table>
<thead>
<tr>
<th>S&amp;T MD Sequence (1-2)</th>
<th>Type:</th>
</tr>
</thead>
<tbody>
<tr>
<td>MLE 1 Key 1</td>
<td></td>
</tr>
<tr>
<td>Channel 1: BNC CH1 (CH1)</td>
<td></td>
</tr>
<tr>
<td>New Sequence</td>
<td>Sequence 1 Rate: 00:02:10</td>
</tr>
<tr>
<td>Key 1</td>
<td>Rotate:</td>
</tr>
<tr>
<td>Keyframes: 2</td>
<td>Normal Spin</td>
</tr>
</tbody>
</table>

**S&T MD Sequence Menu 1-2 — Two Keyframe Sequence**

The system fills in the frames between the Keyframes to create the effect.

13. Press **DVE** to return to the **S&T Position/Crop Menu**.

14. Use the knobs or the Positioner to move the image to the desired position.
15. Press DVE to return to the S&T MD Sequence Menu.
17. Press DVE to return to the S&T Position/Crop Menu.
18. Use the knobs or the Positioner to move the image to the desired position.
19. Press UP ONE to display the Squeeze & Tease WARP Main Menu 1-2.
20. Press Border to display the S&T MD Border Menu.
21. Apply a border to the image.

22. Press DVE to return to the Sequence Menu.
24. Press Load / Save Sequence to display the S&T MD Sequence Load/Save Menu.
25. Use the **Sequence** knob to select a sequence position in the list.

26. Press **Save Sequence** to save the sequence in that position.

The default name given to a new sequence is, “New Seq”. For ease of use, you should give each sequence a unique, descriptive name. Refer to the section “**Renaming a Sequence**” on page 20–20 for information on renaming a sequence.

This completes the procedure for creating a simple, four Keyframe sequence.

### Modifying Keyframes

The **Modify Keyframes** function enables the user to edit a Keyframe and apply that change to the entire sequence, current or previous keyframes, or current and subsequent Keyframes.

When modifying keyframes, you can select what type of modification is done between two choices:

- **Absolute** — Changes all parameters to the exact same value for all keyframes specified. For example, Changing the X-location of a key in keyframe to 10 will adjust all X-locations to 10 in the specified range.

- **Relative** — Changes all parameters by the same value, relative to their original values. For example, increasing the X-location of a key by 10 will adjust all keys in the specified range by 10, relative to their original X-locations.

The range of keyframes to modify is configured through the **Modify Keyframes Menu**, which is accessed through the **S&T MD Sequence Menu 2-2**.
Modifying Keyframes in a Sequence

The following steps explain how to modify keyframes in a simple, four Keyframe sequence. Try experimenting with different ranges and modification types to get a feel for the creative possibilities of the function.

When modifying a sequence where multiple channels are assigned in a Keyframe, parameters for each channel are calculated separately. The total number of parameters modified is displayed in the Modify Keyframes Menu until Perform Modify is pressed. Once modified, the value resets to 0. Refer to the section “Assigning Multiple Channels to a Flying Key” on page 15–18 for information on using multiple channels in a keyer.

Note

Lighting parameters cannot be applied across multiple keyframes in a sequence. You must set the lighting parameters for each keyframe.

Use the following procedure to modify the range of keyframes in a sequence using the Modify Keyframe function:

1. Create or load a sequence similar to the four Keyframe sequence you created in the section “Creating a Sequence” on page 20–7.
2. Press Next Keyframe to advance to Keyframe two in the sequence.
3. Navigate to the S&T Position/Crop Menu as follows:
   • Press UP ONE Position/Crop.
4. In the S&T Position/Crop Menu, move the key in Keyframe two to a different position. Refer to the section “Position/Crop Menu” on page 16–2 for details.
5. Press Up One ⇒ Sequence ⇒ More to display the S&T Sequences Menu 2-2.
6. Press Modify Keyframes to display the Modify Keyframes Menu.
7. Press Relative to set the Modify Type to Relative.
8. Verify the Start KF knob displays Keyframe 2.
9. Use the End KF knob to adjust the end keyframe to Keyframe 4.
10. Press **Perform Modify** to apply the changes.

A pop-up displays which reads “**Sequence xxx has been modified. Please remember to go to the S&T MD Sequence Load/Save Menu if you want to make these changes permanent**”.

11. Press **Up One→More→Load/Save Sequence** to display the S&T MD Sequence Load/Save Menu.

12. Use the **Sequence** knob to select a sequence position in the list.

13. Press **Save Sequence** to save the sequence in that position.

**Note**

The sequence number in brackets indicates the position of the sequence in the list. An asterisk (*) beside a list entry indicates that a sequence has been saved to that position.

**Note**

Only the Keyframes in the selected range will be modified. If the selected baseline Keyframe is not in the chosen range, you will have to save changes to that keyframe using the **Overwrite Keyframe** button.

Your sequence will now show changes to Keyframe 2 to 4 with a relative change to the X-location of the key in Keyframe 2.

This completes the procedure to modify the range of keyframes in a sequence using the **Modify Keyframe** function.
Modifying Spline Motion

**Spline** motion differs from **Smooth** and **Linear** motion in that the image does not follow a straight line between keyframes. Rather, the image follows a curving (spline) path that smoothly takes it from keyframe to keyframe. The figure below shows 3 keyframes and two sample paths that an image would take as it moved between them: a spline path and a linear or smooth path.

Notice that the spline path between keyframes is smooth and continuous with no abrupt direction changes. The linear and smooth path is a series of straight lines between keyframes resulting in abrupt directional changes at the keyframes. Getting fluid motion between keyframes requires using spline motion.

The initial spline path between keyframes is determined by the switcher based on where you place your keyframes. You can control this path to a certain extent by modifying three parameters: **Tension**, **Bias**, and **Continuity**.

**Tension** affects how tight or loose the curve is. Lower tension gives a looser, more sweeping curve while tightening the tension brings the curve closer to a straight line. The figure below shows examples of various tension effects on a standard spline path.
Notice how the decreased tension spline follows a more sweeping path between keyframes than the standard spline. The increased tension spline tightens up the curves and, as you can see, makes a more direct path between keyframes.

**Bias** balances how much influence the previous and next keyframes have on the spline through the current keyframe. Increased bias places more importance on the smoothness between the previous and current points, while a decreased bias places more importance on the smoothness between the current and next points. The figure below shows the effect of increased and decreased bias on a standard spline path.

Notice how increasing the bias shifts the bulge of the curve to the right of Keyframe 2 while decreasing the bias shifts the bulge to the left.

**Continuity** affects how smoothly the path passes through the keyframes. The standard spline path moves smoothly through each keyframe but by adjusting the continuity, you can make the path effectively come to a point at a keyframe and then abruptly move away towards the next keyframe. The figure below shows the effects of continuity on a spline path far better than an explanation.
Notice how increasing the continuity causes the path to overshoot the keyframe and then quickly sweep back into it. Then, the path abruptly leaves the keyframe position before returning to a smooth path. Decreasing the continuity causes the path to smoothly sweep into a keyframe and then abruptly change directions towards the next keyframe before resuming a smooth path.

Changing the **Tension**, **Bias**, and **Continuity** allow you to tailor the spline path to suit your needs. Try playing with various combinations of values to see how they affect motion between keyframes.

**Controlling Tension, Bias, and Continuity**

Use the following procedure to change the **Tension**, **Bias**, and **Continuity** of a spline path:

1. Start a new sequence (Refer to the section “Creating a Sequence” on page 20–7 if you need help in creating a sequence).
2. Before inserting a keyframe, use the **Type** knob to change the type to **Spline**.
3. Press **Insert Keyframe** to place the keyframe into the sequence
4. Press **MORE** to display the **S&T MD Sequence Menu 2-2**.
5. Press **Spline Params** to display the Spline Parameters menu.
6. Use the **Tension** knob to change the tension of the spline path at the current keyframe.
7. Use the **Bias** knob to change the bias of the spline path at the current keyframe.
8. Use the **Continuity** knob to change the continuity of the spline path at the current keyframe.
9. Press **UP ONE** to return to the **S&T MD Sequence Menu 1-2**.

This completes the procedure for changing the **Tension**, **Bias**, and **Continuity** of a spline path.

**Adding a Hold to a Sequence**

You can insert a **Hold** at the end of any Keyframe. A **Hold** differs from a Keyframe **Duration** in that it requires manual input to continue by pressing the **AutoTrans** button.

Use the following procedure to add a hold to a sequence:

1. Navigate to the **S&T MD Sequence Menu** as follows:
   - Press **FLY KEY ⇒ UP ONE ⇒ Sequence**.

   **Note**
   You must select a **FLY KEY** for the **MLE** that has the Squeeze & Tease option installed. If you select an **MLE** that does not have Squeeze & Tease installed, you will receive an error message.

2. Program the Keyframe (refer to the section “Position/Crop Menu” on page 16–2 for more information).
3. Double-press **Next Keyframe** to jump to the end of the sequence.

4. Press **MORE** (to display the S&T MD Sequence Menu 2-2).

5. Toggle the **Hold** button to **On**.

![S&T MD Sequence Menu 1-2 — Hold at end of Keyframe](image)

6. Program the next Keyframe.

   An “H” representing the **Hold** is displayed at the end of the Keyframe you just inserted and before the Keyframe you are inserting now.

![S&T MD Sequence Menu 1-2 — Hold Inserted in Two-Keyframe Sequence](image)

7. Continue to program and insert Keyframes.

8. To save the sequence, press **Load / Save Sequence** on the S&T MD Sequence Menu 1-2.

   The **Load / Save Sequence Menu** is displayed.

![S&T Sequence Load / Save Menu](image)

   The sequence number in brackets indicates the position of the sequence in the list. An asterisk (*) beside a list entry indicates that a sequence has been saved to that position.

9. Use the **Sequence** knob to select a sequence position in the list and press **Save Sequence**.
10. The default name given to a new sequence is, “Unused”. For ease of use, you should give each sequence a unique, descriptive name. Refer to the section “Renaming a Sequence” on page 20–20 for information on renaming a sequence.

This completes the procedure for adding a hold to a sequence.

**Running a Sequence with a Hold**

A hold inserted in a sequence requires manual input to continue when the sequence is being run.

Use the following procedure to run a sequence with a hold:

1. Load and run a sequence. Refer to the section “Loading a Sequence” on page 20–21 and section “Running a Sequence” on page 20–22.

When you run the sequence it will stop when it reaches the point where the **Hold** was inserted.

2. Press the flashing **AutoTrans** button to continue running the sequence.

The sequence will continue as saved.

This completes the procedure for running a sequence with a hold.

**Renaming a Sequence**

Use the following procedure to rename any of the available sequences:

1. Navigate to the **S&T MD Sequence Menu** as follows:

   - Press **FLY KEY ⇒ UP ONE ⇒ Sequence**.

   **Note**
   
   You must select a **FLY KEY** for the **MLE** that has the Squeeze & Tease option installed. If you select an **MLE** that does not have Squeeze & Tease installed, you will receive an error message.

2. Press **Load / Save Sequence** to display the **S&T MD Sequence Load/Save Menu**.
3. Use the **Sequence** knob to select the sequence from the list.

4. Press **Rename Sequence** to display the **Sequence Name Menu**. If there is no sequence in the current spot, this menu item will be grayed out.

5. Enter the eight-character sequence name as follows:
   - Use the **Horizontal** knob to move the highlight horizontally.
   - Use the **Vertical** knob to move the highlight vertically.
   - Use the **Space**, **Prev Letter** and **Next Letter** softkeys to enter each letter in the sequence name.

6. When you are finished entering the sequence name, press **Accept New Name**.

The sequence appears in the list on the **Load / Save Menu**.

This completes the procedure for renaming a sequence.

### Loading a Sequence

Use the following procedure to load any of the available sequences from memory:

1. Navigate to the **S&T MD Sequence Menu** as follows:
   - Press **FLY KEY** ⇒ **UP ONE** ⇒ **Sequence**.

2. Press **Load / Save Sequence** to display the **S&T Sequence MD Load/Save Menu**.

3. Use the **Sequence** knob to select the sequence from the list.

4. Press **Load Sequence**.

The sequence appears in the workspace.

This completes the procedure for loading a sequence from memory.
Running a Sequence

With the sequence loaded, press the DISS, WIPE and DVE SEND buttons at the same time to display the Runtime Menu.

Operating Tip

Double-pressing the DISS, WIPE and DVE SEND buttons at the same time displays a list of Sequences for quick access via the Pattern Control Group. Refer to the section “Recalling Sequences Using the Pattern Control Buttons” on page 20–25 for more information.

The black bar on the timeline represents the playhead moving through the sequence.

The Sequence Rate (shown in minutes, seconds, and frames) indicates the programmed duration of the sequence. If the sequence has been manually set to run at a different rate, this field indicates “Sequence Rate (Overwritten)” and the new rate is shown.

Remember, the sequence rate determines how fast the sequence will run on the switcher. When you create the sequence, you establish its duration. This is the default sequence rate. If you want the sequence to run at a different rate, you can set a new rate manually.
Use the following procedure to run the sequence at a different rate:

**Note**
If you want to run a sequence at the default rate, skip to step 4.

1. With the switcher in sequence mode, press the **MLE Rate** button in the **MLE Transition Group**.

   ![MLE Transition Group](image)

   The display shows the current sequence rate for both Keyers.

   Sequence 1 and Sequence 2 can have different values when the sequence rate is set to 1 – the default sequence rate. If you change the rate, both Keyers will use the rate you indicate.

2. Enter the new sequence rate in frames.

   The rate appears on the top line of the display as you type and the **Enter** button lights.

   ![New Sequence Rate Display](image)

3. Press **Enter** to accept the new rate.

   The display shows the new rate.

   ![New Rate Display](image)

**Note**

**Synergy 2 Users:**

On the **PGM/PST** MLE and MLE 1 on the Synergy 2, a display exists above the fader bar. When in sequence mode, this display will show the sequence rate (in frames) for the sequence selected as the next transition. If both Keyers are selected as the next transition and they both have a sequence loaded, the display shows the longer of the two rates.
4. Press the NORM, REV, or FLIP FLOP buttons, in the Pattern Control Group, to indicate the direction of the sequence.

Keep in mind that when the sequence runs forwards, it will smoothly transition from the first keyframe to the initial position. Running in reverse, the sequence will smoothly transition from the first keyframe to the initial position. Running in Flip-Flop mode, a sequence will smoothly transition to and from the initial position to the first keyframe.

5. Use the Pause and Run softkeys to run the sequence.

OR

- Use the Auto Trans button to run the sequence automatically.
- Use the Fader to run the sequence manually.
- Use the Cut button to cut a Key on or off.

Operating Tip

You can use the DISS, WIPE and DVE SEND buttons (press all three at the same time) to toggle between the Sequences Shot Box and the Runtime Menu.

This completes the procedure for running a sequence at a different rate.

Deleting a Sequence

Use the following procedure to delete any of the available sequences from memory:

1. Navigate to the S&T MD Sequence Menu as follows:

   • Press FLY KEY ⇒ UP ONE ⇒ Sequence.

Note

You must select a FLY KEY for the MLE that has the Squeeze & Tease option installed. If you select an MLE that does not have Squeeze & Tease installed, you will receive an error message.

2. Press Load / Save Sequence (to display the S&T MD Sequence Load/Save Menu).

3. Use the Sequence knob to select the sequence from the list.

4. Press Delete Sequence.

5. When prompted with the message:

   "You are about to delete a sequence."

   • Press Cancel to terminate the deletion.

   OR

   • Press Confirm to continue with the deletion.

This completes the procedure for deleting any of the available sequences.
Recalling Sequences Using the Pattern Control Buttons

The sequences you create and save are mapped to buttons in the Pattern Control area.

Use the following procedure to recall a sequence using the buttons in the Pattern Control Group:

1. Double-press either the WIPE/PP1 or the PST/PP2 button (in the Pattern Control Group) to select the Keyer and activate sequence selection.

   The button blinks to indicate you are in Squeeze & Tease sequence selection mode and indicates the Keyer that has control of the Pattern Control Group.

2. Press the corresponding row and column button in the Pattern Control area to select a sequence from the Sequence Shot Box and load it into the selected Key.

   - Press MORE to display the next 40 sequences.

   Important

   You can also load a sequence from the Global Memory System Group.

   - The button currently selected is highlighted in the display and is lit in the Pattern Control area.
This completes the procedure for recalling a sequence using the buttons in the Pattern Control Group.

**Assigning a Sequence to a Different Pattern Selection Button**

You can move your favorite sequences to specific buttons in the Pattern Selection Group of your switcher to make them easier to access. There are two assignable groups of buttons in the Pattern Control Group, the Wipes/Sequence Group and the User Wipes Group.

**Operating Tip**

For ease of use, it is recommended that you assign sequences so that they are grouped together in the Pattern Selection Group. For example, you may want to assign sequences to one half of the Pattern Selection buttons and wipes to the other half.

**Squeeze & Tease MD Wipes/Sequences**

Use the following procedure to assign a sequence to a specific S&T MD Wipe/Sequence button:

1. Navigate to the S&T MD Wipe/Sequence Assignment Menu as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Personality ⇒ 3D Patt Button Assign

2. Use the Button knob to select the button you want to associate with a specific sequence.

3. Use the Sequence knob to select the sequence from the list.

   The button is assigned.

4. If you want to check your work, press the S&T Wipes button.

   The sequence shot box shows the sequence associated with each button position. If you assign the same sequence to more than one button, only the first instance appears highlighted in the shot box.

   The completes the procedure for assigning a sequence to a specific S&T MD Wipe/Sequence button.
**User Wipes**

Use the following procedure to assign a sequence to a specific User Wipe button:

1. Navigate to the User Wipe Menu as follows:
   - Click the Set User button in the Pattern Control Group on your switcher.

2. Use the Button knob to select the USER button you want to assign the wipe or sequence to.

3. Use the Categories knob to select one of the four categories of User Wipes:
   - Classic
   - Rotary

4. Use the Wipe knob to assign a saved wipe to the user button.

5. Press Done to assign the wipe to the user button.

This completes the procedure for assigning a sequence to a specific User Wipe button.

**Sequence Memory Notes**

Please note the following important points regarding saving and loading sequences:

- The switcher enables you to store up to 100 sequences and up to 1600 saved sequence positions. Each sequence can have up to 50 Keyframes.
- When you load a sequence memory from disk, it is recalled to all MLEs on the switcher.

**Previewing a Sequence**

You can review the sequence on your preview monitor before bringing it to air.

Use the following procedure to preview your sequence before you bring it to air:

1. Fly the Key with the sequence loaded and select it in the next Transition area of your switcher.

2. Press the DISS, WIPE and DVE SEND buttons at the same time to display the Runtime Menu.

3. Run the sequence on the preview monitor using the Auto Trans button or the Fader.

4. Bring the Key to air.

This completes the procedure for previewing your sequence before bringing it to air.
Custom Controls and Sequences

When programming a custom control with a sequence, you must insert a **Pause** in the custom macro. Insert the **Pause** after the wipe selection, before pressing the **Auto Trans** button. This ensures that the switcher has sufficient time to load and run the wipe.
Squeeze & Tease Wipes can also be performed with Squeeze & Tease MD. Squeeze & Tease Wipes are used to change the status of a Key (on air or off air) and can be done on Keys or backgrounds. You can use the standard Squeeze & Tease Wipes provided with Squeeze & Tease MD or create your own customized wipe patterns. Customized Squeeze & Tease Wipes can be saved and recalled for later use.

Squeeze & Tease Wipes are built in much the same way as sequences, but with a few additional rules. To create a customized Squeeze & Tease Wipe, it is important that you have read and understood the section discussing sequences. Refer to the section “Working with Sequences” on page 20–3.

To build a Squeeze & Tease Wipe, you should start with a full screen, centered image. This is for creating the Squeeze & Tease Wipe only — when it is actually running, the image will not necessarily be full-screen or centered. What you are building is the pattern of effects that will be applied to the image. You create Keyframes for the effects you want and select a Squeeze & Tease MD Wipe modifier. The Squeeze & Tease MD Wipe modifier determines the method used to bring the image off screen and is one of the following:

- **Knife Edge** — the image rotates so that it is edge-on to the viewer and cannot be seen,
- **Slide Off** — the image moves off screen,
- **Spin Off** — the image turns out of the picture, or
- **None** — a user-specified method such as distance or cropping.

The following example shows a simple background wipe with three Keyframes. In this example:

As with sequences, you can set the type of motion for each Keyframe to indicate how that Keyframe should move to the next Keyframe:

- smooth motion
- spline motion (Refer to the section “Modifying Spline Motion” on page 20–16 for information on modifying spline motion paths)
- linear motion

You may want to experiment with different types of motion when creating your wipe to see which type will work best with the effect you are trying to produce.

You can also specify how quickly you want the image to move from Keyframe to Keyframe.
Creating a Squeeze & Tease Wipe

The process for building a Key Squeeze & Tease Wipe or a background Squeeze & Tease Wipe is the same. To build a Squeeze & Tease Wipe, you create the pattern that the image will follow. When you run the Squeeze & Tease Wipe on a Key, the image follows the shape of the pattern you have created, so it does not matter where the Key is on the screen when you apply the wipe.

The following procedure will show you how to create a simple wipe that starts with a Key in lower right corner of the screen. The Key is then moved to the upper left corner, followed by it sliding off the screen to the right.

**Background Wipe Example**

Use the following procedure to create a simple wipe:

1. Navigate to the **S&T Position/Crop Menu** as follows:
   • Press **FLY KEY ⇒ Position**.
2. In **S&T MD Position / Crop Menu**, prepare the first Keyframe in the sequence (refer to the section “Position/Crop Menu” on page 16–2 for details) — for example, the following illustration displays an image that has been positioned and rotated in 3D space.
3. Press **UP ONE** to display the **Squeeze & Tease WARP Main Menu 1-2**.
4. Press **Sequence** to display the **S&T MD Sequence Menu 1-2**.

**Important**

Squeeze & Tease Wipe motions are relative by default. Images will move a relative amount based on your wipe keyframes so different sized images or images starting in different places will not follow identical paths for the same wipe.
5. Press **Insert Keyframe** to insert the first Keyframe you created into the sequence. The Keyframe appears in the timeline. Adjust any parameters for the Keyframe (duration, for example).

6. Press **DVE** in the **Positioner Control Group** to return to the **S&T Position/Crop Menu**.

7. Use the knobs or the positioner to move the image away from the viewer and into the top left-hand corner of the screen.

8. Press **DVE** to return to the **S&T MD Sequence Menu**.

9. Press **Insert Keyframe**.

   The Keyframe appears in the timeline. Adjust any parameters for the Keyframe (number of frames or type of motion). The system fills in the frames between the Keyframes to create the effect.

10. Press **MORE** to display the **S&T MD Sequence Menu 2-2**.

11. Press **Wipe Modifier** to display the **Wipe Modifier Menu**.

12. Use the **Wipe** knob to select the type of wipe that will be used to move the image off of the screen. The available wipes are as follows:
   
   - **Knife Edge** — This wipe finishes with the image edge-on to the viewer. This wipe cannot be used with 3D objects.
   
   - **Slide Off** — This wipe moves the image directly off the screen. This is done by changing the location of the image on the X-Axis and/or the Y-Axis.
   
   - **Spin Off** — This wipe rotates the image off the screen. The rotation between the second-last Keyframe and the final Keyframe determines the direction and amount of rotation.
• **Dissolve** — This wipe dissolves the image out of view by taking on a transparency of 100%. Use the **Dissolve At** knob to indicate where in the timeline you want the dissolve to begin, for example, set **Dissolve At** to 75% to begin the dissolve 75% of the way through the wipe.

• **None** — This wipe takes the image off the screen using a parameter other than X or Y position or rotation. To use this wipe, select **None**, then create a Keyframe where the image is off the screen. The most common ways to achieve this are as follows:
  ~ Adjusting the Z location so that the image appears to move away from the viewer until it disappears (positive Z location)
  ~ Adjusting the Z location so that the image appears to move toward the viewer until it disappears (negative Z location)
  ~ Cropping the image horizontally, vertically, or both until it appears to disappear from view

**Note**

When you use the **None** modifier, the system does not compensate for the starting position of the image when the wipe is applied. It runs the pattern exactly as it was set up.

Sometimes the image needs to travel further to get off screen than at other times (depending on its starting location). When you use a preset, for example, **Slide Off**, the system creates a virtual “last Keyframe” to put the image where it should be in order to move it off screen.

When you use the **None** modifier, you must set the parameters so that the image will end off screen no matter what its starting position.

13. Use the **Wipe** knob to select **Slide Off** as the type of wipe you want to use. (This is the default wipe).

14. Press **MORE** to display the **S&T MD Sequence Menu 1-2**.

15. Press **Load/Save Sequence** to display the **S&T MD Sequence Load/Save Menu**.

16. Use the **Sequence** knob to select a sequence position in the list.

**Note**

The sequence number in brackets indicates the position of the sequence in the list. An asterisk (*) beside a list entry indicates that a sequence has been saved to that position.

17. Press **Save Sequence**.

The system does not differentiate between sequence memories and Squeeze & Tease Wipe memories. You should give each wipe a unique descriptive name to make it easy to identify from sequences. Refer to the section “**Working with Sequences**” on page 20–3 for information on how to rename, load, recall, or delete memories.

**Operating Tip**

Like sequences, Squeeze & Tease Wipes can contain **Holds** that pause playback until you press the **Auto Trans** button. Refer to the section “**Adding a Hold to a Sequence**” on page 20–18 for information on inserting a **Hold** into your wipe.

This completes the procedure for creating a simple wipe.
Loading a Squeeze & Tease Wipe

Use the following procedure to load any of the available Squeeze & Tease Wipes from memory:

1. Navigate to the S&T MD Sequence Menu as follows:
   • Press FLY KEY ⇒ UP ONE ⇒ Sequence.
2. Press Load / Save Sequence (to display the S&T MD Sequence Load/Save Menu).
3. Use the Sequence knob to select the sequence from the list.
4. Press Load Sequence.

The sequence appears in the workspace.

This completes the procedure for loading a Squeeze & Tease Wipe from memory.

Running a Squeeze & Tease Wipe

When running a Squeeze & Tease Wipe transition, the system dynamically allocates channels to produce the appropriate effect. If there are not enough channels available to complete the Squeeze & Tease Wipe, a dissolve is performed. Once the Squeeze & Tease Wipe is complete, the internally allocated channels are freed for you to use.

Use the following procedure to run a Squeeze & Tease Wipe:

1. With the Squeeze & Tease Wipe loaded, press the WIPE and DVE SEND buttons, both in the Transition Group, at the same time to display the Runtime Menu.

Important

If you run a two channel wipe (if the wipe was created for a combined key, for example) as a background transition, only the first channel will be applied to the background. If it is run on a flying key, the applied channels will be applied, as defined, to the respective channels of a regular or combined key (for example, the first channel will be applied to channel 1 if present in the key and the second channel will be applied to channel 2 if present.

Running the Squeeze & Tease Wipe
The black bar on the timeline represents the playhead moving through the wipe.

**Operating Tip**

You can use the **Wipe** and **DVE Send** buttons (press both at the same time) to toggle between the Sequences Shot Box and the Runtime Menu.

2. Press the **Norm**, **Rev**, or **Flip Flop** buttons, in the Pattern Control Group, to indicate the direction of the Squeeze & Tease Wipe.

3. Use the **Auto Trans** button to run the Squeeze & Tease Wipe automatically, or use the **Fader** to run it manually. Manually, the Squeeze & Tease Wipe always ends at the end of the fader movement (up or down).

   In the last Keyframe, the image will be off screen. At the end of the Squeeze & Tease Wipe, the Key cuts off air.

This completes the procedure for running a Squeeze & Tease Wipe.

You can change the rate at which the Squeeze & Tease Wipe runs. Refer to the section “Running a Sequence” on page 20–22 for more information.

You can Squeeze & Tease Wipe a Key whether the **Fly Key** is on or not so you don’t have to remember to hit **Fly Key** before performing a wipe.

**Note**

Any Squeeze & Tease MD borders that were set when the wipe was created are **not** applied to the flying keys when running a Squeeze & Tease MD wipe.

### Custom Controls and Squeeze & Tease Wipes

When programming a custom control with a Squeeze & Tease Wipe, you must insert a pause in the custom macro. Insert the pause after the wipe selection, before pressing the **Auto Trans** button. This ensures that the switcher has sufficient time to load and run the Squeeze & Tease Wipe.
Storing Sequences and Squeeze & Tease Wipes

For archive purposes, and to keep safe backup copies of your sequences and Squeeze & Tease Wipes, you should store your entire set of sequences and Squeeze & Tease Wipes to the internal hard drive or a USB key.

You can store the entire set of registers or you may store individual sequences, Squeeze & Tease Wipes and memories.

Note: Both sequences and Squeeze & Tease Wipes are stored as sequences in the system.

Store entire registers to disk:

- 3D Sequences — All 3D sequences as one file:
  ~ ST3DSEQ.SYN
- Memories — All memories as one file:
  ~ MEMORYS.SYN

Store individual memories and 3D sequences to disk:

- Memory Register — A specific memory register as an individual file:
  ~ MEM##.SYN
- S&T 3D Sequence — A specific 3D sequence as a single file:
  ~ STSEQ##.SEQ

Storing 3D Sequences

Use the following procedure to store the entire set of 3D sequence registers to disk as one file:

1. If you are using a USB key, plug it into the USB port on the front of the switcher. Wait at least 5 seconds to allow the system to recognize the USB key.

2. Navigate to the Disk Menu as follows:
   - Press HOME ⇒ Disk.

3. Press Dest/Source to display the Dest/Source Menu.
4. Select the storage device that you want to use to store the files as follows:
   • Use the top knob to select the device you want to store the files to. You can select between the following:
     ~ Hard Drive — This option allows you to store the files on the internal hard drive. There are 100 (00 through 99) setups available to store files.
     ~ USB — This option allows you to store the files on a USB key plugged into the switcher panel USB port.
   • If you are saving to the internal hard drive, use the Set Names knob to select a Setup, or location, for the storage of the files.

5. Press Store to display the Disk Store Menu 1-2.

   Note
   Synergy files are designed in a proprietary compressed format that can only be read by a Synergy switcher. However, the files can be copied and saved on a computer.

6. Press MORE to display the Disk Store Menu (2-2).

   ![Disk Store Menu 2-2]

7. Press 3D Sequences.

   Caution
   Do NOT remove a USB key from the switcher before the LED on the USB port goes out. Doing so may destroy the data on your USB key, as well as the data on the next one you insert into the USB port.

All 3D Sequences are stored as ST3DSEQ.SYN.

This completes the procedure for storing the entire set of 3D sequence registers to disk.

Storing Memories

Use the following procedure to store the entire set of memory registers as a single file:

1. If you are using a USB key, plug it into the USB port on the front of the switcher. Wait at least 5 seconds to allow the system to recognize the USB key.

2. Navigate to the Disk Menu as follows:
   • Press HOME ⇒ Disk.

3. Press Dest/Source to display the Dest/Source Menu.
4. Select the storage device that you want to use to store the files as follows:
   • Use the top knob to select the device you want to store the files to. You can select between the following:
     ~ **Hard Drive** — This option allows you to store the files on the internal hard drive. There are 100 (00 through 99) setups available to store files.
     ~ **USB** — This option allows you to store the files on a USB key plugged into the switcher panel USB port.
   • If you are saving to the internal hard drive, use the **Set Names** knob to select a Setup, or location, for the storage of the files.

   **Note**
   Synergy disk files are designed in a proprietary compressed format that can only be read by a Synergy switcher. However, the files can be copied and saved on a computer.

5. Press **Store** to display the **Disk Store Menu 1-2**.

6. Press **Memories**.

   **Caution**
   Do NOT remove a USB key from the switcher before the LED on the USB port goes out. Doing so may destroy the data on your USB key, as well as the data on the next one you insert into the USB port.

   All Memories are stored as **MEMORYS.SYN**.

This completes the procedure for storing the entire set of memory registers to disk.
Storing Individual Memory Registers

Use the following procedure to store individual memory registers as individual files:

1. If you are using a USB key, plug it into the USB port on the front of the switcher. Wait at least 5 seconds to allow the system to recognize the USB key.

2. Navigate to the Disk Menu as follows:
   - Press HOME ⇒ Disk.

3. Press Dest/Source to display the Dest/Source Menu.

4. Select the storage device that you want to use to store the files as follows:
   - Use the top knob to select the device you want to store the files to. You can select between the following:
     - **Hard Drive** — This option allows you to store the files on the internal hard drive. There are 100 (00 through 99) setups available to store files.
     - **USB** — This option allows you to store the files on a USB key plugged into the switcher panel USB port.
   - If you are saving to the internal hard drive, use the Set Names knob to select a Setup, or location, for the storage of the files.

5. Press Store Individual to display the Disk Store Individual Items Menu.

---

*Synergy Q/MD/X Operator’s Manual (v9.1 MD)*
6. Press **Memory Register** to display the **Memory Register Menu**.

- Use the **To disk** knob to select the disk location to save the file to.
- Use the **From switcher** knob to select the memory and accompanying 3D memory you want to save from the switcher.

7. Press **Store Item**.

**Caution**

Do NOT remove a USB key from the switcher before the LED on the USB port goes out. Doing so may destroy the data on your USB key, as well as the data on the next one you insert into the USB port.

Each memory is stored as MEM##.SYN (where ## equals 00-99 or 100 individual memories).

**Note**

Synergy disk files are designed in a proprietary compressed format that can only be read by a Synergy switcher. However, the files can be copied and saved on a computer.

This completes the procedure for storing individual memory registers to disk.

**Storing an Individual S&T 3D Sequence**

Use the following procedure to store a specific 3D sequence as an individual file:

1. If you are using a USB key, plug it into the USB port on the front of the switcher. Wait at least 5 seconds to allow the system to recognize the USB key.

2. Navigate to the **Disk Menu** as follows:

- Press **HOME ⇒ Disk**.

3. Press **Dest/Source** to display the **Dest/Source Menu**.

4. Select the storage device that you want to use to store the files as follows:
• Use the top knob to select the device you want to store the files to. You can select between the following:
  ~ **Hard Drive** — This option allows you to store the files on the internal hard drive. There are 100 (00 through 99) setups available to store files.
  ~ **USB** — This option allows you to store the files on a USB key plugged into the switcher panel USB port.

• If you are saving to the internal hard drive, use the **Set Names** knob to select a **Setup**, or location, for the storage of the files.

---

**Note**

Synergy disk files are designed in a proprietary compressed format that can only be read by a Synergy switcher. However, the files can be copied and saved on a computer.

5. Press **Store Individual** to display the **Disk Store Individual Items Menu**.

6. Press **S&T 3D Sequence** to display the **S&T 3D Menu**.

   **Disk Store Individual Items Menu**
   
   **Disk Store Menu Individual Items Menu** — S&T 3D Sequences

   * Use the **To disk** knob to select the disk location to save the file to.
   * Use the **From switcher** knob to select the memory and accompanying 3D memory you want to save from the switcher.

7. Press **Store Item**.

---

**Caution**

Do NOT remove a USB key from the switcher before the LED on the USB port goes out. Doing so may destroy the data on your USB key, as well as the data on the next one you insert into the USB port.

The individual 3D Sequence is stored as **STSEQ##.SEQ** (where ## equals 00-99).

This completes the procedure for storing a specific 3D sequence to disk.
Recalling Sequences and Squeeze & Tease Wipes

Use the following procedure to recall sequences and Squeeze & Tease Wipes from the switcher hard drive or a USB key. Both sequences and Squeeze & Tease Wipes are stored as sequences in the system. Sequence registers are in the file ST3DSEQ.SYN.

**Important**

If you are going to recall the entire set of sequence registers, ensure that your current on-line set of sequence registers is stored on the switcher hard drive or a USB key. If you have not stored them, they will be overwritten when you recall a new file.

You can recall the entire set of registers or you can recall individual sequences and wipes, as desired.

**Recalling an Entire Set of Sequences**

Use the following procedure to recall an entire set of sequences:

1. If you are using a USB key, plug it into the USB port on the front of the switcher. Wait at least 5 seconds to allow the system to recognize the USB key.

2. Navigate to the Disk Menu as follows:
   - Press HOME ⇒ Disk.

3. Press Dest/Source to display the Dest/Source Menu.

4. Select the storage device that you want to use to store the files as follows:
   - Use the top knob to select the device you want to store the files to. You can select between the following:
     - **Hard Drive** — This option allows you to store the files on the internal hard drive. There are 100 (00 through 99) setups available to store files.
     - **USB** — This option allows you to store the files on a USB key plugged into the switcher panel USB port.
   - If you are recalling from the internal hard drive, use the Set Names knob to select a Setup, or location, for the storage of the files.

5. Press Recall to display the Disk Recall Menu 1-2.

7. Press 3D Sequences.

This completes the procedure for recalling an entire set of sequences from disk.

Recalling an Individual S&T 3D Sequence

Use the following procedure to recall a specific sequence:

1. If you are using a USB key, plug it into the USB port on the front of the switcher. Wait at least 5 seconds to allow the system to recognize the USB key.

2. Navigate to the Disk Menu as follows:
   • Press HOME ⇒ Disk.

3. Press Dest/Source to display the Dest/Source Menu.

4. Select the storage device that you want to use to store the files as follows:
   • Use the top knob to select the device you want to store the files to. You can select between the following:
     ~ Hard Drive — This option allows you to store the files on the internal hard drive. There are 100 (00 through 99) setups available to store files.
     ~ USB — This option allows you to store the files on a USB key plugged into the switcher panel USB port.
   • If you are recalling from the internal hard drive, use the Set Names knob to select a Setup, or location, for the storage of the files.

5. Press Recall Individual to display the Disk Recall Individual Items Menu.
6. Press **S&T 3D Sequence** to display the list of available sequences.
   - Use the **From disk** knob to select the sequence you wish to recall.
   - Use the **To switcher** knob to select the sequence number you want to recall to on the switcher.

7. Press **Recall Item**.

**Note**

When memories are saved to the switcher hard drive or a USB key, they are stored as `MEM##.SYN`, therefore they **cannot** be recalled individually.

This completes the procedure for recalling a specific sequence from disk.
In This Chapter

This chapter provides instructions for adding lighting effects to keys in Squeeze & Tease MD. These lighting effects are based on a model that contains directional light and ambient light.

Directional light emits light in all directions, much like a light bulb. The amount of light on the image decreases with the distance the light is from the image. It can be used to define sharp edges and deepen shadows in your image, to give an appearance of depth. You can adjust the position and intensity of the directional light to vary the appearance of your image.

Ambient light is used to set the lighting level for the entire image. It illuminates the image with a flat, uniform light, like daylight in the real world. The lighting model enables you to control the level of ambient light for different overall effects.

You can set the Luminance Thresholds for the maximum and minimum light levels to fine-tune your lighting.

Lighting parameters can be individually set or a number of presets may be used to quickly create lighting effects.

The following topics are discussed in this chapter:

- Lighting Effects Overview
- Applying Lighting Effects
- Working with Multiple Channels
- Individual Centering
Lighting Effects Overview

When you press **FLY KEY** the system automatically displays the **S&T MD Position/Crop Menu**.

**Note**

You must select a **FLY KEY** for the **MLE** that has the Squeeze & Tease MD option installed. If you select an **MLE** that does not have Squeeze & Tease MD installed, you will receive an error message.

Press **UP ONE** to display the **Squeeze & Tease MD Main Menu 1-2**.

Press **Lighting** to display the **S&T MD Lighting Menu**.

The status area in the top, left-hand corner shows the menu name, the MLE in use and the key in use. The Channel indicator on the bottom, right-hand side of the screen shows the channel(s) in use. You can toggle between channels or select both channels.

- The **Lighting** knob indicates the lighting model in use:
  - Select **None** to turn the lighting model off. If the source is set to **None**, lighting parameters are not enabled.
  - Select **Natural** to enable the lighting model.

The graphics show the position of the directional light for the selected channel(s). The box on the left shows the key in 3D space. The circle represents the position of the light. The box on the right provides a top-down view.

- The **Intensity** knob controls the intensity of the directional light.
- The **Ambient** knob controls overall ambient light on the key. For increased shadows and high contrast, use a low Ambient light level. To give the image a more “flattened” effect, increase the Ambient light level. To rely exclusively on directional light, set the Ambient light to zero.
- **Presets** include predefined directional light positions (for example, Center, Top Right) and Intensity and Ambient-level presets (for example, Dim, Ambient Only).

- **Luminance Clipping** is used to clip the maximum light and minimum light levels of an image. For example, if you set the light to a high intensity, this may produce some washout on screen.

![Luminance Clipping](image)

In this instance, you would clip the maximum light to a lower level. If the image appears too dark, adjust the minimum light level to a higher setting.
Applying Lighting Effects

Lighting parameters can be controlled individually or set via a lighting preset. Presets allow you to quickly and easily apply lighting effects and maintain consistent lighting across multiple keys.

Applying Lighting Presets

The quickest way to create lighting effects is to use one of the included presets. This allows you to use lighting in your production with minimal setup.

Use the following procedure to apply a lighting preset:

1. Navigate to the S&T MD Lighting Presets as follows:
   - Press FLY KEY \( \Rightarrow \) UP ONE \( \Rightarrow \) Lighting \( \Rightarrow \) Presets.

2. Use the Presets knob to select a preset lighting setup. You can select from the following:
   - **Other** — You control the lighting parameters individually to create a custom effect. This is the default setting. Refer to the section “Applying Individual Lighting Parameters” on page 21–5 for information on controlling individual lighting parameters.
   - **Center** — Creates a light source centred directly above the key image. The light fades off towards the bottom of the image.
   - **Top Left** — Creates a light source above and to the left of the key image. The light fades off towards the bottom right corner of the image.
   - **Top Right** — Creates a light source above and to the right of the key image. The light fades off towards the bottom left corner of the image.
   - **Close** — Creates a light source centered above but quite close to the key image. This creates a brighter, washed-out effect.
   - **Dim** — Similar to the Close preset but uses a less-intense light source.
   - **Ambient Only** — lighting is turned off. Only ambient lighting provides illumination of the key image.

3. Toggle the Auto Follow softkey to turn this feature On or Off.
   - **On** — The light source will keep its relative position, based on the center of the Key. This helps to keep the lighting constant when moving an image in a sequence or wipe. This is the default setting.
   - **Off** — The light source keeps its position based on the center of the 3D space. As the image moves, the light will not move. The image appears brighter as it moves closer to the light source and dims as it moves away.

This completes the procedure for applying a lighting preset.
Applying Individual Lighting Parameters

Individual lighting parameters can be applied when you need more control over the lighting environment than the preset selections provide.

You can start by applying a lighting preset and then fine-tune the lighting parameters to create different lighting effects.

Use the following procedure to apply individual lighting parameters:

1. Navigate to the S&T MD Lighting Menu as follows:
   - Press FLY KEY ⇒ UP ONE ⇒ Lighting ⇒ Lighting Setup.

2. Use the Lighting knob to select the type of light source:
   - None — The lighting is turned off.
   - Natural — The lighting model is turned on.

3. Use the Intensity knob to control the brightness of the light source. Increased values produce a brighter light source.

4. Use the Ambient knob to control the non-directional “background” light level of the key image. Increased values produce a brighter overall image.

5. Press Position to display the Position Menu.

When creating a 3D sequence or wipe, use the Ambient Only preset on the first keyframe. This produces no noticeable lighting effect but ensures that the lighting model is activated so any lighting effects later in the sequence flow smoothly.

When running a wipe, set the lighting to None before you run the wipe if you wish to use the lighting effects you applied when you created the wipe. Setting the lighting to Natural will override any lighting effects in the wipe itself.

Operating Tips

When creating a 3D sequence or wipe, use the Ambient Only preset on the first keyframe. This produces no noticeable lighting effect but ensures that the lighting model is activated so any lighting effects later in the sequence flow smoothly.

When running a wipe, set the lighting to None before you run the wipe if you wish to use the lighting effects you applied when you created the wipe. Setting the lighting to Natural will override any lighting effects in the wipe itself.
6. Position the light source to achieve the desired effect as follows:
   • Use the **X Location** knob to adjust the horizontal position of the light source relative to the key image.
   • Use the **Y Location** knob to adjust the vertical position of the light source relative to the key image.
   • Use the **Z Location** knob to adjust the distance of the light source from the key image. You can position the light anywhere in 3D space, including locations in front of or behind the image.

7. Press **Luminance Clipping** to display the **Luminance Clipping Menu**.

8. Adjust the maximum and minimum lighting values as follows:
   • Use the **Min. Light** knob to adjust the minimum luminance threshold.
   • Use the **Max. Light** knob to adjust the maximum luminance threshold.
     (0.0% represents minimum brightness, 100.0% represents maximum brightness).

9. Toggle the **Auto Follow** softkey to turn this feature **On** or **Off**.
   • **On** — The light source will keep its relative position, based on the center of the Key. This helps to keep the lighting constant when moving an image in a sequence or wipe.
   • **Off** — The light source keeps its position based on the centre of the 3D space. As the image moves, the light will *not* move.

This completes the procedure for applying individual lighting parameters.
Working with Multiple Channels

You can apply and adjust lighting effects on two channels at the same time.

Use the following procedure to apply individual lighting parameters:

1. Navigate to the **S&T MD Lighting Menu** as follows:
   - Press **FLY KEY ⇒ UP ONE ⇒ Lighting**.

2. Double-press **Channel** to select both channels.

The following table shows how the Lighting Effects behave when working with both channels.

<table>
<thead>
<tr>
<th>Lighting Parameter</th>
<th>Scenario</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>Coordinates are the same for both channels.</td>
<td>The display shows a graphical representation of the position of the directional light. The knob values are displayed. The joystick or knobs can be used to position the light source for both channels.</td>
</tr>
<tr>
<td>Channel 1 and Channel 2 have different light source positions.</td>
<td>A message is displayed to indicate the values are different. The graphic and knob values are not displayed. The joystick or knobs can be used to change the position coordinates by an equal percentage. A quick way to give both channels the same light source position is to set all of the coordinates to 100.0% with both channels selected. Then you can adjust the position as desired.</td>
<td></td>
</tr>
</tbody>
</table>
### Lighting Effects Behavior Table

<table>
<thead>
<tr>
<th>Lighting Parameter</th>
<th>Scenario</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Intensity and Ambient Light Levels</strong></td>
<td>All values are the same for both channels.</td>
<td>The display shows a graphical representation of the settings. The knob values are displayed. The knobs can be used to adjust the levels for both channels.</td>
</tr>
<tr>
<td></td>
<td><strong>Channel 1 and Channel 2 values are different.</strong></td>
<td>A message is displayed to indicate the values are different. The graphic and knob values are not displayed. The knobs can be used to increase or decrease the settings by an equal percentage. A quick way to give both channels equal values is to adjust both levels to 100.0%. Then you can adjust the values as desired.</td>
</tr>
<tr>
<td><strong>Luminance Clipping</strong></td>
<td>All values are the same for both channels</td>
<td>The knob values are displayed. The knobs can be used to adjust the thresholds for both channels.</td>
</tr>
<tr>
<td></td>
<td><strong>Channel 1 and Channel 2 thresholds are different.</strong></td>
<td>A message is displayed to indicate the values are different. The knob values are not displayed. The knobs can be used to increase or decrease the thresholds by an equal percentage. A quick way to give both channels equal values is to adjust both thresholds to 100.0%. Then you can adjust the values as desired.</td>
</tr>
</tbody>
</table>
Individual Centering

To return a specific Lighting parameter to its default setting, press and hold the appropriate softkey and press the CENTER button in the Positioner Group.

- **F1** + CENTER defaults the Lighting Setup settings (Source, Intensity, Ambient)
- **F2** + CENTER defaults the Position settings (X, Y, and Z)
- **F3** + CENTER defaults the Preset (to Other)
- **F4** + CENTER defaults the Auto Follow (to On)
- **F5** + CENTER defaults the Luminance Clipping settings (Min. Light, Max. Light)
WARP Effects

In This Chapter

Squeeze & Tease MD 3D provides a complete range of WARP effects such as page turn with adjustable curl, ripple, globe, splits, and many more. You can combine WARP with pre-processor effects like defocus or colorization to produce dramatic effects. WARP can be used with stills or live video. In order to use WARP effects, the Squeeze & Tease MD WARP option and WARP card(s) must be installed in your switcher.

This chapter provides detailed instructions for applying WARP effects to keys. The following topics are discussed in this chapter:

- Selecting and Working with WARP Effects

Also, the following WARP effects are discussed in this chapter:

- Film  •  Page Roll
- Globe  •  Pixie Dust
- Heart  •  Ripples
- Lens Flare  •  Sand
- Magnify  •  Split
- Melt  •  Star
- Obscure  •  Stretch

Note

Squeeze & Tease MD WARP cannot be used with a 1080p video format at this time.
Selecting and Working with WARP Effects

The following sections describe each type of WARP and provide specific instructions for adjusting the WARP parameters.

Operating Tip

When using a WARP effect as a wipe, you can apply it to a background or a key.
You can use a WARP effect in a sequence and have the values interpolate between keyframes.

Use the following procedure to select a WARP effect:

1. Press FLY KEY to display the S&T Position/Crop Menu 1-2.
2. Press UP ONE ⇒ MORE to access the Squeeze & Tease WARP Main Menu 2-2.
3. Press WARP to display the S&T WARP Menu.

S&T WARP Menu

The status area in the top, left-hand corner displays the menu name, the MLE in use and the key in use.

4. Use the CATEGORY knob to select a category of WARP effects to choose from (by default, Favorites is the only category available).
5. Use the WARP knob to select the desired WARP effect.
6. Press SELECT to load the WARP.

Operating Tip

Once a WARP is loaded, you can press the WARP button to return to the list and select a new WARP.
When working with an image, each time you select a new type of WARP, the parameters return to their default values.

This completes the procedure for selecting a WARP effect.

WARP Resources

Each WARP card installed in your switcher provides a single WARP resource. Adding additional cards provides more resources. Each MLE of your switcher has access to a maximum of two WARP resources. WARP resources are used when applying WARP effects to three areas corresponding to the background, key 1, and key 2 buses. One WARP resource is required to deliver a WARP effect in any of the three areas and only one WARP resource can be used in each area at a time. There is one notable exception: when a WARP is used as a wipe transition on the background bus and either or both key 1 and key 2, only a single WARP resource is used. This allows you to apply a WARP to a key and use a second WARP as a wipe transition on that key as long as the background is set to transition as well.
The table below illustrates various scenarios and the number of WARP resources required.

<table>
<thead>
<tr>
<th>Scenario</th>
<th>WARP Resources Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applying a WARP Effect to a key</td>
<td>1</td>
</tr>
<tr>
<td>Running a Sequence containing a WARP effect on a key</td>
<td>1</td>
</tr>
<tr>
<td>Running a Squeeze &amp; Tease MD Wipe with a WARP effect on...</td>
<td></td>
</tr>
<tr>
<td>Background Bus</td>
<td>1</td>
</tr>
<tr>
<td>Background Bus + Key 1 Bus</td>
<td>1</td>
</tr>
<tr>
<td>Background Bus + Key 2 Bus</td>
<td>1</td>
</tr>
<tr>
<td>Background Bus + Key 1 and Key 2 Bus</td>
<td>1</td>
</tr>
<tr>
<td>Key 1 Bus</td>
<td>1</td>
</tr>
<tr>
<td>Key 2 Bus</td>
<td>1</td>
</tr>
<tr>
<td>Key 1 + Key 2 Bus</td>
<td>2</td>
</tr>
</tbody>
</table>

**Freeing WARP Resources**

If you try to use a WARP effect when all the WARP resources are in use, a pop-up message will appear on your switcher allowing you to choose how the resource contention is resolved. You have three options:

- **Free WARP 1** — Frees the first WARP resource from whatever effect it was being used for and applies it to the new effect.

- **Free WARP 2** — Frees the second WARP resource from whatever effect it was being used for and applies it to the new effect.

- **Cancel** — Does not free either WARP resource. The new effect is not performed.

If the WARP effect you are trying to apply requires two WARP resources, the pop-up message will only have two options:

- **Confirm** — Both WARP resources are freed from whatever effects they were being used for and are applied to the new effect

- **Cancel** — WARP resources are not freed. The new effect is not performed.

Freeing WARP resources has different effects depending on what the resource was being used for. If the WARP resource was being used as part of a sequence, the sequence is unloaded when the WARP resource is freed. If the resource was being used as a wipe transition, the transition is switched to a dissolve when the WARP resources is freed.

Once sufficient WARP resources have been freed, the new WARP effect is retried unless it is being initiated as a result of one of the following:

- Memory Register Recall
- Key Copy or Swap
- MLE Copy

In these cases, the action proceeds without the associated WARP effect applied.
WARP Effects

This section describes each WARP effect available for use. Each effect has specific settings which you can modify to change the appearance of the effect. Experiment with different setting to see how they affect the appearance of each WARP effect.

Film

This Warp has five parameters that can be adjusted.

- **Film** — Press this button to select from a variety of film presets and to add noise and modify the resolution of the effect.
- **Defects** — Press this button to adjust the type and number of defects to the effect.
- **Light** — Press this button to adjust the lighting of the effect.
- **Color** — Press this button to adjust the color of the effect.
- **Sensitivity** — Press this button to adjust the color and luminance of the effect.

Film Parameters

- Use the **Film Presets** knob to select the effect from the following list:
  - None
  - Late 1800’s
  - 1900’s
  - 1910’s
  - 1920’s
  - Early Color
  - Old Color
  - Pale Color
  - Oversaturated
  - Color Fade
  - Amateur
  - VHS
• Use the **Noise** knob to adjust the amount of noise added to the effect.
• Use the **Resolution** knob to adjust the resolution of the effect.

**Defects Parameters**

- Use the **Line Scratch** knob to modify the number of scratch lines in the effect.
- Use the **Rand. Scratch** knob to modify the number of random scratches in the effect.
- Use the **Film Jump** knob to modify the number of times the film will jump in the effect.

**Light Parameters**

- Use the **Flash** knob to modify the number of times the effect flashes.
- Use the **Intensity** knob to modify the intensity of light on the effect.
- Use the **Radius** knob to modify the radius of the effect.

---

**Important**  The Film warp will only be visible, and its parameters adjustable, after selecting a preset with the **Film Presets** knob.
**Color Parameters**

- Use the **Luminance** knob to modify the luminance of the effect.
- Use the **Saturation** knob to modify the saturation of color on the effect.
- Use the **Hue** knob to modify the hue of the effect.

**Sensitivity Parameters**

- Use the **Red** knob to adjust the amount of red in the effect.
- Use the **Blue** knob to adjust the amount of blue in the effect.
- Use the **Luma Contrast** knob to modify the luminance contrast in the effect.

**Globe**

This WARP has three parameters that can be adjusted.

- **Rotation** — Press this button to adjust the rotation of the effect along either the X or Y-Axis and to create the globe effect.
- **Position** — Press this button to adjust the position of the effect.
- **Movement** — Press this button to adjust the continuous rotation of the effect.
- **Lighting** — Press this button to adjust the lighting of the effect.
- **Light Pos.** — Press this button to adjust the position of the lighting effect.
Rotation Parameters

- Use the **X-Rot** knob to rotate the effect along the X-Axis.
- Use the **Y-Rot** knob to rotate the effect along the Y-Axis.
- Use the **Creation** knob to create the effect. The globe effect must be 100% created before any of the other parameters will function.

Position Parameters

- Use the **X-Position** knob to move the effect along the X-Axis.
- Use the **Y-Position** knob to move the effect along the Y-Axis.

**Note**
The center point of the screen is 50.00%.

- Use the **Z-Position** knob to move the effect around the Z-Axis.
Movement Parameters

- Use the **X-Rate** knob to set the rate of continuous rotation around Y-Axis (horizontal rotation).
- Use the **Y-Rate** knob to set the rate of continuous rotation around the X-Axis (vertical rotation).

**Note**

Values of 0.000 mean no continuous rotation is applied.

Lighting Parameters

- Use the **Highlight** knob to adjust the brightness and visibility of the lighting highlight. Increased values produce a brighter highlight.
- Use the **Shadow** knob to adjust the shadow effect on the globe. Increasing values cause the areas of the globe not lit by the light source to appear darker.
- Use the **Type** knob to select the type of light source:
  - **None** – Light source disabled. Flat lighting is used.
  - **Natural** – Soft, natural-looking light source.
  - **White** – Harsh, white light source.

Lighting Position Parameters

- Values of 0.000 mean no continuous rotation is applied.
• Use the **Gleam Size** knob to adjust the size of the gleam effect produced by the simulated light source.

• Use the **Z Rot.** knob to rotate the simulated light source along the Z-Axis.

• Use the **X-Y Rot.** knob to rotate the simulated light source along the X and Y axes.

**Heart**

This WARP has five parameters that can be adjusted:

- **Position** — Press this button to adjust the position and size of the effect.

- **Rotation** — Press this button to adjust the rotation of the effect along the X, Y, or Z axes.

- **Border** — Press this button to adjust the border size.

- **Border Color** — Press this button to adjust the border luminance, saturation and hue.

- **Movement** — Press this button to adjust the rotation of the effect along the X, Y, or Z axes.

**Position Parameters**

- Use the **X-Pos** knob to position the center point of the heart along the X-Axis.

- Use the **Y-Pos** knob to position the center point of the heart along the Y-Axis.

- Use the **Size/Creation** knob to create and change the size of the heart.
**Rotation Parameters**

- **X-Rotation** knob to adjust the direction and number of rotations along the X-Axis.
- **Y-Rotation** knob to adjust the direction and number of rotations along the Y-Axis.
- **Z-Rotation** knob to adjust the direction and number of rotations along the Z-Axis.

**Border Parameters**

- **Size** knob to adjust the size of the border.

**Border Color Parameters**

- **Luminance** knob to adjust the luminance of the border color.
- **Saturation** knob to adjust the saturation of the border color.
- **Hue** knob to adjust the hue of the border color.
**Movement Parameters**

- Use the **X-Rate** knob to adjust the direction and rate of rotation along the X-Axis.
- Use the **Y-Rate** knob to adjust the direction and rate of rotation along the Y-Axis.
- Use the **Z-Rate** knob to adjust the direction and rate of rotation along the Z-Axis.

**Lens Flare**

This WARP allows you to add a point light source and a series of lens flare effects to the video. The following five parameters can be adjusted:

- **Position** — Press this button to adjust the size and position of the light source and flares.
- **Lighting** — Press this button to adjust washout lighting color, brightness and amount of glare of the light source.
- **Placement** — Press this button to adjust the placement of the lens flares.
- **Color** — Press this button to adjust the luminance, saturation and hue levels.
- **Flare Options** — Press this button to adjust the number of lens flares and to select a lighting source type.
• Use the **Center (X)** knob to adjust the light source position along the X-Axis.
• Use the **Center (Y)** knob to adjust the light source position along the Y-Axis.
• Use the **Size** knob to adjust the flare size.

**Lighting Parameters**

![WARP Menu — Lens Flare, Lighting Parameters](image1)

• Use the **Fade** knob to select the color of the washout lighting.
• Use the **Brightness** knob to adjust the brightness of the light source, flares and washout lighting.

**Placement Parameters**

![WARP Menu — Lens Flare, Placement Parameters](image2)

• Use the **Auto-Follow** knob to toggle between **On** (placement of lens flares is the same angle as the light source) or **Off** (placement of the lens flares is to the center of the light source and flares).
• Use the **Angle** knob to adjust the angle of the lens flares.
• Use the **Distance** knob to adjust the distance between the lens flares and the light source.

**Color Parameters**

![WARP Menu — Lens Flare, Color Parameters](image3)
• Use the **Luminance** knob to adjust the luminance.
• Use the **Saturation** knob to adjust the saturation.
• Use the **Hue** knob to adjust the hue.

**Flare Options Parameters**

<table>
<thead>
<tr>
<th>Flare Options Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use the <strong>Aspect</strong> knob to adjust the aspect ratio of the effect.</td>
</tr>
<tr>
<td>Use the <strong>Flare Type</strong> knob to select the lighting source type from 0 to 9.</td>
</tr>
<tr>
<td>Use the <strong>Flares</strong> knob to adjust the number of lens flares from 0 to 4.</td>
</tr>
</tbody>
</table>

**Magnify**

The Magnify WARP creates an area within which the background video, that the WARP is applied to, is magnified. This WARP can be adjusted for position, shape, borders, and rotation. The following five parameters can be adjusted:

• **Position** — Press this button to adjust the size and position of magnified area.
• **Shape** — Press this button to adjust the shape of the magnified area.
• **Effects** — Press this button to adjust the background, edge effects, and angle of the magnify area.
Position Parameters

- Use the **X-Position** knob to adjust the magnify area position along the X-Axis.
- Use the **Y-Position** knob to adjust the magnify area position along the Y-Axis.
- Use the **Size** knob to adjust the magnify size.

Shape Parameters

- Use the **Shape** knob to select an ellipse or rectangle shape.
- Use the **Aspect Ratio** knob to adjust the aspect ratio of the effect.
- Use the **Magnify** knob to adjust the magnification of the effect.

Effects Parameters

- Use the **Background** knob to select whether the background is visible or not. You can **Hide** or **Show** the background.
- Use the **Edge Effect** knob to turn borders for the lens effect on or off.
- Use the **Angle (deg.)** knob, or the positioner, to adjust the angle of the magnified area.
Melt

This Warp has three parameters that can be adjusted.

- **Melt** — Press this button to adjust the direction and amplitude of the melt.
- **Modulation** — Press this button to adjust the size and number of waves in the melt.
- **Curve** — Press this button to adjust the amount of curve in the melt.

---

**Melt Parameters**

- Use the **Type** knob to select the type of melt: Block Expands, Block Shrinks, Hole Expands, or Hole Shrinks.
- Use the **Direction** knob to indicate the direction of the melt: Up, Down, Right, or Left.
- Use the **Amplitude** knob to adjust the height of the individual waves in the melt effect.

---

**Modulation Parameters**

- Use the **Frequency** knob to adjust the number of melting waves in the effect.
- Use the **Peak** knob to adjust the size of the melting waves.
- Use the **Lateral Dist.** knob to shrink or expand the video, based on the type of melt you have selected.
Curve Parameters

- Use the **Slope** knob to adjust the angle of the curve.

Operating Tip

You can use this parameter to apply a tilt effect.

- Use the **Phase** knob to move the wave across the image.

Obscure

This Warp allows you to obscure a section of video using a mosaic pattern. The following parameters can be adjusted:

- **Pixelation** — Press this button to adjust the size of the mosaic tiles.
- **Position** — Press this button to adjust the position of the obscured video.
- **Shape** — Press this button to adjust the shape of the mosaic tile.
- **Effects** — Press this button to adjust the lighting effects.

Pixelation Parameters
- Use the (X) knob to adjust the tiles along the X-Axis.
- Use the (Y) knob to adjust the tiles along the Y-Axis.
- Use the Overall knob to adjust the tiles as a whole.

**Position Parameters**

<table>
<thead>
<tr>
<th>Position</th>
<th>Overall</th>
</tr>
</thead>
<tbody>
<tr>
<td>(X)</td>
<td>(Y)</td>
</tr>
</tbody>
</table>

**WARP Menu — Obscure, Position Parameters**

- Use the Center (X) knob to adjust the position of the video along the X-Axis.
- Use the Center (Y) knob to adjust the position of the video along the Y-Axis.
- Use the Size knob to adjust the size of the effect.

**Shape Parameters**

<table>
<thead>
<tr>
<th>Shape</th>
<th>Overall</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aspect</td>
<td>(Y)</td>
</tr>
</tbody>
</table>

**WARP Menu — Obscure, Shape Parameters**

- Use the Aspect knob to adjust the aspect ratio of the effect.
- Use the Shape knob to select an ellipse or rectangle shape.

**Effects Parameters**

<table>
<thead>
<tr>
<th>Effects</th>
<th>Overall</th>
</tr>
</thead>
<tbody>
<tr>
<td>Background</td>
<td>Edge Effect</td>
</tr>
</tbody>
</table>

**WARP Menu — Obscure, Effects Parameters**

- Use the Background knob to change the background.
- Use the Edge Effect knob to toggle the lighting on or off.
• Use the **Angle (deg.)** knob to adjust the angle (in degrees) of the lighting for the effect.

**Page Roll**

**Operating Tip**

The Page Roll WARP can be used in wipes or other effects.

Keep the following notes in mind when working with the Page Roll WARP:

• Performing a Page Roll on a flying key requires two Squeeze & Tease MD channels regardless of the key type (typically, Preset Pattern keys require only one channel.). Using a Page Roll as a background wipe requires only a single channel. Be aware of this when using a Page Roll when you have limited Squeeze & Tease MD channels available.

• You can not perform a Page Roll on a combined key.

**Note**

Squeeze & Tease MD borders are not applied when performing a Page Roll background wipe.

• When working with a Page Roll, the parameters are applied based on the whole screen area (as if the image were full screen). When you change the page turn parameters and move the image along the Z-Axis, causing it to appear smaller, you will not see any part of the effect that is happening where there is no key video.

This WARP has two parameters that can be adjusted.

• **Position** — Press this button to adjust the fold of the page turn.

• **Light** — Press this button to adjust the on-board lighting.

**Important**

When working with Page Roll, keep in mind that the parameters are applied based on the whole screen area (as if the image were full screen). When you change the page turn parameters and move the image along the Z-Axis, causing it to appear smaller, you will not see any part of the effect that is happening where there is no key video.
### Position Parameters

- Use the **Roll** knob to adjust the position of the page turn on the image.
- Use the **Radius** knob to adjust the radius of the fold. This indicates whether the fold is wide or narrow.
- Use the **Angle** knob to adjust the axis of the fold. This specifies the corner where the fold begins.

### Light Parameters

- Use the **Gleam** knob to adjust the intensity of the light that appears on the curve at the top of the fold.
- Use the **Shadow** knob to adjust amount of shadow on top and underneath the curve of the fold.
- Use the **Model** knob to select the type of light you want to use. **Natural** light brightens the area; **White** blends the area of the image with white light.

### Pixie Dust

This Warp has three parameters that can be adjusted.

- **Position** — Press this button to define the area on the image where the effect appears.
- **Shape** — Press this button to select the shape of the area where the effect appears (rectangle or oval).
- **Randomness** — Press this button to adjust the amount of random particle distribution in the effect.
Position Parameters

- Use the \((X)\) knob to define the horizontal position of the effect on the image.
- Use the \((Y)\) knob to define the vertical position of the effect on the image.
- Use the Size knob to define the size of the effect.

Shape Parameters

- Use the Aspect knob to change the aspect ratio of the area where the effect appears.
- Use the Pattern knob to select the shape of the effect (rectangle or oval).
Randomness Parameters

- Use the **Variation** knob to indicate the amount of variation in the random distribution of particles in the effect. The greater the variation, the fuzzier the image appears.
- Use the **Softening** knob to indicate the amount of softening around the edges of the effect.
- Use the **Movement** knob to set the randomness behavior. Select **Yes to Fix** the amount of randomness. Select **No to Animate** or have the system vary the random distribution of particles in the effect.

Ripple

This WARP has four parameters that can be adjusted.

- **Wave** — Press this button to adjust the amplitude and frequency of the ripples.
- **Position** — Press this button to adjust the position of the ripple effect.
- **Lighting** — Press this button to adjust the lighting on the effect.
- **Movement** — Press this button to indicate the type of movement you want in the effect.
Wave Parameters

- Use the **Amplitude** knob to adjust the perceived height of the waves.
- Use the **Frequency** knob to adjust the width of the waves.

Position Parameters

- Use the **Xcenter** knob to indicate the horizontal position of the ripple.
- Use the **Ycenter** knob to indicate the vertical position of the ripple.

Lighting Parameters

- Use the **Intensity** knob to adjust the intensity of light on the wave of the ripple.
**Movement Parameters**

**WARP Menu — Ripple Effect, Movement Parameters**

- Use the **Continuous** knob to create continuous wave motion.
- Use the **Waterdrop** knob to create a water drop effect.

**Sand**

This Warp has four parameters that can be adjusted.

- **Sand**: Press this button to adjust the amount and direction of the sand effect.
- **Wind**: Press this button to adjust the amount and direction of the wind.
- **Edge Peaks** and **Edge Curve**: Use these buttons to adjust the peaks and edges of the effect.

**WarpMenu — Sand Effect**

**Sand Parameters**

- Use the **Direction** knob to select the direction of the blowing sand.
- Use the **Opacity** knob to adjust the opacity of the grains of sand.
- Use the **Progression** knob to adjust the amount of displacement in the effect.
**Wind Parameters**

- Use the **Oscillation** knob to adjust the amount of oscillation in the blowing sand.
- Use the **Velocity** knob to adjust the wind speed.
- Use the **Direction** knob to adjust the direction of the wind.

**Edge Peaks**

- Use the **Frequency** knob to adjust the number of peaks at the edges of the effect.
- Use the **Amplitude** knob to adjust the size of the waves at the edges of the effect.

**Edge Curve**

- Use the **Slope** knob to adjust the angle of the waves at the edge of the effect.
- Use the **Phase** knob to move the edges of the waves across the image.

**Split**

This WARP has two parameters that can be adjusted.
- **Movement** — Press this button to adjust direction and size of the split.
• **Axis** — Press this button to adjust the position and angle of the split.

![WARP Menu — Split](image)

**Movement Parameters**

- Use the **Movement** knob to select the direction of the split.
- Use the **Amplitude** knob to adjust the size of the split.

![WARP Menu — Split, Movement Parameters](image)

**Axis Parameters**

- Use the **Position** knob to indicate the position of the split on the image.
- Use the **Angle** knob to adjust the angle of the split.

![WARP Menu — Split Effect, Axis Parameters](image)

**Star**

This WARP has five parameters that can be adjusted.

- **Position** — Press this button to adjust the position and size of the effect.
- **Rotation** — Press this button to adjust the rotation of the effect along either the X, Y, or Z axes.
- **Shape** — Press this button to adjust the number and size of points to the star and the border size.
• **Border Color** — Press this button to adjust the luminance, saturation and hue of the border.

• **Movement** — Press this button to adjust the rotation of the effect along the X, Y, or Z axes.

---

**Position Parameters**

- Use the **X-Pos** knob to position the center point of the star along the X-Axis.
- Use the **Y-Pos** knob to position the center point of the star along the Y-Axis.
- Use the **Size/Creation** knob to change the size of the star.

---

**Rotation Parameters**

- Use the **X-Rotation** knob to adjust the direction and number of rotations along the X-Axis.
- Use the **Y-Rotation** knob to adjust the direction and number of rotations along the Y-Axis.
- Use the **Z-Rotation** knob to adjust the direction and number of rotations along the Z-Axis.
**Shape Parameters**

- Use the **Num Pts** knob to modify the number of points in the star.
- Use the **Pt Size** knob to modify the point size.
- Use the **Border Size** knob to adjust the size of the border.

**Border Color Parameters**

- Use the **Luminance** knob to adjust the luminance of the border color.
- Use the **Saturation** knob to adjust the saturation of the border color.
- Use the **Hue** knob to adjust the hue of the border color.

**Movement Parameters**

- Use the **X-Rate** knob to adjust the direction and rate of rotation along the X-Axis.
- Use the **Y-Rate** knob to adjust the direction and rate of rotation along the Y-Axis.
- Use the **Z-Rate** knob to adjust the direction and rate of rotation along the Z-Axis.
**Stretch**

This Warp has one parameter that can be adjusted.

- **Aspect**: Press this button to adjust the aspect of the effect along the X or Y axis.

  ![Warp Menu — Stretch](image)

**Aspect Parameters**

- Use the **X Aspect** knob to adjust the aspect of the effect along the X axis.
- Use the **Y Aspect** knob to adjust the aspect of the effect along the Y axis.

![Warp Menu — Stretch, Aspect Parameters](image)
In This Appendix

For your reference, this appendix lists the various menu trees that are used within the Synergy Q/MD/X system. The following topics are discussed:

- BNC Configuration Menu Tree
- Installation Setup Menu Tree
- Communications Menu Tree
- Custom Control Menu Tree
- Custom Control Banks Menu Tree
- Disk Menu Tree
- Recall Factory Menu Tree
BNC Configuration Menu Tree

The figure below illustrates the portion of the menu tree that is used to configure BNC connectors — specifically, the path used to reach the BNC Setup Menu and other associated setup menus.
The figure below illustrates the *portion* of the menu tree that is used for additional installation setup.

**Installation Setup Menu Tree**
Communications Menu Tree

The figure below illustrates the portion of the Synergy menu tree that is used for communications setup procedures.
Custom Control Menu Tree

The figure below illustrates the portion of the Synergy menu tree that is used for programming custom control buttons.

**Note**

The *Edit* menu item only appears if the custom control currently selected has already been programmed.
Custom Control Banks Menu Tree

The figure below illustrates the portion of the Synergy menu tree that is used for setting up Custom Control banks.
Disk Menu Tree

The figure below illustrates the portion of the menu tree that is used for saving and recalling switcher setups.
Recall Factory Menu Tree

The figure below illustrates the portion of the menu tree that is used for recalling factory default settings.

Recall Factory Menu Tree
Appendix B. Squeeze & Tease MD Wipes and Sequences

In This Appendix

This appendix briefly describes the pre-programmed Squeeze & Tease Wipes and sequences that are supplied on the Product Resources CD.
Squeeze & Tease MD Wipes and Sequences

After the Squeeze & Tease Wipes and Sequences have been loaded, you can replace or delete them as required. The following chart describes the provided wipes and sequences.

<table>
<thead>
<tr>
<th>Number</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>00</td>
<td>PushLt</td>
<td>Push left</td>
</tr>
<tr>
<td>01</td>
<td>PushRt</td>
<td>Push right</td>
</tr>
<tr>
<td>02</td>
<td>PushUp</td>
<td>Push up</td>
</tr>
<tr>
<td>03</td>
<td>PushDn</td>
<td>Push down</td>
</tr>
<tr>
<td>04</td>
<td>PushUpLt</td>
<td>Push to upper left corner</td>
</tr>
<tr>
<td>05</td>
<td>PushUpRt</td>
<td>Push to upper right corner</td>
</tr>
<tr>
<td>06</td>
<td>PushDnLt</td>
<td>Push to lower left corner</td>
</tr>
<tr>
<td>07</td>
<td>PushDnRt</td>
<td>Push to lower right corner</td>
</tr>
<tr>
<td>08</td>
<td>RotateX</td>
<td>Rotate in X to a knife edge</td>
</tr>
<tr>
<td>09</td>
<td>RotateY</td>
<td>Rotate in Y to a knife edge</td>
</tr>
<tr>
<td>10</td>
<td>SwingRt</td>
<td>Pivot point on right edge, rotate in X to the right and back</td>
</tr>
<tr>
<td>11</td>
<td>SwingLt</td>
<td>Pivot point on left edge, rotate in X to the left and back</td>
</tr>
<tr>
<td>12</td>
<td>SwingUp</td>
<td>Pivot point on top edge, rotate in Y up and back</td>
</tr>
<tr>
<td>13</td>
<td>SwingDwn</td>
<td>Pivot point on bottom edge, rotate in Y down and back</td>
</tr>
<tr>
<td>14</td>
<td>SwngUpLt</td>
<td>Pivot point on top edge, rotate up and then left</td>
</tr>
<tr>
<td>15</td>
<td>SwngUpRt</td>
<td>Pivot point on top edge, rotate up and then right</td>
</tr>
<tr>
<td>16</td>
<td>SwngDnLt</td>
<td>Pivot point on top edge, rotate down and then left</td>
</tr>
<tr>
<td>17</td>
<td>SwngDnRt</td>
<td>Pivot point on top edge, rotate down and then right</td>
</tr>
<tr>
<td>18</td>
<td>RotXBack</td>
<td>Push away while rotating in X</td>
</tr>
<tr>
<td>19</td>
<td>RotYBack</td>
<td>Push away while rotating in Y</td>
</tr>
<tr>
<td>20</td>
<td>DiveRt</td>
<td>Rotate back and right</td>
</tr>
<tr>
<td>21</td>
<td>DiveLt</td>
<td>Rotate back and left</td>
</tr>
<tr>
<td>22</td>
<td>DiveUp</td>
<td>Rotate back and up</td>
</tr>
<tr>
<td>23</td>
<td>DiveDn</td>
<td>Rotate back and down</td>
</tr>
<tr>
<td>24</td>
<td>WalkDown</td>
<td>Move back, then walk the video down</td>
</tr>
<tr>
<td>25</td>
<td>WalkUp</td>
<td>Move back, then walk the video up</td>
</tr>
<tr>
<td>26</td>
<td>AspectX</td>
<td>Compress horizontally to knife edge and back</td>
</tr>
<tr>
<td>27</td>
<td>AspectY</td>
<td>Compress vertically to knife edge and back</td>
</tr>
</tbody>
</table>

Important: The following descriptions refer to background wipes as PGM transitions to PST when used as a Normal transition.
### Squeeze & Tease Wipes and Sequences Chart

<table>
<thead>
<tr>
<th>Number</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>28</td>
<td>ZoomOut</td>
<td>Push towards then back</td>
</tr>
<tr>
<td>29</td>
<td>ZoomIn</td>
<td>Push away then back</td>
</tr>
<tr>
<td>30</td>
<td>DfocusRt</td>
<td>Defocus then push right</td>
</tr>
<tr>
<td>31</td>
<td>DfocusLt</td>
<td>Defocus then push left</td>
</tr>
<tr>
<td>32</td>
<td>MosaicLt</td>
<td>Mosaic tiles then push left</td>
</tr>
<tr>
<td>33</td>
<td>MosaicRt</td>
<td>Mosaic tiles then push right</td>
</tr>
<tr>
<td>34</td>
<td>TwirlLt</td>
<td>Twirl around Y and push left</td>
</tr>
<tr>
<td>35</td>
<td>TwirlRgt</td>
<td>Twirl around Y and push right</td>
</tr>
<tr>
<td>36</td>
<td>KnifEdge</td>
<td>Twirl to knife edge</td>
</tr>
<tr>
<td>37</td>
<td>Tornado</td>
<td>Video gets stuck in a tornado</td>
</tr>
<tr>
<td>38</td>
<td>SpinOut</td>
<td>Spin and push towards then back</td>
</tr>
<tr>
<td>39</td>
<td>SpinIn</td>
<td>Spin and push away then back</td>
</tr>
<tr>
<td>40</td>
<td>TopLtUp</td>
<td>Pivot point top left corner, rotate and push up then back</td>
</tr>
<tr>
<td>41</td>
<td>TopLtDn</td>
<td>Pivot point top left corner, rotate and push down then back</td>
</tr>
<tr>
<td>42</td>
<td>TopRtUp</td>
<td>Pivot point top right corner, rotate and push up then back</td>
</tr>
<tr>
<td>43</td>
<td>TopRtDn</td>
<td>Pivot point top right corner, rotate and push down then back</td>
</tr>
<tr>
<td>44</td>
<td>BtmLtUp</td>
<td>Pivot point bottom left corner, rotate and push up then back</td>
</tr>
<tr>
<td>45</td>
<td>BtmLtDn</td>
<td>Pivot point bottom left corner, rotate and push down then back</td>
</tr>
<tr>
<td>46</td>
<td>BtmRtUp</td>
<td>Pivot point bottom right corner, rotate and push up then back</td>
</tr>
<tr>
<td>47</td>
<td>BtmRtDn</td>
<td>Pivot point bottom right corner, rotate and push down then back</td>
</tr>
<tr>
<td>48</td>
<td>10000lbs</td>
<td>Video falls, then bounces (when run in reverse)</td>
</tr>
<tr>
<td>49</td>
<td>NailFall</td>
<td>Video swings on nail point, then falls to ground</td>
</tr>
<tr>
<td>50</td>
<td>SpinLtUp</td>
<td>Pivot on left center then up</td>
</tr>
<tr>
<td>51</td>
<td>SpinLtDn</td>
<td>Pivot on left center then down</td>
</tr>
<tr>
<td>52</td>
<td>SpinRtUp</td>
<td>Pivot on right center then up</td>
</tr>
<tr>
<td>53</td>
<td>SpinRtDn</td>
<td>Pivot on right center then down</td>
</tr>
<tr>
<td>54</td>
<td>SpinUpLt</td>
<td>Pivot on top then left</td>
</tr>
<tr>
<td>55</td>
<td>SpinUpRt</td>
<td>Pivot on top then right</td>
</tr>
<tr>
<td>56</td>
<td>SpinDnLt</td>
<td>Pivot on bottom then left</td>
</tr>
<tr>
<td>57</td>
<td>SpinDnRt</td>
<td>Pivot on bottom then right</td>
</tr>
<tr>
<td>58</td>
<td>Sepia Spn</td>
<td>Move away to 3/4 size, change color to sepia, then rotate in X to a knife edge</td>
</tr>
<tr>
<td>59</td>
<td>Photo</td>
<td>Move away to 3/4 size, light flash, followed by a lighting effect with blur, defocus and sepia while rotating in Y</td>
</tr>
</tbody>
</table>
Glossary of Terms

**Active Video Lines** — All video lines not occurring in the vertical blanking interval. The portion of the video signal that contains picture information.

**Aspect Ratio** — The numerical ratio of picture width to height, for example, 4:3 or 16:9.

**Auto Transition** — An automatic transition in which the manual movement of the fader handle is simulated electronically. The transition starts when the AUTO TRANS button is pressed and takes place over a pre-selected time period, measured in frames.

**Border** — Effects created around the edges of a pattern or on a keyer. If an optional dual border generator card is installed, several border, shadow, and outline effects are available on that keyer as well.

**Border Generator** — Circuitry that generates various border effects on keys created by the switcher.

**Chroma Key** — An effect in which video from one source replaces video of a specific hue in a second video source. The blue and green hues are most commonly used for chroma keying.

**Chrominance** — The “depth” or saturation of a color. The three characteristics of a TV color signal are chrominance, luminance and hue.

**Cut** — An instantaneous switch from one video signal to another.

**Dissolve** — A transition from one video signal to another in which one signal is faded down while the other is simultaneously faded up. The term “mix” is often used interchangeably with “dissolve”.

**Downstream Keyer (DSK)** — A keyer that places a key “downstream” of the MLE effects system output. This “top level” effect usually consists of a character generator title.

**External Key** — A video input (non-primary video) used to produce a key effect. Examples of external key sources are character generators and cameras.

**Fade-to-Black** — A controlled change of the on-air picture signal level down to black level.

**Field** — One half of a complete picture (or frame) interval containing all of the odd, or all of the even lines in interlaced scanning. One scan of a TV screen is called a “field”; two fields are required to make a complete picture (which is a “frame”).

**Field Frequency** — The rate at which one complete field is scanned, approximately 50 times per second in 625 video, or 60 times per second in 525 video.

**Frame** — One complete picture consisting of two fields of interlaced scanning lines.

**GPI** — An abbreviation for General Purpose Interface, a device which typically allows switcher automatic transition functions to be controlled remotely.
Hue — The characteristic of a color signal that determines whether the color is red, yellow, green, blue, purple, etc. (the three characteristics of a TV color signal are chrominance, luminance, and hue). White, black, and gray are not considered hues.

Internal Key — The use of a primary input to produce a key effect.

Key — An effect produced by “cutting a hole” in background video, then filling the hole with video or matte from another source. Key source video cuts the hole, key fill video fills the hole. The video signal used for cut and fill can come from the same or separate sources.

Key Fill — A video input which is timed to “fill the hole” provided by the key source video. An example of key fill is the video output of a character generator.

Key Invert — An effect that reverses the polarity of the key source so that the holes in the background are cut by dark areas of the key source instead of bright areas. The KEY INV push-button selects this effect.

Key Mask — A keying technique in which a pattern is combined with the key source to block out unwanted portions of the key source.

Key Source — The video signal which “cuts a hole” in the background video to make a key effect possible. Also called “Key Video”. In practice, this signal controls when a video mixer circuit will switch from background to key fill video.

Key Video — See Key Source.

Linear Keys — Linear keys make it possible to fully specify the transparency of a key from opaque, through transparent, to fully off. The transparency is specified by the key signal (also known as the “hole cutter” or “alpha channel”) that is associated with the key fill. A keyer capable of a linear key converts the key signal voltage directly to the transparency effect on the screen. The KEY MEM button allows the user to store the CLIP and GAIN settings required to match the incoming key signal to your requirements.

Line Frequency — The number of horizontal scans per second. For 525 line 60 Hz systems, this is approximately 15734 scans per second.

Luminance Key — An effect in which video from one source is replaced by video that exceeds a set level in a second video source.

Mask — See Key Mask.

Matte — A solid color signal that is generated by the switcher and can be adjusted for hue, saturation, and luminance levels.

Matte Key — A key effect in which the fill video is a matte, provided by one of the internal matte generators.

Memory — The memory feature provides storage and recall of complete switcher setups.

MIX — See Dissolve.

MLE — An abbreviation for multi-level effects.

PGM Output — The on-air video output of the system.

Primary Input — Video sources selected by the control panel push-buttons for the crosspoint buses. These buses are normally labelled “KEY”, “PGM”, and “PST”.

PV Output — A switcher output that shows the scene that will go on-air when the next automatic or manual transition takes place.

Self Key — A key effect in which the same video signal serves as both the key signal and key fill.
**Soft Edge** — A pattern edge effect produced by mixing key source and key fill signals in such a way that the edge of the pattern is not sharp.

**Split Screen** — An effect in which a wipe pattern provides the key source signal. This is known as a “preset pattern” key.

**Tally** — An indicator which illuminates when the associated push-button or control is selected or is on-air.

**Termination** — A means of closing a circuit by connecting a resistive load to it. In video systems, a termination is typically a 75 ohm resistive load.

**Transition** — A controlled change from one video input to another video input or black. The change can occur through a wipe, cut, dissolve or “DVE Send” effect.

**Transition Preview** — A transition seen only on the preview monitor. It may be observed and adjusted without disturbing the program or “on-air” output.

**Video** — The electrical signal produced by a television camera, character generator or other image source. The signal amplitude varies in relation to the tonal scale from black to white presented at the source. White produces the highest amplitude; black produces the lowest signal amplitude.

**Wipe** — A transition from one video signal to another, in which the change proceeds according to the shape of a specific pattern. A moving transition line separates the two picture signals.
Index

Numerics
3D Borders, see S&T Border
3D Space
  control options ............................................. 15-9
  image location .............................................. 15-3
  image rotation .............................................. 15-7
  motion parallax ............................................ 15-6
  perspective ................................................... 15-5
  position coordinates ..................................... 15-3
  raster and image location ............................. 15-4
  Squeeze & Tease MD basics ....................... 15-3

A
Advanced Borders, see S&T Border
Advanced Positioning
  layering ...................................................... 15-22
  locate ....................................................... 17-5
  spin ........................................................... 17-3
  viewpoint .................................................... 17-4
Alpha
  shaped ..................................................... 13-21
  unshaped ................................................... 13-21
Ambient light ............................................ 21-1, 21-2
Appearance, S&T Border .................................. 18-4
Aprisa 100 Still Store interface ....................... 12-26
Arm mode, ROLL VTR ........................................ 14-3, 14-13, 14-14
Aspect, using ................................................ 16-10
Assign group, Aux Bus ..................................... 12-6
Assignable
  Aux panel, modes ........................................ 12-9
  Aux panel, using ........................................ 12-10
Assigning channels ........................................ 15-17
Audio server
  clip control ................................................ 14-2
  clips, overview .......................................... 14-2
  control option .......................................... 14-2
  program clips ............................................ 14-6
  program custom control setup ..................... 14-3
  using clips .............................................. 14-11
Auto Flip .................................................... 15-24
Aux Bus
  assign group .............................................. 12-6
  crosspoint row .......................................... 12-5
  follow mode .......................................... 12-5
  group ...................................................... 12-3
  group, Synergy 1 ....................................... 12-9
  group, Synergy 2 ....................................... 12-4
  group, Synergy 3 ....................................... 12-4
  group, Synergy 4 ....................................... 12-3
  OFF mode, regular mode ............................ 12-9
  remote panels ........................................ 12-8
SHIFT ...................................................... 12-5
special crosspoints ................................... 12-6
using .................................................... 12-7
Aux panel
  assignable ................................................... 12-10
  remote ..................................................... 12-8
B
Backside video ............................................ 15-23
Auto Flip .................................................. 15-24
  using with sequences ................................ 15-24
  using with wipes ...................................... 15-24
Betacam
  protocol .................................................... 14-2
BNC configuration menu tree ............................ 23-2
Border
  color ..................................................... 18-10
  softness .................................................. 18-10
  working with multiple channels .................. 18-10
C
Camera, remote control interface .................... 12-55
CD-ROM, Wipes and Sequences .......................... 24-2
Center cross hairs
  change position ...................................... 12-17
Center cross hairs, preview overlay ................ 12-17
Center overlay
  cross hairs .............................................. 12-17
  position .................................................. 12-18
  preview overlay cross hairs ....................... 12-17
  select a predefined center ......................... 12-17
Centering
  Advanced Positioning parameters .................. 17-6
  an image ............................................. 15-6, 15-9
  Lighting parameters ................................ 21-9
  Position/Crop parameters ........................... 16-15
  S&T Border parameters ............................... 18-11
Changing still ID ........................................ 12-26
Channel
  assigning .............................................. 15-17
  listing .................................................. 15-18
  Channel, Still-Store .................................. 13-9
Character Generator
- Changing PGM Text 12-32
- Changing PV Text 12-34
- editing text 12-33
- Effects 12-34
- Effects, Ease 12-37
- Effects, Effect 12-35
- Effects, Pattern 12-36
- Effects, Reverse 12-38
- Effects, Row Direction 12-38
- Effects, Speed 12-37
- interface 12-27
- Mode 12-27
- Modifying Effects 12-35
- Selecting Channels 12-39
- Selecting Mode 12-28

Character Generator Manual Mode
- Recalling a Page 12-31
- Running an Effect 12-32
- Selecting a Folder 12-31

Character Generator Sequence Mode
- Loading a Page 12-29
- Recalling an Event 12-30
- Running an Event 12-30
- Selecting a File 12-29

Chyron Duet LEX
- changing PGM text 12-45
- changing preview text 12-43
- operation overview 12-39
- playing animation 12-48
- recalling a page to preview 12-41
- recalling a page to program 12-42
- selecting a folder 12-40
- swapping preview and program 12-47

CLEAN FEED
- aux bus 12-6

Clip
- audio server 14-2
- name menu 14-4
- program audio server 14-6
- program custom control 14-3
- program video server 14-8
- program VTR 14-4
- programming 14-3
- using audio server 14-11
- using video server 14-11
- using VTR 14-11
- video server 14-2
- VTR control 14-2

Color (HSL), S&T Border 18-9
- Color (RGB), S&T Border 18-8

Color, S&T Border 18-8

Colorize effect 19-5

Communications menu tree 23-4

Control options 15-9

Copy
- DSK to DSK 12-75
- DSK to MLE Keyer 12-75
- functions 12-72
- Key 12-74
- matte 12-76
- MLE 12-72
- MLE Keyer to DSK 12-75
- MLE Keyer to MLE Keyer 12-74
- wipe 12-77

Cropping
- horizontal 16-11
- using 16-11
- vertical 16-12

Custom control
- bank setup menu tree 23-6
- group 14-3
- menu tree 23-5
- VTR 14-3

Custom Controls and 3D Wipes 20-34

Cut and Paste Stills 13-18

D

Defocus effect 19-3

Deleting sequences 20-24

Digicart
- protocol 14-2
- Directional light 21-1, 21-2, 21-7
- Directory, creating in Global-Store 13-14

Disk
- store menu 20-36
- Disk menu tree 23-7

Display
- preview overlay elements 12-14

DSK
- assigning channels 15-20
- DSK to DSK Copy 12-75
- DSK to DSK Swap 12-76
- DSK to Keyer Copy 12-75
- Duration, keyframe 20-6

E

Eagle Pan Tilt System
- focus, adjusting 12-63
- iris, adjusting 12-63
- operation 12-62
- pan, adjusting 12-63
- pedestal, adjusting 12-63
- store a shot 12-64
- tilt, adjusting 12-63
wiper, using the ............................................... 12-64
zoom, adjusting .............................................. 12-63
Editor interface ........................................... 12-25
Effect
  colorize .................................................... 19-5
  defocus ................................................... 19-3
  mosaic .................................................... 19-4
  posterize ................................................ 19-4
  strobe .................................................... 19-6
Effects, modifying CG events ..................... 12-34
End-of-life disposal ........................................ 1-8
Enter Louth ID Menu ........................................ 14-8
Environmental Information .......................... 1-8

F

Film, warp .................................................. 22-4
Fly Key
  in 3D .................................................... 15-16
Introduction ............................................... 15-2
Mix/DSK ................................................... 15-16
Modifiers ................................................... 15-17
MultiDSK ................................................... 15-16
  navigating to the main menu ...................... 15-12
  overview ................................................ 15-2
  rules ..................................................... 15-16
Follow, Aux Bus mode ....................................... 12-9
Font Color, Preview Overlay Setup .................. 12-24
Freeze
  using .................................................... 16-14
Frontside/Backside video .............................. 15-23, 15-24
FTP
  mount point ............................................ 13-6

G

Global memory system group
  editor interface ...................................... 12-25
  still store mode ..................................... 12-26
Global-Store
  animation .............................................. 13-21
  assigning default stills ......................... 13-22
  creating a directory ................................ 13-14
  default stills ...................................... 13-22
  deleting a still .................................... 13-17
  deleting all stills ................................ 13-16
  field/frame display mode ......................... 13-20
  moving stills ....................................... 13-18
  on-air properties .................................. 13-19
    autoplay ............................................ 13-21
    display frame ..................................... 13-21
    looping ............................................. 13-21
    play speed ........................................ 13-22
    reverse ............................................ 13-21
  thumbnail ............................................ 13-21
  trim ................................................... 13-22
  overview ............................................. 13-9
  renaming a still .................................. 13-11
  renumbering a still ................................ 13-13
  still position ...................................... 13-20
  viewing default stills ............................ 13-23
Globe, warp .............................................. 22-6
GPI
  aux panel override .................................. 12-9
  control ............................................... 12-2
  input control, area, button ..................... 12-2
  input function ...................................... 12-2
  output control ..................................... 12-2
  output function .................................... 12-2
  setup .................................................. 12-2
Grab
timecode ............................................... 14-5
Grass Valley CameraMan camera
  focus, adjusting ..................................... 12-70
  iris, adjusting ..................................... 12-70
  operation ............................................ 12-67, 12-68
  pan, adjusting ..................................... 12-69
  pedestal, adjusting ................................ 12-70
  recall a shot ....................................... 12-70
  store a shot ........................................ 12-70
  tilt, adjusting ..................................... 12-69
  zoom, adjusting .................................... 12-69
Group
  aux bus ............................................... 12-3
  global memory system ............................... 12-25
  global memory system, still store mode ........ 12-26
  preview overlay ..................................... 12-13
  GVG-4000 protocol .................................. 12-25

H

Heart, warp .............................................. 22-9
HIDE ONLY ............................................... 12-24
Hide overlay ............................................ 12-24
Hold
  adding to a sequence .............................. 20-18
  running in a sequence ............................. 20-20

I

Icon
  Disk Store menu ..................................... 20-36
Image
  specifications ........................................ 13-2
Image Transfer .......................................... 13-5
  copying from switcher ............................ 13-8
  copying to switcher ................................ 13-7
  legacy files ........................................ 13-8
Image transfer preparation .......................................... 13-2
Images
  centering ................................................. 15-6
  location ................................................. 15-3
  rotation .................................................. 15-7
Indicators
  N/S, aux bus .............................................. 12-6
  ON AIR, Aux Bus ........................................ 12-6
Inpoint/Outpoint Menu ........................................ 14-10
Input
  GPI control ............................................... 12-2
Installation
  setup menu tree ......................................... 23-3
Intensity, lighting ........................................... 21-3

J
Joystick, using .................................................. 15-11

K
Key
  copy ....................................................... 12-74
  swap ...................................................... 12-75
Keyer groups
  DSK, assigning channels ............................. 15-20
  MLE, assigning channels ......................... 15-18
  MLE, unassigning channels ....................... 15-18
Keyer to DSK Copy .......................................... 12-75
Keyer to Keyer Copy ....................................... 12-74
Keyer to Keyer Swap ....................................... 12-76
Keyframe .................................................... 15-2
  duration ................................................. 20-6
  pivot position .......................................... 16-7
  pivot position preset ................................... 16-6
  programming ............................................. 20-3
Keyframes
  modifying ................................................. 20-13
Keys
  flying in 3D ............................................. 15-16

L
Layering .......................................................... 15-22
Lens Flare, warp ............................................ 22-11
Lighting
  adjust lighting effects ................................ 21-4
  ambient ................................................... 21-1, 21-5
  directional .............................................. 21-1, 21-2, 21-5
  intensity .................................................. 21-2, 21-3
  luminance clipping ..................................... 21-1, 21-3
  model ...................................................... 21-1, 21-2
  overview .................................................. 21-2
  presets .................................................... 21-3
  working with multiple channels ..................... 21-7
Lighting Preset ............................................... 21-4
Linear motion .............................................. 20-4, 20-29
Loading
  sequences ................................................ 20-6, 20-21
  wipes ..................................................... 20-33
Locate feature ................................................. 17-5
Looping, VTR clip ........................................... 14-15
Louth protocol .................................................. 14-2
Luminance clipping ......................................... 21-1, 21-3

M
Magnify WARP .................................................. 22-13
Manual Mode, Character Generator .................... 12-27
Mask
  preview overlay ......................................... 12-23
  MASK PV .................................................... 12-23
Matte
  copy ...................................................... 12-76
  Melt, warp ................................................. 22-15
Memory
  area, still store mode .................................. 12-26
Menu
  advanced positioning ................................... 17-2
  channel listing .......................................... 15-18
  clip name ................................................ 14-4
  cropping .................................................. 16-11
  disk store ................................................ 20-36
  enter Louth ID .......................................... 14-8
  inpoint/outpoint ........................................ 14-10
  lighting ................................................. 21-2, 21-4, 21-5, 21-7
  load/save sequence ..................................... 20-12, 20-15, 20-19
  point of rotation ....................................... 16-6
  position/crop ............................................ 15-17
  pre processor ........................................... 22-2
  preprocessor ............................................. 19-2
  preview overlay ......................................... 12-14
  remote control, video server clips .................. 14-13
  remote control, VTR clips ............................ 14-12
  rotation .................................................. 16-8
  runtime ................................................. 20-22, 20-33
  S&T Border ................................................ 18-2
  S&T position/crop ....................................... 15-17
  sequence ................................................ 20-5
  sequence name .......................................... 20-21
  source ID position ..................................... 12-14
  spin ....................................................... 17-3
  structure .................................................. 15-12
  time clock count up .................................... 12-20
  transparency ............................................. 16-13
  tree, custom control banks ............................ 23-6
  user wipes assignment .................................. 20-27
viewpoint ........................................ 17-4
VTR clips ........................................ 14-4
VTR position .................................. 12-16
WARP ............................................. 22-2
wipe/sequence assignment ............... 20-26
Menu system .................................. 15-12
Menu tree
  BNC configuration ........................... 23-2
  communications ........................... 23-4
  custom control ............................. 23-5
  installation setup ......................... 23-3
  recall factory ............................. 23-8
Mix/DSK Fly Key ............................. 15-16
MLE
  copy ......................................... 12-72
  aux bus ...................................... 12-6
MLE 2
  aux bus ...................................... 12-6
MLE PV
  aux bus ...................................... 12-6
MLE-Store .................................... 13-9
on-air properties
  autoplay .................................... 13-21
  display frame ............................. 13-21
  looping .................................... 13-21
  play speed ................................ 13-22
  reverse .................................... 13-21
  thumbnail .................................. 13-21
  trim ....................................... 13-22
Mode
  Character Generator ...................... 12-27
Modifying
  keyframes .................................. 20-13
Mosaic effect ............................... 19-4
Motion parallax ............................ 15-6
Moving Stills ................................ 13-18
MultiDSK Fly Key ......................... 15-16
Multiple channels
  borders .................................... 18-10
  lighting .................................. 21-7

N

N/S
  aux bus ................................... 12-6
Non-sync, indication ...................... 12-6

O

Obscure, warp ................................ 22-16
Off Mode, Aux Bus ......................... 12-9
ON AIR
  aux bus ................................... 12-6

On-air properties, Global-Store .......... 13-19
Options
  audio server control ..................... 14-2
  editor interface ........................ 12-25
  video server control .................... 14-2
  VTR remote control ..................... 14-2
Outputs
  GPI control ................................ 12-2
Overlay
  center cross hairs ....................... 12-17
  hide only .................................. 12-24
  mask preview ............................. 12-23
  safe title .................................. 12-18
  source identification .................. 12-14
  time clock ................................ 12-20
  video server timecode and size ........ 12-15
  VTR Timecode ............................ 14-12
  VTR timecode and size ................. 12-15
  VTR timecode, changing ................ 12-16
Overview
  audio server clip control .............. 14-2
  video server clip control ............. 14-2
  VTR clip control ......................... 14-2
  overview .................................. 13-9

P

Page Roll, warp ................................ 22-18
Panasonic Pan/Tilt Head
  focus, adjusting ......................... 12-66
  iris, adjusting ......................... 12-66
  operation ................................ 12-65
  pan, adjusting ......................... 12-65
  recall a shot ............................ 12-66
  store a shot ................................ 12-66
  tilt, adjusting ......................... 12-65
  wiper, using the ......................... 12-66
  zoom, adjusting ......................... 12-65
Pattern selection area ................. 20-25, 20-26
Pause, inserting ......................... 20-28
Perspective ................................ 15-5, 17-5
  image centering ......................... 15-6
  parallax effect .......................... 15-6
  relative size ............................ 15-5
  viewpoint ................................ 15-6
PGM
  aux bus ................................... 12-6
Pictureframe Borders, see S&T Border
Pinnacle FXDeko II
  operation overview ....................... 12-49
  recalling a page to preview ............ 12-49, 12-53, 12-54
  recalling a page to program ........... 12-51
  swapping preview and program .......... 12-52
  Pivot position .......................... 16-7
Index

Pivot position preset ........................................ 16-6
Pixie Dust, warp ........................................ 22-19
Play mode, ROLL VTR ........................................ 14-3, 14-13
Play Speed, VTR clip ........................................ 14-15
Point of view .................................................. 17-4
Position
  adjusting ....................................................... 16-3
  coordinates .................................................... 15-3
  X-Axis .......................................................... 15-11
  Y-Axis .......................................................... 15-11
  Z-Axis .......................................................... 15-11
Position/Crop menu .......................................... 15-17
Positioner, using ............................................ 15-11
Posterize effect ............................................ 19-4
Preprocessor Menu ......................................... 19-2
Preview
  overlay group ................................................ 12-13
  overlay, time clock ....................................... 12-20
  overlay, VTR timecode ................................... 14-12
  Preview Overlay Menu ................................... 12-14
Preview Mask overlay ...................................... 12-23
Preview Overlay
  font color .................................................... 12-24
Preview overlay
  center cross hairs ........................................ 12-17
  elements ...................................................... 12-14
  hide only ...................................................... 12-24
  mask .......................................................... 12-23
  modify safe title name .................................. 12-20
  preview source display .................................. 12-14
  program source display .................................. 12-14
  safe action box ............................................ 12-18
  safe title ...................................................... 12-17
  safe title overlay ......................................... 12-18
  source identification .................................... 12-14
  Synergy 1 ..................................................... 12-15
  transition type display .................................. 12-14
  video server timecode .................................. 12-15
  VTR timecode ............................................... 12-15
  VTR timecode, changing ................................ 12-16
Previewing sequences ..................................... 20-27
Programming
  clips .......................................................... 14-3
  custom control ............................................. 14-3
Programming, keyframes .................................. 20-3
Protocol
  Betacam ........................................................ 14-2

Digicart ........................................................ 14-2
GVG-4000 ..................................................... 12-25
Louth ............................................................ 14-2

Recall factory settings, menu tree ..................... 23-8
Recalling
  sequences and wipes .................................. 20-25, 20-41
  sets of sequences ...................................... 20-41
  specific sequences ..................................... 20-42
Remote
  Aux panel ................................................... 12-8
  Aux panel override ....................................... 12-9
  Aux panels, Synergy 1 .................................. 12-8
  Aux panels, Synergy 1.5 .................................. 12-8
  Aux panels, Synergy 2 ................................... 12-8
  Aux panels, Synergy 2.5 .................................. 12-8
  Aux panels, Synergy 3 ................................... 12-8
  Aux panels, Synergy 3.5 .................................. 12-8
  Aux panels, Synergy 4 ................................... 12-8
  Camera control, operation ............................. 12-55
  control menu, video server clips ..................... 14-13
  control menu, VTR clips ................................ 14-12
Remote camera control
  Eagle Pan Tilt System ................................ 12-62
  Grass Valley CameraMan camera ..................... 12-67, 12-68
  operation overview ..................................... 12-55
  Panasonic Pan/Tilt Head ................................ 12-65
  Sony .......................................................... 12-58
  Telemetrics ................................................. 12-55
Renaming a still, Global-Store ......................... 13-11
Renaming sequences ...................................... 20-20
Repair policy ................................................ 1-7
Ripple, warp .................................................. 22-21
ROLL VTR
  arm mode .................................................... 14-3, 14-13, 14-14
  play mode .................................................... 14-3, 14-13
Rotation
  adjusting ..................................................... 16-6
  image .......................................................... 15-7
  point of ...................................................... 16-6
  using .......................................................... 16-8
  X axis .......................................................... 16-8
  Y axis .......................................................... 16-9
  Z axis .......................................................... 16-9
Row Direction, Character Generator .................. 12-38
Running
  a sequence with a Hold .................................. 20-20
  sequences ................................................... 20-22
  wipes .......................................................... 20-33
S&T Border
- Appearance ........................................... 18-4
- centering ............................................. 18-11
- color .................................................... 18-8
- color, HSL ............................................ 18-9
- color, RGB ........................................... 18-8
- menu .................................................... 18-2
- size ...................................................... 18-3
- softness .............................................. 18-4
- style .................................................... 18-7
- symmetry ............................................. 18-5
- transparency .......................................... 18-5

S&T MD
- control options ...................................... 15-9
- image centering ..................................... 15-9
- image location ....................................... 15-3
- image rotation ....................................... 15-7
- motion parallax ...................................... 15-6
- multiple channel control ...................... 15-9
- overview .............................................. 15-3
- perspective .......................................... 15-5
- position coordinates ............................ 15-3
- Position/Crop menu ................................ 15-17
- raster and image location ..................... 15-4
- single channel control ......................... 15-9
- viewpoint ............................................ 15-7

Safe title
- preview overlay .................................... 12-17

Safe title overlay .................................. 12-18
- adjust position .................................... 12-19
- change position ..................................... 12-18
- change text size .................................... 12-18
- modify name ......................................... 12-20
- position ............................................... 12-19
- selecting a predefined set up ............... 12-19

Sand, warp .......................................... 22-23

Section
- global memory system group ............. 12-25, 12-26

Selecting
- channels, Character Generator .......... 12-39

Sequence
- Mode, Character Generator ............... 12-27

Sequences
- adding a Hold ...................................... 20-18
- adding a Pause ..................................... 20-28
- assigning to buttons ......................... 20-26
- creating ............................................. 20-8
- deleting .............................................. 20-24
- loading .............................................. 20-6, 20-21
- memories ........................................... 20-27
- menu ................................................... 20-5
- overview ............................................ 20-2
- previewing ......................................... 20-27
- Product Resource CD ......................... 24-2
- recalling ............................................. 20-25
- recalling from disk ......................... 20-41
- renaming ........................................... 20-20
- running .............................................. 20-22
- running with a Hold ......................... 20-20
- storing to disk ................................. 20-35
- with Frontside/Backside video ........... 15-24
- working with ..................................... 20-3

Setup
- GPI .................................................... 12-2
- Preview Overlay font color ................ 12-24
- time clock overlay ............................. 12-21

Shaped Alpha ....................................... 13-21

SHIFT
- aux bus .............................................. 12-5

Size
- source ID ............................................ 12-14
- video server timecode ....................... 12-15
- VTR timecode ..................................... 12-15

Size, S&T Border .................................. 18-3

Slow motion, VTR clips ....................... 14-13, 14-15
- Smooth motion .................................. 20-3, 20-29

SMPTE standard safe title ................. 12-18

Softness, S&T Border ......................... 18-4

Sony robotic camera
- auto mode ......................................... 12-59
- digital zoom ....................................... 12-59
- focus, adjusting .................................. 12-59
- image ratio, adjusting ...................... 12-60
- iris, adjusting .................................... 12-59
- manual mode ...................................... 12-59
- operation .......................................... 12-58
- optical zoom ...................................... 12-59
- pan, adjusting .................................... 12-58
- picture effect, adjusting .................. 12-60
- recall a shot ....................................... 12-61
- shutter speed, adjusting .................... 12-59
- store a shot ....................................... 12-60
- tilt, adjusting ..................................... 12-58
- white balance, adjusting .................. 12-60
- zoom, adjusting .................................. 12-58

Source
- identification ....................................... 12-14

Source ID overlay ................................ 12-14
- changing on a Synergy 1 ................. 12-15
- position ............................................. 12-15
- position menu .................................... 12-14
- size ................................................... 12-15

Specifications
- image ............................................... 13-2
- Spin an image .................................... 17-3
- Spline motion .................................... 20-4, 20-29
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Split, warp</td>
<td>22-24</td>
</tr>
<tr>
<td>Squeeze &amp; Tease</td>
<td></td>
</tr>
<tr>
<td>WARP</td>
<td></td>
</tr>
<tr>
<td>Magnify</td>
<td>22-13</td>
</tr>
<tr>
<td>Squeeze &amp; Tease Overview</td>
<td>15-2</td>
</tr>
<tr>
<td>Squeeze &amp; Tease. See also S&amp;T MD</td>
<td></td>
</tr>
<tr>
<td>Star, warp</td>
<td>22-25</td>
</tr>
<tr>
<td>Static discharge</td>
<td>1-6</td>
</tr>
<tr>
<td>Still image</td>
<td></td>
</tr>
<tr>
<td>capturing</td>
<td>13-24</td>
</tr>
<tr>
<td>changing capture directory</td>
<td>13-27</td>
</tr>
<tr>
<td>default, Global-Store</td>
<td>13-22</td>
</tr>
<tr>
<td>deleting in Global-Store</td>
<td>13-16</td>
</tr>
<tr>
<td>renaming in Global-Store</td>
<td>13-11</td>
</tr>
<tr>
<td>renumbering in Global-Store</td>
<td>13-13</td>
</tr>
<tr>
<td>selecting in Still-Store</td>
<td>13-9</td>
</tr>
<tr>
<td>viewing default, Global-Store</td>
<td>13-23</td>
</tr>
<tr>
<td>Still Store</td>
<td></td>
</tr>
<tr>
<td>changing still ID</td>
<td>12-26</td>
</tr>
<tr>
<td>global memory system mode</td>
<td>12-26</td>
</tr>
<tr>
<td>interface</td>
<td>12-26</td>
</tr>
<tr>
<td>Stills, moving</td>
<td>13-18</td>
</tr>
<tr>
<td>Still-Store</td>
<td></td>
</tr>
<tr>
<td>capturing stills</td>
<td>13-24</td>
</tr>
<tr>
<td>changing capture directory</td>
<td>13-27</td>
</tr>
<tr>
<td>menu overview</td>
<td>13-10</td>
</tr>
<tr>
<td>on-air properties</td>
<td></td>
</tr>
<tr>
<td>autoplay</td>
<td>13-21</td>
</tr>
<tr>
<td>display frame</td>
<td>13-21</td>
</tr>
<tr>
<td>looping</td>
<td>13-21</td>
</tr>
<tr>
<td>play speed</td>
<td>13-22</td>
</tr>
<tr>
<td>reverse</td>
<td>13-21</td>
</tr>
<tr>
<td>thumbnail</td>
<td>13-21</td>
</tr>
<tr>
<td>trim</td>
<td>13-22</td>
</tr>
<tr>
<td>selecting a still</td>
<td>13-9</td>
</tr>
<tr>
<td>Storing</td>
<td></td>
</tr>
<tr>
<td>3D sequences</td>
<td>20-35</td>
</tr>
<tr>
<td>memories</td>
<td>20-36</td>
</tr>
<tr>
<td>memory registers</td>
<td>20-38</td>
</tr>
<tr>
<td>S&amp;T 3D sequence</td>
<td>20-39</td>
</tr>
<tr>
<td>Stretch, warp</td>
<td>22-28</td>
</tr>
<tr>
<td>Strobe effect</td>
<td>19-6</td>
</tr>
<tr>
<td>Style, S&amp;T Border</td>
<td>18-7</td>
</tr>
<tr>
<td>Swap</td>
<td></td>
</tr>
<tr>
<td>DSK to DSK</td>
<td>12-76</td>
</tr>
<tr>
<td>functions</td>
<td>12-72</td>
</tr>
<tr>
<td>key</td>
<td>12-75</td>
</tr>
<tr>
<td>MLE Keyer to MLE Keyer</td>
<td>12-76</td>
</tr>
<tr>
<td>Symmetry, S&amp;T Border</td>
<td>18-5</td>
</tr>
<tr>
<td>Synergy 1</td>
<td></td>
</tr>
<tr>
<td>aux bus group</td>
<td>12-5</td>
</tr>
<tr>
<td>center crosshairs overlay, changing</td>
<td>12-17</td>
</tr>
<tr>
<td>change safe title overlay</td>
<td>12-18</td>
</tr>
<tr>
<td>changing VTR timecode overlay</td>
<td>12-16</td>
</tr>
<tr>
<td>preview overlay</td>
<td>12-15</td>
</tr>
<tr>
<td>preview overlay function</td>
<td>12-13</td>
</tr>
<tr>
<td>remote aux panels</td>
<td>12-8</td>
</tr>
<tr>
<td>safe title ID name, modify</td>
<td>12-20</td>
</tr>
<tr>
<td>time clock overlay setup</td>
<td>12-21</td>
</tr>
<tr>
<td>Synergy 1.5</td>
<td></td>
</tr>
<tr>
<td>remote aux panels</td>
<td>12-8</td>
</tr>
<tr>
<td>Synergy 2</td>
<td></td>
</tr>
<tr>
<td>aux bus group</td>
<td>12-4</td>
</tr>
<tr>
<td>preview overlay group</td>
<td>12-13</td>
</tr>
<tr>
<td>remote aux panels</td>
<td>12-8</td>
</tr>
<tr>
<td>Synergy 2.5</td>
<td></td>
</tr>
<tr>
<td>remote aux panels</td>
<td>12-8</td>
</tr>
<tr>
<td>Synergy 3</td>
<td></td>
</tr>
<tr>
<td>aux bus group</td>
<td>12-4</td>
</tr>
<tr>
<td>preview overlay group</td>
<td>12-13</td>
</tr>
<tr>
<td>remote aux panels</td>
<td>12-8</td>
</tr>
<tr>
<td>Synergy 3.5</td>
<td></td>
</tr>
<tr>
<td>remote aux panels</td>
<td>12-8</td>
</tr>
<tr>
<td>Synergy 4</td>
<td></td>
</tr>
<tr>
<td>aux bus group</td>
<td>12-3</td>
</tr>
<tr>
<td>preview overlay group</td>
<td>12-13</td>
</tr>
<tr>
<td>remote aux panels</td>
<td>12-8</td>
</tr>
<tr>
<td>T</td>
<td></td>
</tr>
<tr>
<td>Telemetrics remote camera</td>
<td></td>
</tr>
<tr>
<td>focus, adjusting</td>
<td>12-56</td>
</tr>
<tr>
<td>iris, adjusting</td>
<td>12-56</td>
</tr>
<tr>
<td>location, adjusting</td>
<td>12-57</td>
</tr>
<tr>
<td>operation</td>
<td>12-55</td>
</tr>
<tr>
<td>pan, adjusting</td>
<td>12-55</td>
</tr>
<tr>
<td>pedestal, adjusting</td>
<td>12-56</td>
</tr>
<tr>
<td>recall a shot</td>
<td>12-57</td>
</tr>
<tr>
<td>store a shot</td>
<td>12-57</td>
</tr>
<tr>
<td>tilt, adjusting</td>
<td>12-55</td>
</tr>
<tr>
<td>zoom, adjusting</td>
<td>12-55</td>
</tr>
<tr>
<td>the</td>
<td>22-12</td>
</tr>
<tr>
<td>Time clock</td>
<td></td>
</tr>
<tr>
<td>count up menu</td>
<td>12-20</td>
</tr>
<tr>
<td>Time Clock overlay</td>
<td></td>
</tr>
<tr>
<td>button</td>
<td>12-20</td>
</tr>
<tr>
<td>setup</td>
<td>12-21</td>
</tr>
<tr>
<td>Time clock overlay setup</td>
<td></td>
</tr>
<tr>
<td>change position</td>
<td>12-21</td>
</tr>
<tr>
<td>change size</td>
<td>12-21</td>
</tr>
<tr>
<td>count direction setup</td>
<td>12-22</td>
</tr>
<tr>
<td>preset time setup</td>
<td>12-23</td>
</tr>
<tr>
<td>transition</td>
<td>12-22</td>
</tr>
<tr>
<td>Timecode grab</td>
<td>14-5</td>
</tr>
<tr>
<td>Timeline</td>
<td>20-5 , 20-10</td>
</tr>
<tr>
<td>Transition type</td>
<td></td>
</tr>
<tr>
<td>preview overlay element</td>
<td>12-14</td>
</tr>
<tr>
<td>Transparency</td>
<td></td>
</tr>
<tr>
<td>applying</td>
<td>16-13</td>
</tr>
</tbody>
</table>
Transparency, S&T Border ......................... 18-5
Transparency, using .................................. 16-13
types ......................................................... 13-9

U
Unshaped Alpha ........................................ 13-21
Unshaped, alpha ....................................... 13-21
Using
assignable Aux panel ............................... 12-10
audio server clips ..................................... 14-11
aux bus .................................................... 12-7
video server clips .................................... 14-11
VTR clips ................................................ 14-11
Using the positioner .................................. 15-11

V
Video
server clips ............................................... 14-2
server clips, overview .............................. 14-2
server clips, remote control menu ............. 14-13
server control option .............................. 14-2
server timecode overlay .......................... 12-15
server, program clips .............................. 14-8
server, program custom control ............... 14-3
server, using clips .................................. 14-11
Viewpoint ............................................... 17-4
VizRT character generator
operation overview .................................. 12-53
VTR
clip .......................................................... 14-2
clip menu ................................................ 14-4
clips, overview ....................................... 14-2
clips, remote control menu ...................... 14-12
looping a clip ........................................... 14-15
position menu ......................................... 12-16
program clips ......................................... 14-4
program custom control ......................... 14-3
remote control option ............................ 14-2
slow motion ............................................ 14-13, 14-15
TC ........................................................... 14-12
timecode overlay .................................... 14-12
timecode overlay and size ...................... 12-15
timecode overlay, changing ................. 12-16
using clips ............................................. 14-11
VTR timecode overlay .............................. 12-15
position .................................................. 12-16
size ........................................................ 12-16
VTR Timecode overlay, changing .............. 12-16

W
WARP
Film ....................................................... 22-4
Globe ...................................................... 22-6
Heart ...................................................... 22-9
Lens Flare ................................................. 22-11
Magnify ................................................. 22-13
Melt ......................................................... 22-15
menu ....................................................... 22-2
Obscure ................................................. 22-16
Page Roll ............................................... 22-18
Pixie Dust ............................................... 22-19
resources ................................................. 22-2
resources, freeing .................................. 22-3
Ripple .................................................... 22-21
Sand ....................................................... 22-23
Split ....................................................... 22-24
Star ......................................................... 22-25
Stretch .................................................. 22-28
wipe ....................................................... 22-2
WARP Effects ........................................... 22-4
Warranty .................................................. 1-7
WebDAV .................................................. 13-5
connection ............................................. 13-5
mount point ........................................... 13-5
transferring images ............................. 13-7
Wipe
copy ..................................................... 12-77
WARP .................................................... 22-2
Wipes
background ........................................... 20-29
creating .................................................. 20-30
Custom Controls .................................. 20-34
key ......................................................... 20-30
loading ................................................... 20-33
modifier .................................................. 20-31
overview ............................................... 20-2
Product Resources CD ......................... 24-2
recalling from disk ............................... 20-41
running .................................................... 20-33
storing to disk ....................................... 20-35
types available ...................................... 20-31
with Frontside/Backside video .............. 15-24
worksheet ............................................. 13-5